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Backups are usually good, unless there is a sewer involved.

If it keeps up, man will atrophy all his limbs but the push-button finger. 
~Frank Lloyd Wright

Do you realize if it weren't for Edison we'd be watching TV by
candlelight?  ~Al Boliska

Download a booklet with comprehensive descriptions of technology training and resources
for counselors (PDF; 116KB).
http://www.schoolcounselor.com/pdf/booklet.pdf 
____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: Blocking text in Microsoft Word™ can get a bit tricky sometimes. For instance, I sometimes
start by holding the left mouse button down and then dragging but the pages start moving by
very fast and I end up blocking more than I want. Is there an easier way to do this?

A: Sure, here are three other ways to block text (adapted from http://techrepublic.com.com): 

1. Use [Shift] plus the arrow keys. Hold down [Shift] and press an arrow key to
select text in the desired direction. To select a word at a time, press [Ctrl][Shift] and the
left or right arrow key.

2. Use the mouse with the [Shift] key. Move the mouse pointer away from the
insertion point position, hold down [Shift] and click to select all the text between the
insertion point and the place where you clicked.

3. Use the [Shift] plus the down arrow key instead of the mouse.

And/Or to ...

– Select a word: Double-click on it. If a space immediately follows the word you select, the
space gets selected, too. Punctuation is ignored.

– Select a sentence. Hold down [Ctrl] and click anywhere in the sentence.

– Select a paragraph. Triple-click within the paragraph or move the mouse just past the left
margin of the paragraph. When the pointer changes to a right-pointing arrow, double-click to
select the whole paragraph.

– Select a table. Select a table by holding down [Alt] and double-clicking anywhere in the
table.

http://tinyurl.com/dgfjd
http://www.schoolcounselor.com/pdf/booklet.pdf
http://techrepublic.com.com
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– Select all the text between the insertion point and… To select all the text between
the insertion point and the end of the current line, press [Shift][End]. To select the
text from the insertion point through the end of the current paragraph, press [Ctrl][Shift] and
the down arrow. To select the text from the insertion point to the end of the document, press
[Ctrl][Shift][End].

– Select an entire document. Press [Ctrl]A. This is handy when you need to change the font
or add or remove formatting. Once you've selected the entire document, apply the formatting
to everything and either leave it applied or apply it again to remove it. For example, suppose
some text in your document is underlined and you want nothing underlined. To avoid spending
time visiting each underlined section of text and un-underlining it, select the whole document
with [Ctrl]A. Press [Ctrl]U to apply underlining to the entire document and then press [Ctrl]U
again to remove the underlining. Be careful when you use [Ctrl]A. If you accidentally press
[Delete] or type a keystroke and erase everything, don't panic. Just press [Ctrl]Z or choose
Undo from the Edit menu.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Q: How do I print an envelope using the address that I have in a letter.

A: After typing in the address in your letter (MS Word will figure out where it is), open the
Tools menu and select Envelopes And Labels. (Word XP users choose Letters And Mailings and
then select Envelopes And Labels.) In the Envelopes tab, enter the return address if you want
one, and click Print. If you click on the Options tab, you can also check of that you want a
delivery bar code included!

TIPS AND TRICKS

Remove Passwords Stored By XP
from Lockergnome
Windows XP gives you the ability to store user names and passwords on your local computer so
you do not have to enter in your credentials each time you access different sites or resources.
Of course this provides some simplicity for users that have to remember more than one user
name and password.  However, in terms of security, any one who sits down at your computer
while you are logged on can then access sites and resources using your cached credentials.

You can view and remove the stored credentials on your computer using the following steps:

1.  Click Start and select Run. 
2.  Type in rundll32.exe keymgr.dll, KRShowKeyMgr and click OK. 
3.  The Stored User Names and Passwords dialog box will appear. 

http://tinyurl.com/5ttd6
http://channels.lockergnome.com/windows/archives/20050811_remove_passwords_stored_by_xp.phtml
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4.  You can remove an entry by selecting it from the list and clicking the Remove button. 
5.  Click Close.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Most Applications: Zooming
If you have a scroll wheel mouse, you can use the wheel to enlarge or shrink the screen size of
your document or worksheet. Hold down the <Ctrl> key and spin the wheel toward yourself to
zoom out or away from yourself (forward) to zoom back in. You may need to enable this
feature to make it work properly; to do so, in Word or Excel, choose Tools, Options, click the
General tab, and check the Zoom on Roll with Intellimouse box (a scroll mouse of any brand
will work).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Return to Where You Where
Wouldn't it be nice to quickly return to the place in your document where you left off when you
last saved? Press <Shift>-<F5> and you're there. In fact, you can repeat the key combo to go
to the last three places you made changes.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

IE New Window Maximizer v2.3
If you're an avid multitasker, you know all too well how quickly your desktop can get cluttered
with windows. Though this utility doesn't solve that problem, it gives you at least a semblance
of order by automatically maximizing every new Internet Explorer window that you open. It
includes a function for hiding or closing all IE windows with a user-defined hot-key; you can
also specify a particular IE window that will not be hidden or closed when you use the hot-key.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Adjust text to fit within an Excel cell 
Microsoft Excel™'s AutoFit feature is great when you need to resize a cell to display more text
than the cell currently allows. But when you can't change the size of a cell to fit the text, this
tip shows how you can resize the text to fit within the cell. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Shortcuts with your Mouse

– double click a number in a numbered list. This opens the numbered tab in the Bullets And
Numbering dialog box.

http://www.pcworld.com/downloads/file_description/0,fid,22832,00.asp
http://techrepublic.com.com/5100-10877-5842320.html
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– Hold down [Ctrl] and click within a sentence to select the sentence.

– Double-click a WordArt object to open the Edit WordArt dialog box.

SchoolCounselor.com E-Newsletter Download. 
Get Issues of 20-45 of the SchoolCounselor.com newsletter in one file with active
hyperlinks throughout ... This e-book is a compilation of the last 26 issues as they were
published on the SchoolCounselor.com website with only a couple of changes. For one, 48 of
the 478 links on the pages were no longer active and either updated or removed. So, even
though some issues of the newsletter are several years old, this should provide you with
websites that have stood the test of time. Second, I’ve made sure that all links on these
pages are active so that you may conveniently click on any resource (usually blue and
underlined) and go right to that webpage – no need to type website addresses. Otherwise,
the integrity of these issues has been preserved. After purchasing, you will be sent directly to
a web page with the download link. As well, you will receive an e-mail with the same link.
The download is a PDF file which requires the free Adobe Acrobat Reader. 
http://www.schoolcounselor.com/NEWSLETTER/ 
Only $8.95
171 Pages (PDF file)
Almost 500 links.

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Malicious Software Removal Tool for Windows 
Microsoft has, this week, released an updated version of its Malicious Software Removal Tool
for Windows (KB890830). This free tool is not a replacement for anti-virus, anti-spyware, or
anti-spamware. Rather it is a separate, additional tool (and did I mention that it’s free?),
offered by Microsoft, which seeks out and destroys specific, targeted malicious software, such
as Sasser and MyDoom. The newest version, released just yesterday, will remove Spyboter,
Dumaru, and Bagz malware, in addition to Netsky, Wootbot, Sober, and a host of others.
http://support.microsoft.com/?kbid=890830 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Talk (beta)
They say talk is cheap. Google thinks it should be free. Google Talk enables you to call or send
instant messages to your friends for free–anytime, anywhere in the world.  Google Talk is in
beta and requires a Gmail username and password.
http://www.google.com/talk/ 

http://www.schoolcounselor.com/NEWSLETTER/
http://support.microsoft.com/?kbid=890830
http://www.google.com/talk/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Podcasting
Podcasting is a method of publishing audio broadcasts via the Internet, allowing users to
subscribe to a feed of new files (usually MP3s). It became popular in late 2004, largely due to
automatic downloading of audio onto portable players or personal computers. Read more from
Wikipedia, the free encyclopedia ...
http://en.wikipedia.org/wiki/Podcasting 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Diary Project
According to the site, this is a site where “teens can share their innermost secrets and feelings
with honesty, openness and connectedness - anonymously. It's a place where you can
celebrate victories, share insights and inspire others to do the same. The site provides an
impartial audience that can acknowledge and understand your feelings. It encourages
self-expression, as well as listening. We hope that you will use this site as a means of positive
interaction with other teens and a source of comfort for yourselves. We look forward to hearing
from you.”
http://www.diaryproject.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HIV Prevention Counseling: A Client-Centered Approach is a free program, based on
the "Virtual Practicum" model, for individuals who are, or will be, engaged in counseling to
reduce the risk of contracting or transmitting HIV.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Blogger for Microsoft Word™ 
Now you can use Blogger right within Microsoft® Word. 
http://buzz.blogger.com/bloggerforword.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Teen Chat Decoder 
It can be quite confusing when trying to understand just what the heck some teens are talking
about when they use chat rooms & Instant messaging lingo.  Teen Chat Decoder is an Acronym
Decoder Software that 'Cracks the Secret Teen Lingo code' your teen uses in Chat Rooms,
Instant Messages, & Text Messages - for FREE!
http://www.teenchatdecoder.com/ 

http://en.wikipedia.org/wiki/Podcasting
http://www.diaryproject.com/
http://iml.dartmouth.edu/education/cme/HIV_Prevention/install.html
http://iml.dartmouth.edu/education/cme/HIV_Prevention/install.html
http://buzz.blogger.com/bloggerforword.html
http://www.teenchatdecoder.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Anatomy of an Excel formula: Using functions to perform calculations
Sometimes we take for granted what users know. While Microsoft Excel™ may be familiar to
you, if you are on a help desk you will have to explain how the application works to users that
fall within a vast range of skill level and knowledge. This series of Excel tutorials can make that
training much simpler. A formula is a recipe that lets you make calculations in Excel based on
any number of factors. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Desktop 2.0 Beta
Google has rolled out a beta version of its desktop software, adding such features as "Sidebar,"
which offers a personalized panel of information such as e-mail, stock quotes and news. I
updated myself a couple of days ago and I have to say I’m very impressed. 
http://desktop.google.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Technology Grants
Others ask be about educational technology grants. Following are several websites that will
help:

-- THE Journal http://www.thejournal.com/ 
-- Educauase http://www.educause.edu/ 
-- George Lucas Foundation http://www.edutopia.org/ 
-- TechLearning http://www.techlearning.com/resources/grants.jhtml 
-- USDOE office of tech http://www.ed.gov/about/offices/list/os/technology/index.html 

And more using this google search:
http://tinyurl.com/89pfh 

JUST FOR FUN

Planarity
Click on the little blue dots, which we call vertices, and then drag them to a new position. Try
to arrange the vertices so none of the lines intersect. These lines are also called edges. When
none of the lines intersect, then click on the "Check Solution" button. If your solution is correct,
you will go to the next level.
http://www.planarity.net 

http://techrepublic.com.com/5100-10877_11-5841667.html?tag=html.alert#
http://desktop.google.com/
http://www.thejournal.com/
http://www.educause.edu/
http://www.edutopia.org/
http://www.techlearning.com/resources/grants.jhtml
http://www.ed.gov/about/offices/list/os/technology/index.html
http://tinyurl.com/89pfh
http://www.planarity.net
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

SoundClick is a music website that features both signed and unsigned bands.  You will find
well-known artists such as Janet Jackson, Sarah McLachlan, Moby, Gravediggaz, PM Dawn, Phil
Collins, Peter Gabriel, Kate Bush, Letters To Cleo. But we also offer thousands of great
unsigned bands looking for their big break.
http://www.soundclick.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Video Search: School (or Guidance) Counselor
Google Video offers viewers a way to see material from archived TV programs, educational
videos, personal productions and more. 
http://tinyurl.com/byrs7 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Unclaimed Property: Recover lost money!
The NAUPA website consists of state officials charged with the responsibility of collecting and
reuniting lost owners with their unclaimed property. This site was developed by state unclaimed
property experts to assist you - free of charge - in your efforts to search for funds that may
belong to you or your relatives. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Flickr
Flickr is a way to get your photos to the people who matter to you. You can also turn your
picture into a fun magazine cover!
http://www.flickr.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Cool Story: Libraries Offering Audiobook Downloads
A new way to borrow audiobooks from the library involves no CDs, no car trips, no fines and no
risk of being shushed. Rather, public libraries from New York City to Alameda, Calif., are letting
patrons download Tom Clancy techno-thrillers, Arabic tutorials and other titles to which they
can listen on their computers or portable music players - all without leaving home.

____________________________________________

http://www.soundclick.com/
http://tinyurl.com/byrs7
http://www.unclaimed.org/mainframe.asp?VisitorType=owner
http://www.flickr.com/
http://apnews.myway.com/article/20050826/D8C7GQLG0.html
http://www.schoolcounselor.com/advertising.htm
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SchoolCounselor.com eNewsletter #47 - Sept. 11, 2005 

There are two ways of constructing a software design. One way is to
make it so simple that there are obviously no deficiencies. And the other
way is to make it so complicated that there are no obvious deficiencies.
– C. A. R. Hoare

"Imagine if every Thursday your shoes exploded if you tied them the
usual way. This happens to us all the time with computers, and nobody
thinks of complaining." – Jef Raskin

____________________________________________

FREQUENTLY ASKED QUESTIONS

Q: Is there a way for me to search within a page on the web. For instance, I often navigate to
the ASCA Ethical Standards and want to review just the part on sole-possession notes. It would
be nice to quickly go directly to the point in the document. 

A: Once you have located the site and the particular page that contains the information you
need, you may find that the page is very long. Instead of reading a long document, you may
want to conduct a page search using certain keywords. Fortunately, if you’ve done this in other
Microsoft programs (e.g., Word), you will know how to do it in Internet Explorer, it’s the same
procedure. To search a page in Internet Explorer, click on [Edit] and then [Find (on this page)]
or press CTRL-F on the keyboard as a shortcut. Then simply put in your keywords and press
Enter or [Find Next]. Notice that you can check or uncheck certain options such as to search up
the page or down the page. You can also restrict your search to whole words only and find an
exact match which takes into consideration capitalization. 

In Mozilla Firefox, it’s even easier.   The first part is exactly the same as Internet Explorer (i.e.,
click on [Edit] and then [Find (on this page)] or press CTRL-F on the keyboard as a shortcut).
On the bottom left of your screen you will find the search window. Start typing in your search
words and you’ll notice that Firefox immediately begins looking for those words in the
document. The more you type, the more it finds.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Your question here ...  Do you have a question about how technology can help you become
more effective, efficient, or have more fun in your work?  What types of tasks do you work on
that beg for an easier way to do it? Do you ask yourself how you might get more out of the
technology tools that you already have? Have you ever told yourself there must be a better
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way? All questions are smart questions.  E-mail me your questions
(newsletter@schoolcounselor.com) now and I might include the answers in a future newsletter. 

Educational and Inspirational Posters for your Home and Office
http://www.schoolcounselor.com/posters.htm 

TIPS AND TRICKS

Mixing Column and Paragraph Formats In Microsoft Word™ Documents
from TechRepublic
 
By default, Word's normal template is set to single-column format; thus, when you type a
paragraph, you are typing in single-column format. You can mix column with paragraph formats
in the same document by simply changing the column format. For example, you may want to
have your document open with an introductory paragraph or two, while the rest of the text is
formatted in three columns. To do this, follow these steps:

1. Type the opening paragraphs. 
2. Put your cursor where you want to begin the multi-column text. 
3. Go to Format | Columns. 
4. Enter 3 for the Number Of Columns, and make any necessary changes to Width And Spacing. 
5. In the Apply To drop-down menu, select This Point Forward. 
6. Click OK. 

To add a paragraph below your multi-column text, click where you want the paragraph to
begin, go to Format | Columns and change the number of columns to 1. Then, in the Apply To
drop-down menu select This Point Forward and Click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Create Charts and Diagrams in PowerPoint 2002
In this article, the authors explore some ideas, tips, and thoughts on using charts and diagrams
effectively in PowerPoint. While the techniques we outline below are for PowerPoint version
2002, many of these tips also work in previous versions.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Formatting
This series of Excel tutorials helps you with formatting a Microsoft Excel™ spreadsheet.

mailto:newsletter@schoolcounselor.com
http://www.schoolcounselor.com/posters.htm
http://techrepublic.com.com/5100-10877_11-5618013.html?tag=nl.e056
http://www.microsoft.com/office/previous/xp/columns/column09.asp
http://techrepublic.com.com/5100-10877_11-5856952.html?tag=html.alert#
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Text Wrap
These steps explain how to wrap text in a range of cells (columns, rows, or both).

1. Select the cell(s) that need text to wrap.
2. Go to the Format menu, Cells choice. (Ctrl + 1 works too.)
3. On the Alignment tab, check the Wrap Text box.
4. Now simple click OK to return to the worksheet.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows XP™: Filmstrip View
adapted from Worldstart

When Windows ME came on the scene it featured a cool folder view called " Thumbnail View "
that displays all images as little thumbnails to make them easier to manage. Win XP expanded
this feature, allowing us to add a picture to a file folder icon in thumbnail view. In addition, XP
has another view mode for pictures called " Filmstrip View. " In the My Pictures folder, and its
subfolders, you can see a "filmstrip" of images that scroll from left to right at the bottom of the
window. If you don’t see the filmstrip few after opening the My pictures folder, right click in any
open space, select View, and then Filmstrip. Remember that you’ll only have the filmstrips
option in the My Pictures folder. In other folders, highlight all of your picture files, right click
over them, and select View from the menu.  

Now, where were we? While you’re in films strip view, you will see in the upper part of the
window a preview pane where the image can be rotated clockwise or counter-clockwise. The
thumbnails in the filmstrip work just like they do in thumbnail view. This saves having to open
an image file in Picture viewer or some other imaging software to see a larger version of it. In
addition, you can drag the corner of the window to make it bigger (or click the "Maximize"
button)—the larger you make this window, the bigger the picture in the preview pane. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: How do I get Word to stop helping me type? 

There are several places to look to turn off Word's various automatic features: 
1. Choose AutoCorrect (or AutoCorrect Options) from the Tools menu, then click on the
AutoCorrect tab. 
2. Clear the check boxes for the AutoCorrect items that you want to disable. 
3. Do the same for the AutoFormat As You Type tab. 
4. On the AutoText tab, clear the Show AutoComplete tip check box. 

http://www.worldstart.com/tips/tips.php/112
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5. Choose Options from the Tools menu, then click on the tabs and clear any check boxes for
features that you want to disable.

Similarly, you can tell the Office Assistant to go away by following these procedures: 

1, Click on the Office Assistant, then click on Options. 
2. Clear the Use Office Assistant check box. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Replace Fonts Globally

You can quickly perform a global replace of any font used in a Microsoft PowerPoint
presentation using the Replace Font dialog box:

1. On the Format menu, click Replace Fonts. 
2. In the Replace Font dialog box, click the font you want to replace in the Replace list. 
3. In the With list, click the font you want to apply. 
4. Click Replace and review the font change. If you like what you see, click Close. If not, you
can continue making choices in the Replace Font dialog box until you find what you want. 

WORTHY WEBSITES AND SOFTWARE

Career CyberGuide
http://www.yorku.ca/careers/cyberguide/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free Web-based accounts offer more than just e-mail
Not long ago, a free Web-based e-mail account was good for merely sending and receiving
e-mail. As more players entered the market, competition forced new features. Here are four
favorite tricks for taking advantage of free e-mail services

~~~~~~~~~~~~~~~~~~~~~~~~~~~

REFDESK
In a library, if you don't know where to look for a reference book, you go to the Reference
Librarian. On the Internet, if you don't know where to look for answers, you go to Refdesk.com.
At first glance, the sheer amount of useful links on the Refdesk home page can be
overwhelming. But it's really quite well organized and useful. 
http://www.refdesk.com 

http://www.yorku.ca/careers/cyberguide/
http://www.usatoday.com/tech/columnist/kimkomando/2005-08-28-email-tips_x.htm
http://www.refdesk.com
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Dropload 
Dropload is a place for you to drop your files off and have them picked up by someone else at a
later time. Recipients you specify are sent an e-mail with instructions on how to download the
file. Files are removed from the system after 7 days, regardless if they have been picked up or
not. You can upload any type of file, mp3, movies, docs, pdfs, up to 100MB each! Recipients
can be anyone with an e-mail address.
http://www.dropload.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Get to know Microsoft Outlook
Know the basic types of Outlook Calendar entries, book activities into your calendar efficiently,
and stay on top of important dates with more advanced features such as recurrence and
reminders.

And ...

Tame the chaos of your Inbox: Learn about five features in Microsoft Office Outlook® 2003
that will help you find and use the messages you've decided to keep there. Click here.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™ Charting FAQs
Excellent tutorial for creating your charts. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Indeed.com 
Indeed is a search engine for jobs - with a radically different approach to job search. In one
simple search, Indeed gives job seekers free access to millions of employment opportunities
from hundreds of websites. Indeed.com includes all the job listings from major job boards,
newspapers, associations and company career pages - and we continue to add new sites every
day. 
http://www.indeed.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

September 11 Digital Archive 
The September 11 Digital Archive is dedicated to making sure America never forgets what
happened. Many visitors have shared their stories. You're encouraged to do the same. 

http://www.dropload.com/
http://office.microsoft.com/training/training.aspx?AssetID=RC011719291033
http://office.microsoft.com/training/training.aspx?AssetID=RC011156011033
http://pubs.logicalexpressions.com/Pub0009/LPMArticle.asp?ID=209
http://www.indeed.com
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Written accounts, photos and audio recordings will be preserved for future generations. You'll
also find links to resources and other memorial sites.
http://www.911digitalarchive.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™ Tutorial (PowerPoint format)
A great PowerPoint presentation tutorial about popular Excel features that all counselors should
understand.

Also see this one.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

MWSnap
MWSnap is a small yet powerful Windows program for snapping (capturing) images from
selected parts of the screen.  Current version is capable of capturing the whole desktop, a
highlighted window, an active menu, a control, or a fixed or free rectangular part of the screen.
MWSnap handles 5 most popular graphics formats and contains several graphical tools: a zoom,
a ruler, a color picker and a window spy. It can be also used as a fast picture viewer or
converter.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

American Red Cross Family Disaster Plan (PDF)
Not just a document but a checklist for planning and action. 

JUST FOR FUN

Yahoo! Widgets
Bring life to your desktop with fun Konfabulator Widgets. These little guys hang out on your
screen and give you quick, easy access to favorite content. You can even change their style to
match yours. They're fun, stylish, useful and 100% free!
http://widgets.yahoo.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Autostitch
Auto stitch your photos together to get a 360 degree panorama picture. This is a free program
that let's you stitch your photos together to get a 360 degree panorama picture. 

http://www.911digitalarchive.org/
http://download.microsoft.com/download/7/a/4/7a40c70e-0f19-4eef-9a69-c09a18e58c0c/Excel2002.ppt
http://people.ucsc.edu/~maichito/curriculum%202003/Microsoft%20Excel.ppt
http://www.mirekw.com/winfreeware/mwsnap.html
http://www.redcross.org/static/file_cont36_lang0_23.pdf
http://widgets.yahoo.com/
http://www.cs.ubc.ca/~mbrown/autostitch/autostitch.html
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Comic Strips
Quickly fetch one of many comic strips and easily subscribe to it.
http://isnoop.net/comics/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Just for Fun Tests
A whole new kind of Mini-Test! Entertaining yet revealing, the Just-For-Fun Tests give you a
quick glimpse into your psyche, sense of right and wrong, and personal quirks. 
http://www.queendom.com/tests/minitests/ 

 

http://isnoop.net/comics/
http://www.queendom.com/tests/minitests/
http://www.schoolcounselor.com/privacy.htm
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SchoolCounselor.com eNewsletter #48 – October 8, 2005

There's been so many changes with technology allowing people to make
music who haven't really taken the time to learn an instrument.  Christopher
Cross

"If I can operate Google, I can find anything... Google, combined with
Wi-Fi, is a little bit like God. God is wireless, God is everywhere and God

sees and knows everything. Throughout history, people connected to God without wires. Now,
for many questions in the world, you ask Google, and increasingly, you can do it without wires,
too."  Alan Cohen, V.P. of Airespace, a new Wi-Fi provider, New York Times, 6/29/03 

We must learn to balance the material wonders of technology with the spiritual demands of our
human race.  John Naisbitt
___________________________________________

FEATURE ARTICLE: Security Overview

Nobody is immune from catching a computer virus, becoming victim to a phishing scam,
or being the target of a clever piece of spyware unless one practices technology or computing
abstinence. To completely avoid computers, the Internet, and, to an increasing degree, gadgets
such as cell phones, PDA’s, and mp3 players is not an option in today’s high-tech world. You
can, however, significantly lower your risk by taking some precautions. Each of the next several
issues of the SchoolCounselor.com newsletter will feature detailed information about one of
seven common methods for significantly reducing your risk and include firewalls, spyware,
anti-virus, anti-fishing, root kit removal, Active X controls, and Anti-spam.  

Lets start with firewalls:

According to Microsoft, a firewall helps to keep your computer more secure. It restricts
information that comes to your computer from other computers, giving you more control over
the data on your computer and providing a line of defense against people or programs
(including viruses and worms) that try to connect to your computer without invitation. You can
think of a firewall as a barrier that checks information (often called traffic) coming from the
Internet or a network and then either turns it away or allows it to pass through to your
computer, depending on your firewall settings. Your school network probably has an excellent
firewall (and other filtering) precautions running and so you don’t need to worry about this. For
your home computer, however, this is a must, especially if you have a broadband (i.e., high
speed) connection (although most broadband service providers now usually have a firewall
running to block out unwanted intrusions before they can get to your computer).

http://www.schoolcounselor.com/pdf/booklet.pdf
http://en.wikipedia.org/wiki/Firewall_%28networking%29
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If you use Windows XP and have updated to the latest version (Service Pack 2, better
known as SP2), you already have a firewall installed. To make sure that it’s turned on (the
default setting), click on Start, Control Panel, Security Center, then click on Windows Firewall.
Confirm that the “On” setting is active. In my opinion, it doesn’t hurt to have a second firewall
running at the same time. Fore several years, I ran Norton Personal Firewall which I found to
be an excellent product. It will cost you about $30-$40 per year to continue accessing the
company’s update engine, and you do need to keep it updated. Recently, I’ve moved to a free
firewall which seems to do just as good a job – ZoneAlarm from Zonelabs. Another free firewall
program that has received very good reviews is Sygate Personal Firewall. Also know that if you
purchased a wireless router (the device that allows you to access the internet wirelessly with
wireless capable devices), it may also have a built in firewall. 

I should also warn you that firewall programs can be quite annoying for the first couple
or three weeks of use. Any program on your computer that tries to access the Internet will be 
stopped by the firewall until you either approve it or disapprove it. Most programs today will at
one time or another access the Web to look for updates for itself. After a bit of time, these
interruptions do not occur nearly as often. As a tip, if you are warned that a program is trying
to access the Web and you are not sure what the program is, you can Google the name of the
file that is in question. Chances are very good that there is a website out there that will tell you
what it is and if it can be considered safe. 

By the way, the free version of ZoneAlarm also does a few other things that are quite
helpful. First, you can set it up to warn you if you might be submitting your password to a fake
eeeeBahy (spelled incorrectly on purpose so as not to trip you spam control) site. Second,
ZoneAlarm has a lock that can block Internet traffic while your computer is unattended or while
you're not using the Internet, and it can be activated automatically with your computer's screen
saver or after a set period of inactivity. To learn more, you can download the ZoneAlarm
manual here. 

Once you are set up, you can test your firewall capability with a free service called
ShieldsUP! which is an internet vulnerability analysis program. When I clicked the All Service
Ports button, and the remote server performed a comprehensive scan of all the ports at my IP
address. The scan took just over a minute and revealed that all of my ports--with one
exception--had been stealthed. That is, my firewall had rendered them invisible, so that any
computer trying to open ports on my machine's IP address would get no reply. Port 113 on my
system was marked as closed, meaning a remote machine would know a live system is out
there, but it would be unable to gain entry.

____________________________________________

http://www.symantec.com/sabu/nis/npf/
http://www.zonelabs.com/store/content/company/products/znalm/freeDownload.jsp?dc=12bms&ctry=US&lang=en
http://smb.sygate.com/products/spf_standard.htm
http://download.zonelabs.com/bin/media/pdf/zaclient60_user_manual.pdf
https://www.grc.com/x/ne.dll?bh0bkyd2
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Questions ... 

• I'm doing an in-service for parents about middle school transition and I don't want

to "reinvent the wheel." How do I find a such a Microsoft PowerPoint presentation

online? 

• I'm developing a handout for a classroom guidance and want to quickly find specific

illustrations that fit, how do I do that? How do I copy these images into my

Microsoft Word file? 

• How might I quickly find and download sound and/or videos to include in my

presentations, use in class, or include in my work? 

• Once I find a website, how can I put a button on my browser to quickly get there

again without having to type in that long address? 

• What should I know about viruses? 

• How do I translate into Spanish or another language an e-mail or letter to a parent?

• Once I find a site that I like, how can I find related sites and return to these sites

quickly?

• What is an Internet Explorer plugin or addin?

• How exactly do I expand or narrow my searched to find just what I'm looking for? 

• What other tools does Google offer me?

• How can I become a power Googler?

Answers .... 

World Wide Web Boot Camp for School Counselors - CD
Russell A. Sabella, Ph.D.  

     With over 36 videos and lots of tips, tricks, links, this CD gives you step-by-step
instructions for effectively and efficiently navigating the Web. Because all the files are on the
CD, you won’t need to connect to the Internet for all the essential information (only linked
web sites require an Internet connection). What you see and hear on the videos is what you
do. This straightforward approach makes learning how to use the Web as easy and
convenient as watching television. This tool will help students, practitioners, and professors
alike spend less time searching and more time finding relevant resources available on the
Web. 

The content on the CD is equivalent to a full-day workshop in the computer lab. 

Windows Only (not available for the Macintosh) 30% OFF, NOW ONLY $13.95 (PLUS $2
DOWNLOAD SERVICE)! NOW AVAILABLE FOR DOWNLOAD, YOU’LL BE UP AND RUNNING IN

MINUTES.  Visit http://www.schoolcounselor.com/cd/ to view sample videos and order now. 
www.

http://www.schoolcounselor.com/cd/
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TIPS AND TRICKS

Beware Of Anonymous E-mail Online Postcards
Yet another e-mail online postcard virus has been launched. This time the unsuspecting user
gets a postcard from a “secret admirer” or other anonymous source, and when the user follows
the link in the e-mail to retrieve their “postcard,” what they really end up retrieving is the
Dloader-UT Trojan. Read more >>>

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Gmail Open Signup
Since Gmail first launched more than a year ago, people have sought out our web-based e-mail
program (which comes with more than 2.5GB of storage, great spam filters and built-in Google
search). But you had to be invited by a Gmail user to get an account. Now anyone can get a
free account by entering your mobile phone number (this helps combat spam). Google will send
you a text message with an invitation code to get started.
https://www.google.com/accounts/SmsMailSignup1 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Add Borders to Text in a Few Keystrokes
from TechRepublic
If you favor the ease of keyboard shortcuts to using menus and toolbars, then check out these
handy Microsoft Word™ tips on how to add a variety of borders to paragraphs in your
documents. Do you want to add a simple, black border above or below a paragraph in your
Microsoft Word™ document without having to go through the menus? Using your keyboard,
you can add a border in a couple of quick steps and eliminate much of the mouse clicking
involved with using the Format | Border And Shading menu or the toolbar.

Here's how to create a border above your paragraph:

1. Position the pointer at the beginning of the line where you want your border
to occur. 

2. Press the hyphen key [-] three or more times and then press [Enter]. 
3. While the keyboard method doesn't give you the same options to create a

custom line as you would have with the toolbar or menus, you are not limited
to a simple black line. You can vary the shape and thickness of the border by
substituting any one of the following keys for the hyphen:

• Underline [_]: produces a bold black line 
• Equals sign [=]: produces a double-line border 
• Asterisk [*]: produces a dotted border 

http://channels.lockergnome.com/windows/archives/20050928_beware_of_anonymous_email_online_postcards.phtml
https://www.google.com/accounts/SmsMailSignup1
http://techrepublic.com.com/5100-10877_11-5863568.html?tag=nl.e056
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• Tilde [~]: produces a wavy border 
• Number symbol [#]: produces a thick, solid black border with a thin line

above and below it. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tips for Faster Startups
Tired of waiting for your notebook to boot up and get to work? Some practical and easy tips for
getting started more quickly.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Most Windows Programs and Files: Close It Up In A Hurry
To quickly closing file press Ctrl + F4.
To quickly close a program press Alt + F4 (if you press Alt - F4 while on the desktop, your
computer will bring up the logoff or shut down menu.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows Media Player 9 Series and 10 Series Add-in for Microsoft FrontPage
This add-in enables new capabilities for FrontPage users including the ability to: Easily embed
the Windows Media Player 9 Series or 10 Series control into FrontPage web pages and
SharePoint sites; Control the look and feel of the media playback experience; Easily convert
your media files for efficient network delivery. Publish to a Web or streaming server
automatically. All this from within the add-in's wizard without having to write any script!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

5 Ways School Counselors Can Use Technology When Working with At-Risk School
Children 
By Russell Sabella, Ph.D. for the American School Counselor Association and the Guidance
Channel. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: 10 Things You Should Know About PowerPoint Abuse
Who hasn't sat through a badly constructed, poorly delivered presentation? This list will help
you avoid some of the most commonly made PowerPoint blunders. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://msn.pcworld.com/news/article/0,aid,122288,00.asp
http://www.microsoft.com/downloads/details.aspx?FamilyID=98a35ced-f950-4bd8-8e96-adad9335ac77&displaylang=en
http://www.guidancechannel.org/default.aspx?index=1874&cat=13
http://www.guidancechannel.org/default.aspx?index=1874&cat=13
http://techrepublic.com.com/5100-10877_11-5875608.html?tag=html.alert#
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Microsoft Word™: Thesaurus
MS Word comes with a built-in Thesaurus. All you have to do is get it started. First you'll need
to highlight the word that you want replaced. Now you're ready to activate the Thesaurus. You
could go to the Tools menu, Language submenu, and Thesaurus choice. You could also just use
Shift + F7. That seems faster to me, but you decide. A window will open with a list of any
meanings Word may have and a list of synonyms for you to choose from

WORTHY WEBSITES AND SOFTWARE

Google.com Hurricane Resources 
Includes important links and If people search based on various public databases.  
http://www.google.com/hurricane.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

NerdTV
NerdTV is a new weekly online TV show from PBS.org technology columnist Robert X. Cringely.
NerdTV is essentially Charlie Rose for geeks - a one-hour interview show with a single guest
from the world of technology. Guests like Sun Microsystems co-founder Bill Joy or Apple
computer inventor Steve Wozniak are household names if your household is nerdy enough, but
as historical figures and geniuses in their own right, they have plenty to say to ALL of us.
NerdTV is distributed under a Creative Commons license so viewers can legally share the shows
with their friends and even edit their own versions. If not THE future of television, NerdTV
represents A future of television for niche audiences that have deep interest in certain topics.
http://www.pbs.org/cringely/nerdtv/  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Teen Arrive Alive
Teen Arrive Alive helps to keep teens safe, which provides parents with considerable peace of
mind. Through the Teen Arrive Alive GPS and decal programs parents can now receive
immediate input to counsel their teens on safe driving habits and hopefully avoid tragic
accidents....or they will be able to locate lost or missing children right away without precious
time delays. Just knowing when you need to act is what makes Teen Arrive Alive so important
in helping to keep our teens safe. 
http://www.teenarrivealive.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Latest in Outsourcing: Homework 
By Saritha Rai The New York Times (THURSDAY, SEPTEMBER 8, 2005)

http://www.google.com/hurricane.html
http://www.pbs.org/cringely/nerdtv/
http://www.teenarrivealive.com/
http://www.iht.com/articles/2005/09/07/business/tutors.php
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Monthly Calendar Wallpaper
These can come in handy and are pretty to look at. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Acoustic spying decodes typists' tapping
Sounds from typing on computer keyboards are distinctive enough to be decoded, allowing
security breaches caused by "acoustic snooping," researchers say. Researchers at the University
of California say they were able to feed sound recordings of typing on keyboards into a
computer and use an algorithm to recover up to 96 per cent of the keyboard characters entered
by typists. Read more >>>

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What Exactly Is MySpace And Should I Let My Child Use It?
MySpace.com is a recent social-networking phenomenon and a testament to how easy the
Internet makes it to become part of a virtual community. Click and read more.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Bartleby 
Bartleby is a virtual library. There are a number of encyclopedias, in addition to style guides
and other reference books. You'll also find classic works, including a selection of Shakespeare's
plays and poetry.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Online Translators
Online translators can help you (and students) translate important documents . They're not
perfect--a teacher would be able to spot a translation generated by one of these. But it can
help students understand difficult passages. Three translation sites include Alta Vista, Google
Language Tools and World Lingo. Just copy and paste your text and select the language. Those
three sites are at:

    http://www.world.altavista.com/ 
    http://www.google.com/language_tools 
    http://www.worldlingo.com/ 

____________________________________________

http://www.worldstart.com/month-wallpaper-calendar.htm?09
http://www.abc.net.au/news/newsitems/200509/s1460695.htm
http://channels.lockergnome.com/windows/archives/20050916_what_exactly_is_myspace_and_should_i_let_my_child_use_it.phtml
http://www.bartleby.com
http://www.world.altavista.com/
http://www.google.com/language_tools
http://www.worldlingo.com/
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JUST FOR FUN

Virtual Help to Eating Better
The Carrollton-Farmers Branch (TX) School District has launched a web-based Virtual Cafeteria
that students can use to calculate the calories, fat grams, carbs, protein, vitamin A and vitamin
C in their lunch choices. Try planning your own meal.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Wordsmith.org
Wordsmith.org is a worldwide online community of some half-million people who share a love
for words, wordplay, language, and literature. They hail from Australia to Zimbabwe and almost
all other places in between.
http://wordsmith.org/ 

also ...

At Dictionary.com, you can look up a word in either a dictionary or
Roget's Thesaurus (to find synonyms and antonyms). The site also offers Ask Doctor Dictionary
(for questions about words or grammar), the Word of the Day, daily crosswords & word search
puzzles, and a huge list of links to other online dictionaries, including hundreds of non-English
ones. 
http://dictionary.reference.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tic-Tac-Toe (SWF)
I can see this one being a nice warm up to working with elementary school students.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Name That Game
Match the game with the sound effect.  

http://studentnutrition.cfbisd.edu/content/story.aspx?type=customcontent&sid=1034036
http://tinyurl.com/dzhtp
http://wordsmith.org/
http://dictionary.reference.com/
http://bismanlug.org/staticpages/luggames/tictactoe.swf
http://www.pbs.org/kcts/videogamerevolution/arcade/name/name_that_game.swf
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SchoolCounselor.com eNewsletter #49 - October 27, 2005 

In view of all the deadly computer viruses that have been spreading lately,
Weekend Update would like to remind you: when you link up to another
computer, you're linking up to every computer that computer has ever linked
up to. — Dennis Miller

Students today depend upon paper too much. They don't know how to write
on slate without getting chalk dust all over themselves. They can't clean a
slate properly. What will they do when they run out of paper?  - Principal's Association, 1815 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Security Overview Part 2: Spyware

According to the Wikipedia, spyware is a broad category of malicious software intended
to intercept or take partial control of a computer's operation without the user's informed
consent. While the term taken literally suggests software that surreptitiously monitors the user,
it has come to refer more broadly to software that subverts the computer's operation for the
benefit of a third party. That is, spyware will monitor your activity on the Internet and transmit
that information in the background to someone else. Spyware is potentially dangerous because
it can record your keystrokes, history, passwords, and other confidential and private
information. Some software that you use may act like spyware although is actually (and
innocently) communicating with its developer to do things as check for program updates or
provide the developer with error information (for future development).

Spyware applications are typically bundled as a hidden component of freeware or
shareware programs that can be downloaded from the Internet; however, it should be noted
that the majority of shareware and freeware applications do not come with spyware.  So,
spyware is similar to a Trojan horse in that users unwittingly install the product when they
install something else (Webopedia, 2005).

Although there is no guarantee that you’ll always be free from spyware, there are some
things you can do to seriously lower your risk. First and foremost, you need to use an anti-
spyware program that detects and prevents spyware from installing itself on your computer
(and removes it).  Anti-spyware software can also periodically scan your computer for spyware
that may get through and remove it. Following are several of the most popular free anti-
spyware programs:

• Spyware Blaster

http://en.wikipedia.org/wiki/Spyware
http://www.webopedia.com/TERM/s/spyware.html
http://www.javacoolsoftware.com/spywareblaster.html
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• Ad-Aware SE Personal Edition
• Microsoft Windows AntiSpyware
• Spybot Search & Destroy

Personally, I use two of the above programs (Ad-Aware and Microsoft AntiSpyware)
because no one anti-spyware program is known to catch 100% of all spyware.  The two
together seem to do a fantastic job of keeping me spyware free.  Remember, your anti-spyware
software needs to stay updated, on a daily basis, to stay effective at catching all the newly
developed spyware.  And, your anti-spyware program should automatically run system scans on
your computer at least once per day.  Ad-Aware SE Personal Edition does not do either of these
automatically (you have to do it manually) although Ad-Aware SE Professional edition does (this
will cost you about $40).  Microsoft’s AntiSpyware software does scan and update itself
automatically.  

Also, here are some other steps to consider to reduce your risk of being infected by spyware : 

1. If you use Windows XP, one way to help prevent spyware and other
unwanted software is to make sure all your software is updated. Visit
Microsoft Update to confirm that you have Automatic Updates turned on and
that you've downloaded all the latest critical and security updates.

2. While most spyware and other unwanted software come bundled with other
programs or originate from unscrupulous Web sites, a small amount of
spyware can actually be placed on your computer remotely by hackers.
Installing a firewall or using the firewall that's built into Windows XP
provides a helpful defense against these hackers. (See Security Overview
Part 1: Firewalls).

3. Don’t click on links in e-mail spam that claim to offer anti-spyware software.
Some software offered in spam actually installs spyware.

4. Surf and download more safely. The best defense against spyware and other
unwanted software is not to download it in the first place. Here are a few
helpful tips that can protect you from downloading software you don't want:

a. Only download programs from Web sites you trust. If you're not sure whether to
trust a program you are considering downloading, ask a knowledgeable friend or
enter the name of the program into your favorite search engine to see if anyone
else has reported that it contains spyware.

b. Read all security warnings, license agreements, and privacy statements
associated with any software you download.

http://www.download.com/Ad-Aware-SE-Personal-Edition/3000-8022_4-10045910.html?part=dl-ad-aware&subj=dl&tag=top5
http://www.microsoft.com/athome/security/spyware/software/default.mspx
http://www.safer-networking.org/en/index.html
http://go.microsoft.com/?linkid=3646728
http://www.schoolcounselor.com/NEWSLETTER/newsletter48.htm
http://www.schoolcounselor.com/NEWSLETTER/newsletter48.htm
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c. Never click "agree" or "OK" to close a window. Instead, click the red "x" in the
corner of the window or press the Alt + F4 buttons on your keyboard to close a
window.

d. Be wary of popular "free" music and movie file-sharing programs, and be sure
you clearly understand all of the software packaged with those programs.
(Source: Microsoft Corporation)

 
To learn more, visit these website:

• Signs of spyware from Microsoft Corporation
• Learn What Spyware Is, How To Stop It from HowStuffWorks.com
• FTC Alert about Spyware

Next Issue: Part 3: Viruses
____________________________________________

TIPS AND TRICKS

Microsoft Excel™: Faster Access to Worksheets
When working with large workbooks in which all of the worksheet tabs are not visible, your
users may get frustrated with scrolling to find the sheet they need. Here's a really quick tip to
pass on. Right-click on any of the tab-scrolling buttons (to the left of the sheet tabs) and a
shortcut menu will pop up. You can then select the tab you want.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Print Worksheet Column Labels on Every Page
Multipage printouts of large worksheets are difficult to read when their column labels appear
only on the first page. For example, suppose you have a 10-column, 1000-row worksheet and
the labels for each column are contained in row one. Follow these steps to have the column
labels print on every page:

1. Click anywhere in the worksheet, and select File | Page Setup.
2. Click Sheet and, under Print Titles, click the collapse dialog box at the right end of the Rows
To Repeat At Top text box.
3. Select a cell in the title row. The range $1:$1 appears in the text box.
4. Click the collapse dialog box at the right end of the Page Setup--Rows To Repeat At Top text
box.
5. Select Print.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.microsoft.com/athome/security/spyware/spywareprevent.mspx
http://www.microsoft.com/athome/security/spyware/spywaresigns.mspx
http://www.themilwaukeechannel.com/technology/4376879/detail.html
http://www.ftc.gov/bcp/conline/pubs/alerts/spywarealrt.htm
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Microsoft Excel™: Text to Speech
I hate proofreading! I’ve just finished keying this list of 150 numbers from a printed piece of
paper. My eyes have glazed over and the odds of me being able to accurately proofread are
slim. It would help if I had someone to read me the numbers and I could cross-check them
against the piece of paper. It turns out that Excel has a cool feature where you can highlight a
range of cells and have Excel speak the values in those cells. This will allow you to listen to the
numbers while you compare them to the printed paper. When you involve two senses (hearing
and sight), you will engage more of your brain and the process will be less tedious. Read more
>>>

Also, visit http://www.bell-labs.com/project/tts/voices.html for a Text-to-Speech Synthesis web
page from Lucent Technologies.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Adding Background Color

You can add background color to a cell or group of cells:

1.  Go to cell B1. 
2.  Choose Format > Cells  from the menu. 
3.  Choose the Patterns tab. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Phishing: Falling Hook, Line and Sinker
Tips for Quickly Spotting and Avoiding Phishing Scams 
by Ron Pacchiano 
A phishing victim explains how he was reeled in by a bogus e-mail. We also offer tips on how to
quickly spot schemes designed to steal your identity and offer some advice on what to do if
you're caught in a phisher's net. 
http://www.winplanet.com/article/3038-.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Function
Here is a keyboard shortcut to the Paste Function window – a real time saver! Next time you
need to look up an Excel function try Shift + F3. The Paste Function window will immediately
pop open and you're quickly on your quest for that elusive function.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.mrexcel.com/tip097.shtml
http://www.mrexcel.com/tip097.shtml
http://www.bell-labs.com/project/tts/voices.html
http://www.winplanet.com/article/3038-.htm
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Microsoft PowerPoint: Awards and Certificate Templates
All free! Also, check out PowerPoint Calendar templates here and this Back to School Template
here. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Undo 
from http://www.worldstart.com/ 
Do you "Undo" frequently in MS PowerPoint? Ever find that you've exhausted the available
undo list and still have more changes to reverse? Frustrating, isn't it? If you're interested in
having a longer undo list in PowerPoint, go to the Tools menu, Options choice, Edit tab. See the
Undo section? In that field, you can choose to increase or decrease the number of steps. My
program gave me a range from 3 to 150 steps that the undo list will store. Change the number
as you wish and click OK. It's up to you how much you want to undo!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™:  Calculate Percent Change
Note: An oldy but a goody from Issue #25

First you need to know the formula for percent change which is post-data minus pre-data
divided by pre-data. So for instance, if student Judy was absent 7 days in quarter 2 and she
was absent 12 days in quarter 1, the percent change is (7-12)/7 = -.714 which translates into a
minus 71% difference. Thus, Judy was present 71% more often in the second quarter than in
the first. 

In Microsoft Excel™, formulas must begin with either the plus or equal sign (+ or +) so you
would input =(7-12)/7. There are two ways to change the result to percentage format. Either
you can just simple multiply the equation by 100 so it looks like this ((7-12)/7)*100) or you can
right click on the cell, choose Format Cells, Number tab, Percentage. To apply the formatting to
multiple cells, first highlight or block the cells and then do this. To apply to an entire column or
row, left click on the gray part of the column or cell (columns have letters in them and rows
have numbers in them) and then do this procedure. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Print Selected Pages
from VitalNews
Word gives you complete control over how it prints your document. You can either print the
entire document, or you can print a portion of it. To print only selected pages, follow these
steps:

http://office.microsoft.com/en-us/templates/CT011377331033.aspx
http://office.microsoft.com/en-us/templates/CT011377341033.aspx
http://office.microsoft.com/en-us/templates/CT011377351033.aspx
http://www.worldstart.com/
http://wordtips.vitalnews.com/Pages/T0691_Printing_Only_Selected_Pages.html
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1. Choose Print from the File menu. You will see the Print dialog box. (Click here to see a
related figure.) 
2. In the Pages box, indicate the page numbers you want to print. 
3. Click on OK. 

When you specify page numbers, Word allows you quite a bit of flexibility. The following are
some general guidelines for specifying page numbers:

• You can specify a single page number. 
• You can specify a group of non-sequential pages by separating them by

commas, i.e., 4, 8, 19. 
• You can specify a sequential range of pages by putting a dash between them.

Thus, 4-7 would print pages 4 through 7. 
• You can print an entire section by using s. For instance, to print section 5 of

your document, you would use s5. 
• You can print multiple sections the same as you would print multiple pages.

For example, s2, s6 would print sections 2 and 6. 
• You can specify pages within a section by using s and p with page numbers.

For instance, if you want to print pages 2 through 7 of section 4, you would
use p2s4-p7s4. 

• You can specify a range of pages across sections in the same manner. To
print beginning with page 2 of section 4 and ending with page 5 of section 7
you would use p2s4-p5s7. 

By the way, Word uses section breaks to specify parts of a document that have different page
orientation, columns, or headers and footers. Section breaks allow the user to not only print
only sections of a document, but to also specify where the different formatting will begin and
end. You might use section breaks in the following circumstances:  Different headers and
footers. If the document you are working on needs to have different headers and footers on
various pages, you would use section breaks to achieve this.  

• Different numbering schemes. If you are working in a document where the
Table of Contents needs lower case Roman numerals, the contract needs
Arabic numerals, and the Appendices need alphabetic numerals, you can
achieve all of these with section breaks.  

• Different paper sizes. If you want a document to contain one portrait page
and one landscape page, you'll need a section break between the pages.  

• Different margins. If the first page of a letter needs a two-inch margin, and
the following pages need a different margin, you'll need a section break in
the document.  

• Columns. You can use Word's newspaper column feature in the middle of a
page, and place section breaks before and after the multiple columns. If you
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have text prepared and put it into a column format, word will automatically
put in the section breaks. 

Here is how you do it:

1. Click on Insert
2. Choose Break
3. Choose one of the “Section Break Types”

• Next page inserts a section break and starts the new section on the next
page.

• Continuous inserts a section break and starts the new section on the same
page.

• Odd page or Even page inserts a section break and starts the new section on
the next odd-numbered or even-numbered page.

WORTHY WEBSITES AND SOFTWARE

Teach the Children Well 
Teach the Children Well is a collection of links to sites carefully selected by a teacher
for students as well as their parents and teachers. The site was designed for elementary grades
but many of the sites will also be of interest to older students.
http://www.teachthechildrenwell.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

OpenOffice
Programmers released version 2 of OpenOffice.org this week, a major overhaul to an
open-source software suite that has recently become a more serious rival to Microsoft Office.
OpenOffice.org 2.0 is the productivity suite that individuals, governments, and corporations
around the world have been expecting for the last two years. Easy to use and fluidly
interoperable with every major office suite, OpenOffice.org 2.0 realizes the potential of open
source. With new features, advanced XML capabilities and native support for the OASIS
Standard OpenDocument format, OpenOffice.org 2.0 gives users around the globe the tools to
be engaged and productive members of their society.
http://www.openoffice.org/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.teachthechildrenwell.com/
http://www.openoffice.org/
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Aytozon
Comparison shopping on eBay and Amazon now made much easier.
http://aytozon.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Flu Shot Finder
If you're looking for a place where you can get vaccinated this flu season, check out the
Asthma and Allergy Foundation of America's Flu Shot Finder, available at
http://www.aafa.org/flu.cfm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

CounselingSurveys.org
from Timothy Baker, Ed.S., NCC

If you are currently investigating the most effective and ethical way to incorporate electronic
survey instruments into Counseling research, you may find my non-profit web site the answer
to your question. CounselingSurveys.org is a site I created to facilitate high-quality electronic
surveys that would project the professional image of counselors. Researchers and participants
alike find these surveys easy to use, and the design of the site helps all survey respondents
experience a standardized, easy-to-understand informed consent process. If you notice a
familiar layout as you browse the site, you're not mistaken: CounselingSurveys.org is not a new
service. It has generated surveys already in widespread distribution. For the first two years of
this site's development, I focused on refining the nature of services for the initial pool of users,
which included dissertating students and tenure-seeking faculty. In turn, their input has helped
ensure that the site works consistently and offers the features most needed by counselors.

CounselingSurveys.org is free for use by counselors. To sign up, begin the self-registration
process by clicking on: http://www.CounselingSurveys.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Post-it® Software Notes 
What happens when you cross a Post-it® Note with a computer? Post-it® Software Notes - the
classic yellow note designed for your PC! You can use this digital version of the famous canary
yellow® note to remind you to do something, to capture an idea or to organize all those
important phone numbers -- all from your computer desktop. Options include Standard,
Professional, or the Free Lite version. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://aytozon.com/
http://www.aafa.org/flu.cfm
http://www.CounselingSurveys.org/
http://www.CounselingSurveys.org/
http://www.3m.com/market/office/postit/com_prod/psnotes/index.html
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A Field Guide to Parents
Famed for its vast appetite for information and ability to protect its offspring, the parent genus
has nonetheless eluded scientific study. Until now. Click below to learn about such parent
species as: (1) Parentis Hardtofindis, the elusive parent; (2) Parentis Aggresivis, the angry
parent; (3) Parentis Enthusiasticus, the eager parent; (4) Parentis Officina, the busy parent;
and (5) Parentis Diffralingua, the English-learning parent. In this year's MetLife Survey, new
teachers said parent communication is tougher than classroom discipline! According to Mary
Ellen Flannery, making parents full partners in their children's education is a challenge -- and it
can be particularly difficult for new teachers.
http://www.nea.org/neatoday/0510/parenting.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Online Relaxation Audio (MP3's)
Produced by the University of Texas at Austin Counseling & Mental Health Center, 10 Tracks to
Help Keep You On Track!
http://www.utexas.edu/student/cmhc/RelaxationTape/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

PDFCreator
PDFCreator is a free tool to create PDFs easily from nearly any application. With the PDFCreator
Printer driver you turn any program into a PDF-machine
http://sector7g.wurzel6.de/pdfcreator/index_en.htm 

____________________________________________

JUST FOR FUN

WebCam Central 
WebCam Central links to Webcams all over the world. Search by category or location. Or, if
you're feeling lucky, click random cam and it will choose a cam for you. Who knows what you'll
see. 
http://www.camcentral.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google.com: Find Just the Right Movie
With the Google “movie” operator, you can look for movies by titles, actors, directors, genre,
famous lines, plot details and more. In addition, you can find movie theaters and showtimes in
your area. Go to the Google.com search engine and put in the operator “movie:” (without the

http://www.nea.org/neatoday/0510/parenting.html
http://www.utexas.edu/student/cmhc/RelaxationTape/
http://sector7g.wurzel6.de/pdfcreator/index_en.htm
http://www.camcentral.com/


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 32

quotes). Following the colon, either put in some keywords (interests, movie title, actors, etc.) to
learn more about movies of interest or your zip code to get a listing for movies in your area.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

GoogleFight
Put in the two terms and click Make a fight. You'll see two animated stick figures duke it out.
Then the winner is shown, along with the number of times each term was entered.
http://www.googlefight.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

CandyStand
At Candystand, you can feast on games. There is a variety for you to play -- card games, trivia
games and even sports games. Or, if you're like me, you'll enjoy the puzzles. Fortunately, there
are plenty of choices.
http://www.candystand.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Blog
The Google Blog features frequent updates and insights from Googlers on technology, Google
products, and the company at large.
http://googleblog.blogspot.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Just for Fun Rubber Stamps
http://www.jffstamps.com/Sales/Store.asp 

http://www.googlefight.com/
http://www.candystand.com/
http://googleblog.blogspot.com
http://www.jffstamps.com/Sales/Store.asp
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SchoolCounselor.com eNewsletter #50 - Nov. 12, 2005

Bill Gates is a very rich man today... and do you want to know why? The
answer is one word: versions.  – Dave Barry

All sorts of computer errors are now turning up. You'd be surprised to
know the number of doctors who claim they are treating pregnant men. –
Isaac Asimov. 

Computer dating is fine, if you're a computer.  – Rita May Brown. 

______________________________________

Security Overview Part 3: Viruses

Excerpted from Sabella, R. A. (2003). SchoolCounselor.com: A friendly and practical guide
to the world wide web (2  edition). Minneapolis, MN: Educational Media Corporation. nd

Viruses

According to the Webopedia, a virus is a program or piece of code that is loaded
onto your computer without your knowledge and runs against your wishes. All computer
viruses are created by people and most can replicate themselves. A simple virus that
can make a copy of itself over and over again is relatively easy to produce. Even such a
simple virus is dangerous because it will quickly use all available memory and bring your
system to a halt. An even more dangerous type of virus is one capable of transmitting
itself across networks and bypassing security systems. To protect yourself from viruses
on the Internet, don’t download files from sources that may not be safe. Viruses are
usually hidden in programs and activated when the programs run. They also can be
attached to certain other types of executable files, such as special-action Web files and
video files. Generally, when you’re about to download a type of file that could contain a
virus, your browser will display a warning and ask whether you want to open the file or
save it to disk. If you’re confident that the file comes from a trustworthy source, you
may want to save it. If you’re not sure, you may want to cancel your download.
However, rather than practicing “download abstinence”, you might continue and have a
protected transaction by using an antivirus program which automatically scans all
incoming (and usually outgoing) files for known viruses. Most schools and other
organizations typically work very hard to make certain that you have anti-virus software
running on your computer. The reason for this is that any one person in an organization

http://www.webopedia.com/TERM/v/virus.html
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can put the entire group’s network, and computers attached to that network, at risk
with just one virus. 

If you don’t have antivirus software loaded on your computer either at work or at
home, you should get it right away. You might check out and use one of the following
as starters:

• Norton AntiVirus http://www.symantec.com 
• McAfee AntiVirus http://www.mcafee.com 
• PC-cillin http://www.trendmicro.com 
• AVG AntiVirus http://www.grisoft.com (Free)

Similar to adware or spyware, installing antivirus software alone is not enough.
You need to make sure that the software updates itself at least once per day if not
more. Without the latest virus definitions, you could be infected by a new virus not yet
recognized by your antivirus software. At work, I use McAfee which is provided by my
employer. At home, I use AVG antivirus since it works well and is free of charge. Both
of these program (as do the others I mention above) have automatic update features. 

Macro Viruses 

According to Whatis.com, a macro virus is a computer virus that "infects" a
Microsoft Word™ or similar application and causes a sequence of actions to be
performed automatically when the application is started or something else triggers it.
Macro viruses tend to be surprising but relatively harmless. A typical effect is the
undesired insertion of some comic text at certain points when writing a line. A macro
virus is often spread as an e-mail virus. A well-known example in March, 1999 was the
Melissa virus. Current versions of Microsoft Word™ and Excel warn you about
embedded macros as you first open a file. If you are sure that an embedded macro is
benevolent, enable them. If not, click “disable macros.” 

Trojan Horses

(By the way ... I know, I know, there is a difference among a virus, worm, and a trojan
horse .... although, why complicate things, they are all our virtual enemies). 

A Trojan Horse program, like the legendary wooden creature after which it is
named, offers you some apparent benefit (such as a pretty screen saver), encouraging

http://www.symantec.com
http://www.mcafee.com
http://www.trendmicro.com
http://www.grisoft.com
http://www.webopedia.com/DidYouKnow/Internet/2004/virus.asp
http://www.webopedia.com/DidYouKnow/Internet/2004/virus.asp
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you to install it and run it. After it gains your trust, it then has access to your machine
to do whatever else it likes in the background. As an example, in December, 1997, two
students wrote a software product that allowed users to customize their Internet
software. It appeared to work as advertised, but also secretly e-mailed the user’s
password to the students. This action went undetected until March of 1998, when the
students themselves revealed it to the press to demonstrate the security risks faced by
Internet users. Trojan horses are another good reason to invest in an effective antivirus
program. 

Unfortunately, antivirus programs alone are insufficient for reducing your risk of
becoming victim to a trojan horse program. One SchoolCounselor.com eNewsletter
reader, Erik Dial, M.S. a counselor from Milwaukee, Wisconsin, turned me on to a
program that protects against trojans and more called Ewido Security Suite. I now run it
along with my other security software, seems to work very well (Click here to read an
extensive review of this program). This setup of contains the free as well as the
plus-version ($29.95) of the ewido security suite. After the installation, a free 14-day
test version containing all the extensions of the plus-version will be activated. At the
end of the test phase, the extensions of the plus version are deactivated and the
freeware version can be used unlimited times. The purchased license code of the plus
version can be entered at any time. The free version does not provide the realtime
protection or automatic updates although you can certainly update manually and
conduct periodic scans with the remaining free version. 

Cookies 

A cookie is a small amount of information stored on your computer by a Web site
that you have visited. The cookie typically includes information that your Web browser
sends back to the site whenever you visit it again such as your password for the site or
a customized view of the site that you have chosen. The reason that cookies are
designed and planted on your computer is so that your browsing experience is more
personal and simplified. For instance, cookies will help you bypass a site’s password
logon procedures because your password is simply entered from within your cookie.
Then, you might receive a hearty and personalized welcome message. More intricate
cookies keep track of the type of links you follow within a site, how much time you
spend there, and what you do there (e.g., download a file) so that the site owners may
begin to develop a profile for you that allows them to target new information that your
profile indicates would probably be of interest to you. 

http://home.wi.rr.com/erikdial/
http://www.anti-trojan-software-reviews.com/review-ewido.htm
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Some less-than-reputable sites use cookies to determine your originating e-mail
address which they will use to send you unsolicited e-mails in the form of
advertisements. Such online behavior is usually experienced as a violation and is an
example of the dark side of cookie use. Consequently, cookies are the focus of debate
among those who view them as a service or “the cost of doing business” and those who
passionately protect their privacy and civil liberties. 

In general though, cookies are common and usually harmless. They can’t be
used to take information about you or your computer that you have not provided
(again, another reason to be very careful what you kind of information you give up at a
site). But they can be used by certain services to create a profile of your interests based
on the sites you visit. Then information on participating sites can be customized for you
which can certainly be a time-saver.

Browsers such as Firefox or Internet Explorer (IE) can help you better control
cookies by alerting you whenever a server tries to give you a cookie. In Internet
Explorer:

1. Choose Tools, then
2. Internet Options.
3. Click the Privacy tab,
4. Default setting is medium. Move the slider to determine which setting you prefer.
5. You can also click on Advanced for specialized cookie treatment.
 
If you use Firefox, click here to learn more about the cookie manager. To delete cookies
from your system, simply find them on your computer, usually in a folder called
“Cookies” and delete them. Or, in IE, click on [Tools], then [Internet Options], then
[Delete Cookies]. At least a couple of drawbacks exist to denying or deleting cookies,
however. One problem is that cookies are so prevalent that you may be constantly
dealing with cookie alerts which will seriously inhibit you from timely and enjoyable web
surfing. Also, a site may not allow you to download valuable and free utilities and
updates without first accepting their cookie. For instance, if you want to download some
utilities from Microsoft, and you have set up your browser to not accept cookies, the
company’s site will detect this and stop you from continuing. A message will appear on
your screen that alerts you to this situation and instructs you to turn cookies back on if
you still want to pursue your download.

http://www.mozilla.org/projects/security/pki/psm/help_21/using_priv_help.html
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ActiveX

Even if you do not intentionally download software from a Web site, elements of
a site may download, run on your computer, and pose a potential security risk such as
by unleashing a virus onto your system. For example, ActiveX technologies allow
software to be distributed over the Internet. You’ll encounter ActiveX in the form of
controls, usually graphic items such as scrolling marquees, on Web sites. Think of them
as small programs within the site that run on your computer. An ActiveX control is like a
plug-in, but worse. It doesn’t require any installation (so users will use them without
thinking twice), leaves no trace afterwards, and gives the illusion of extra security. A
famous example of a malicious ActiveX control occurred in early 1997 when a group of
computer experts demonstrated to the German press how to use the personal financial
software product Quicken to transfer money from your bank account to theirs while
innocently browsing their Web site. Similar to ActiveX are VB or Visual Basic files
(ending in .vb). 

You should not allow ActiveX objects to run in IE when you are browsing the web. The
default settings for Internet Explorer are set up to prompt or alert you when an ActiveX
script is trying to install itself. You can double check this by clicking on the 'Tools' menu,
click 'Internet Options', and select the 'Security' tab. Select 'Internet' zone and click the
'Custom Level' button. Disable every ActiveX-related setting (unless you have a good
reason to leave one enabled). 'OK' your changes.

Other Things You Can Do to Reduce Your Risk ...

1. Don't fall victim to virus hoaxes. These hoaxes spread needless alarm and
may even tell you to delete perfectly legitimate files. Visit the Hoax
Encyclopedia before forwarding on those dire sounding emails warning of
non-existent viruses. To get the true scoop on other falsehoods traveling via
e-mail, make Urban Legends and Folklore a regular Internet pit stop.

2. E-mail attachments. Don’t open any e-mail attachments that you are not sure
about, even if it looks like it came from a friend. Your friend could have a
virus that sends e-mail  from her account to everyone in her address book. If
you have any doubts about the attachment, delete the e-mail and check with
your friend. Also, take a very close look at the name of the attached file,
especially the last three characters (known as the file extension). If the file
extension is one of the following, it usually means that clicking on the file
will run a program file, which is what viruses are: 

http://antivirus.about.com/od/emailhoaxes/l/blenhoax.htm
http://antivirus.about.com/od/emailhoaxes/l/blenhoax.htm
http://www.snopes.com/
http://urbanlegends.about.com/
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.exe

.bat

.pif

.vbs

.scr

.com

Another interesting clue is to see if there are two file extensions, such as this example
of a Microsoft Word™ File that has been changed into a virus file (note the two periods
and two file extensions):  AnnualReport.doc.pif 

3. Watch out for IM viruses. Like e-mail viruses, instant message viruses are
malicious or annoying programs that are designed to travel through IM. In
most cases these viruses are spread when a person opens an infected file
that was sent in an instant message that appeared to come from a friend.
Click here to learn more.

4. Update your Windows software. Visit Microsoft Update to scan your
computer and install any high-priority updates that are offered to you. If you
have Automatic Updates enabled, the updates are delivered to you when they
are released, but you have to make sure you install them. For more
information, visit the Protect Your PC site.

5. Check out RoadRunner’s security page for lots more, and download this free
checklist.

____________________________________________

TIPS AND TRICKS

Microsoft Office Excel™: Spell Checking 
If you run Spell Check in MS Excel, it only checks the current worksheet not the entire
workbook. To check the whole thing at once, select all worksheets before you run the Spell
Check. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Yahoo!: iPod Video feeds
This Yahoo blog entry offers a tool for generating Yahoo Video RSS feeds. They also show you
how to enter these URLs on iTunes and get fresh content on your 'pods.
http://www.ysearchblog.com/archives/000202.html

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.microsoft.com/athome/security/viruses/imvirus.mspx
http://go.microsoft.com/?linkid=3646728
http://www.rrsecurity-abuse.com/index.html
http://www.webtech.on.ca/WebtechAntiVirusChecklist.pdf
http://www.schoolcounselor.com
http://www.ysearchblog.com/archives/000202.html
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Renaming a File
You can always right-click a file and choose rename which will open the icon’s text section and
allow you to begin renaming. Perhaps a quicker way to do this (it’s close) is to highlight the file
icon (left click once) and press F2. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Formatting Keyboard Shortcuts

Use shortcut keys to apply formatting. Knowing the shortcut keys for common Word tasks can
save you a lot of time. Here are the most common:

Format (keyboard shortcut)

Bold (Control B)
Italic (Control I)
Underline (Control U)
Double underline (Control Shift D)
Change case of letters (Shift F3)
All capitals (Control Shift A)
Small Capitals (Control Shift K)

Subscript (Control =)
Superscript (Control Shift = )
Remove formats (Control Spacebar)
Next larger size (Control >)
Next smaller size (Control <)
Up one point (Control ] )
Down one point (Control [)

Here is a nice one page PDF file that you can print and refer to as you need it for Microsoft
Word 2003. For Macintosh folks, here is a 26 page one that seems to work very nicely.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Replacing Text
excerpted from Sams Teach Yourself Microsoft Office Word 2003 in 24 Hours By Heidi Steele

Sometimes you not only need to find text, but you also have to replace it with something
else. Word’s Replace feature takes the tedium out of making the same change in several
places.

http://www.its.qut.edu.au/assist/userguides/exfiles/word.pdf
http://connectsupport.wsu.edu/Entourage%20Keyboard%20Shortcuts.pdf
http://www.amazon.com/exec/obidos/ASIN/B0006I0I44/schoolcounselorc
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1. Choose Edit, Replace (or press Ctrl+H) to display the Replace tab of the Find and Replace
dialog box.
2. Type the text that you want to find in the Find What text box. 
3. In the Replace With text box, type the text that you want to replace the Find What text. If
you like, you can customize your find and replace operation by clicking the More button and
then using the options in the expanded version of the Find and Replace dialog box (refer to
Figure 12.7). 
4. Click the Find Next button. 
5. Word highlights the first occurrence of the word. To replace it, click the Replace button. 
6. To skip this instance without making the change, click the Find Next button. 
7. Continue this process. If you don’t need to confirm every replacement, click the Replace All
button. 
8. Click OK when Word informs you that it has found all the matches. 
9. Click the Close button in the Find and Replace dialog box. 

If you change your mind about a replace operation after completing it, you can click the Undo
button in the Standard toolbar to undo the replacements one by one if you used the Replace
button, or all at once if you used the Replace All button.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What does a TagCloud look like?
It's a list of keywords taken from the news feeds you specify. Larger fonts indicate a higher
prevalence for an individual keyword. Using Cascading Style Sheets, you can customize almost
every aspect of your TagClouds to make it match your website. Of course, we provide a nice
default set of styles out of the box. Learn more >>>
http://www.tagcloud.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Change Case

1. Highlight the text you want to change and select "Format" - "Change Case".
2. A "Change Case" dialog box will appear. Choose from the following options:
* Sentence case
* lowercase
* UPPERCASE
* Title Case
* tOGGLE cASE

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.tagcloud.com/
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Microsoft PowerPoint: Change a Particular Font
Source: http://malektips.com/powerpoint_2003_0002.html 

After designing a PowerPoint 2003 presentation, have you decided that Arial was not
quite right and Verdana would look better, or that you would rather replace a sans-serif font
with a serif font to make it easier to read? If so, you can replace all uses of one font in an
entire PowerPoint 2003 presentation with another. Note that this only changes text boxes;
graphics containing text using a particular font will not be changed.

1. Click "Format" - "Replace Fonts".
2. A "Replace Fonts" dialog box appears. 
3. Underneath "Replace", select the font that should be replaced with another.
4. Underneath "With", select the new desired font.
5. Click the "Replace" button. 
6. Repeat steps 3-6 as desired if you want to replace multiple fonts.
7. When done, click "Close" to close the dialog box.

You can press CONTROL-Z to undo your changes, if desired. Also note that after changing
fonts, you should look over each slide and ensure the different character sizes of the new font
do not alter the layouts. 
____________________________________________

WORTHY WEBSITES AND SOFTWARE

Cyberbullying: Not Just Name-Calling
Harassment and humiliation take on new forms in Cyberspace. Learn about the consequences,
actions and reactions of using cell phones, the Internet and other digital devices to bully ones
peers. Teacher Guide included!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

G News Central Podcast
Your source for the latest mental health stories pulled from the Internet.
http://gnewscentral.libsyn.com/ 

Relatedly, Liberated Syndication is a premiere media distribution service built from the
ground up with DIY content creators in mind. Libsyn is the first full featured provider tailored
specifically for all-media self-publishing and Podcasting with pricing models that make sense for
this new generation of content creators.
http://www.libsyn.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://malektips.com/powerpoint_2003_0002.html
http://www.powertolearn.com/internet_smarts/interactive_case_studies/index.shtml#cyberbully
http://gnewscentral.libsyn.com/
http://www.libsyn.com/
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1-800-FREE411
1-800-FREE411 was created to provide callers with a free alternative to the skyrocketing rates
being charged by phone companies for directory assistance (411). The service is made possible
by thousands of national and local businesses who sponsor this service with brief valuable
audio advertisements that are played to callers who request businesses  in their yellow pages
category.  This advertising model allows businesses to acquire new customers over the phone,
cost effectively, with little or no risk.  Meanwhile callers get free directory assistance, potentially
saving each of them thousand of dollars per year. 
http://www.free411.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Fool's Gold: A Critical Look at Computers in Childhood
From the Alliance for Childhood,  a report that examines the real costs of computers; billions of
dollars at the expense of key educational programs and the pressing needs of low-income
children, as well as serious risks to children's physical, emotional and intellectual development.

Also check out Tech Tonic - a document from the Alliance that proposes a new definition of
technology literacy as “the mature capacity to participate creatively, critically, and responsibly in
making technological choices that serve democracy, ecological sustainability, and a just
society.”

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google's Scholar
Google's Scholar site takes research to a new level. Just enter your search term to get a list of
relevant articles. For each search result, you have a number of options. Find references to the
article on the Web or in other academic texts.
http://scholar.google.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

InquisitorX 
Here is a new search engine that gives results as you type, without your having to hit the enter
key on your keyboard. Start typing out your search query. As you type  you'll get suggestions
for additional searches and  three results of a Web search (which is the big  weakness with this
engine as I see it; only THREE  results?) and links at the bottom of the results for search
results on other pages.
http://www.inquisitorx.com/beta/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.free411.com
http://www.allianceforchildhood.org/projects/computers/computers_reports.htm
http://www.allianceforchildhood.org/projects/computers/pdf_files/tech_tonic.pdf
http://scholar.google.com/
http://www.inquisitorx.com/beta/
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SparkTop.org Teacher Resource Center
SparkTop.org, a new Schwab Learning resource designed for teachers of students ages 8-12
with learning difficulties, offers tools and ideas for educators to help children build their
self-esteem. Under the "Light the Spark!" and "Show Your Spark!" sections, which encourage
students to think about and share their own personal strengths, the site offers free downloads.
Other activities focus on developing leadership and problem-solving skills in a supportive
environment. The site also offers useful links on such topics as test-taking strategies and
adapting a classroom to fit the needs of students with learning disabilities, plus a free
newsletter and more. For more information, visit the link below.
http://www.sparktop.org 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Study Guides and Strategies
The Study Guides and Strategies web site is authored, developed and maintained by Joe
Landsberger as an educational public service. These student guides are collaboratively
maintained across institutional and national boundaries, and last revised August 15, 2005 .
Permission is granted to freely copy, adapt, and distribute individual Study Guides in print
format in non-commercial educational settings that benefit learners. No request to link to the
Web site is necessary.  Please be aware that the Guides welcome, and are under, continuous
review and revision. For that reason, reproduction of all content on the Internet can only be
with permission through a licensed agreement. 
http://www.studygs.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

enGauge® 21st Century Skills: Literacy in the Digital Age
The enGauge 21st Century Skills go a step further. Advances in the cognitive sciences show
that learning increases significantly when students are engaged in academic study through
authentic, real-world experiences. The enGauge 21st Century Skills build on extensive bodies of
research—as well as calls from government, business, and industry for higher levels of
workplace readiness—to define clearly what students need in order to thrive in today’s Digital
Age.
http://www.ncrel.org/engauge/skills/skills.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Java-Based Timer
Java-based timer for timing tests or other activities. Use right away as no download needed! 
http://html_help4u.tripod.com/javatime.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.sparktop.org
http://www.studygs.net/
http://www.ncrel.org/engauge/skills/skills.htm
http://html_help4u.tripod.com/javatime.html
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EclipseCrossword
EclipseCrossword is the fast, easy, free way to create crossword puzzles in minutes.
EclipseCrossword is for Windows 95, 98, ME, 2000, and XP. It will not run on Macintosh
computers. If you have to enter a password to use your computer (i.e. at work or at school),
you may not be able to complete the installation without permission from your organization's
network administrator.  EclipseCrossword is free. It contains no advertisements, spyware, or
viruses.
____________________________________________

JUST FOR FUN

Toogle
Toogle describes itself as "The most comprehensive image buggery on the web." Enter a word
or phrase and you'll get a text picture of the first result for that search. These are fun to play
with, but a word of warning – neither one of these image tools appears to use filtered search.
http://www.c6.org/toogle/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Orisinal
In these adorable and (mostly) benevolent Web games, you can bounce stars off bubbles, help
a panda romp through a bamboo forest, save a runaway train (and yourself) from destruction,
photograph UFOs, serenade a sweetheart while avoiding neighbors you've awakened, save
ships from icebergs or dragons, and a try host of other mindless yet thoroughly enjoyable
activities (Source: PC Mag)
http://www.ferryhalim.com/orisinal/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Museum of Modern Art: Send an e-card
Images of many of the objects in the collection may also be sent as e-cards. To find them,
search the online collection and click the Send as e-card link in the single-object view. You may
also view an artist index of collection e-cards.
http://www.moma.org/ecards/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Bungee Whiz
This video is a hoax although incredible to watch nonetheless. It turns out that the video is
really a beer commercial from Australia. The video is making the Internet rounds, so someone
may send it to you soon. But you can watch the video now and read an explanation at:

http://www.c6.org/toogle/
http://www.pcmag.com/article2/0,1895,1783192,00.asp
http://www.ferryhalim.com/orisinal/
http://www.moma.org/ecards/
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http://www.snopes.com/photos/advertisements/bungee.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What is a puggle?
http://www.dogbreedinfo.com/puggle.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Zeitgeist
The Google Zeitgeist page is regularly updated to reflect tidbits of information related to the
search behavior of Google users. 
http://www.google.com/press/zeitgeist.html 

____________________________________________

http://www.snopes.com/photos/advertisements/bungee.asp
http://www.dogbreedinfo.com/puggle.htm
http://www.google.com/press/zeitgeist.html
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SchoolCounselor.com eNew Issue #51 - Nov. 25, 2005

Kids don't go out and buy CDs, they make their own, they download
them from the Internet. 
Sebastian Bach

Some say Google is God. Others say Google is Satan. But if they think
Google is too powerful, remember that with search engines unlike other
companies, all it takes is a single click to go to another search engine. 
Sergey Brin (co-founder)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Security Overview Part 4: Phishing

Sources: 

• Help prevent identity theft from phishing scams: What is a phishing scam?
Published: February 10, 2005.

• Antiphishing Work Group
• Federal Trade Commission: How Not to Get Hooked by a ‘ Phishing’ Scam

Phishing is a type of deception designed to steal your identity. In phishing scams, scam
artists try to get you to disclose valuable personal data—like credit card numbers, passwords,
account data, or other information—by convincing you to provide it under false pretenses.
Phishing schemes can be carried out in person or over the phone, and are delivered online
through spam e-mail or pop-up windows. A phishing scam sent by e-mail may start with con
artists who send millions of e-mail messages that appear to come from popular Web sites or
sites that you trust, like your bank or credit card company. The e-mail messages, pop-up
windows, and the Web sites they link to appear official enough that they deceive many people
into believing that they are legitimate. Unsuspecting people too often respond to these requests
for their credit card numbers, passwords, account information, or other personal data.

What does a phishing scam look like? As scam artists become more sophisticated, so do
their phishing e-mail messages and pop-up windows. They often include official-looking logos
from real organizations and other identifying information taken directly from legitimate Web
sites. To make these phishing e-mail messages look even more legitimate, the scam artists may
place a link in them that appears to go to the legitimate Web site, but it actually (1), takes you
to a phony scam site or (2) possibly a pop-up window that looks exactly like the official site.
These copycat sites are also called "spoofed" Web sites. Once you're at one of these spoofed
sites, you might unwittingly send personal information to the con artists. They then often use

http://www.microsoft.com/athome/security/email/phishing.mspx
http://www.microsoft.com/athome/security/email/phishing.mspx
http://www.antiphishing.org/consumer_recs.html
http://www.ftc.gov/bcp/conline/pubs/alerts/phishingalrt.htm
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your information to purchase goods, apply for a new credit card, or otherwise steal your
identity.

Just as in the physical world, con artists will continue to develop new and more
sophisticated ways to trick you online. The following are just a few phrases to watch for if you
think an e-mail message is a phishing scam. Don't forget to trust your instincts. If an e-mail
message looks suspicious, that probably means that it is.

• "Verify your account." Businesses should not ask you to send passwords,
login names, Social Security numbers, or other personal information through
e-mail. Be suspicious of a message that asks for personal information even if
the request looks legitimate.

• "If you don't respond within 48 hours, your account will be closed." Phishing
e-mail may be polite and accommodating in tone, but these messages often
convey a sense of urgency so that you'll respond immediately without
thinking. Phishing e-mail may threaten to close or suspend your account or
may even say your response is required because your account may have been
compromised.

• "Dear Valued Customer." Phishing e-mail messages are usually sent out in
bulk and do not contain your first or last name. Although, it is possible that
con artists have this information. Most legitimate companies (but not all)
should address you by first and last name.

• "Click the link below to gain access to your account." HTML-formatted
messages can contain links or forms that you can fill out just as you'd fill out
a form on a Web site. The links that you are urged to click may contain all or
part of a real company's name and are usually "masked," meaning that the
link you see does not take you to that address but somewhere different,
usually a phony Web site. Notice in the following example that resting the
mouse pointer on the link reveals the real Web address, as shown in the box
with the yellow background. The string of cryptic numbers looks nothing like
the company's Web address, which is a suspicious sign.

 
Another common technique that con artists use is a Uniform Resource Locator (URL or

website address) that at first glance appears to be the name of a well-known company but is
slightly altered by intentionally adding, omitting, or transposing letters. For example, the URL
"www.microsoft.com" could appear instead as:

www.micosoft.com
www.mircosoft.com
www.verify-microsoft.com
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How to Reduce Your Risk

Here are some practical tips:

• Be wary of clicking on links in e-mail messages. Links in phishing e-mail
messages often take you directly to phony sites where you could unwittingly
transmit personal or financial information to con artists. Avoid clicking on a
link in an e-mail message unless you are sure of the destination. Even if the
address bar displays the correct Web address, don't risk being fooled. 

• Instead of clicking on a link inside an e-mail address, type addresses directly
into your browser or use your personal bookmarks. If you need to update
your account information or change your password, visit the Web site by
using your personal bookmark or by typing the URL directly into your
browser.

• Check the security certificate when you are entering personal or financial
information into a Web site. Before you enter personal or financial
information into a Web site, make sure the site is secure. In Internet
Explorer, you can do this by checking the yellow lock icon on the status bar
(bottom right). In Firefox, you will see this same lock at the end of the
address. The closed lock icon signifies that the Web site uses encryption to
help protect any sensitive, personal information that you enter, such as your
credit card number, Social Security number, or payment details. It's
important to note that this symbol doesn't need to appear on every page of a
site, only on those pages that request personal information. Unfortunately,
even the lock symbol can be faked. To help increase your safety, double-click
the lock icon to display the security certificate for the site. The name
following “Issued to” should match the name of the site. If the name differs,
you may be on a fake site, also called a "spoofed" site. If you're not sure
whether a certificate is legitimate, don't enter any personal information. Play
it safe and leave.

• Don't enter personal or financial information into pop-up windows. One
common phishing technique is to launch a fake pop-up window when
someone clicks on a link in a phishing e-mail message. To make the pop-up
window look more convincing, it may be displayed over a window you trust.
Even if the pop-up window looks official or claims to be secure, you should
avoid entering sensitive information, because there is no way to check the
security certificate. Close pop-up windows by clicking on the red X in the top
right corner (a "cancel" button may not work as you'd expect).

• Do update your computer software. Software developers continue to make
improvements to their software to help protect your computer.

• Check out EarthLink ScamBlocker which is part of a free browser toolbar that
alerts you before you visit a page that's on Earthlink's list of known
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fraudulent phisher Web sites. Its free to all Internet users - download at
http://www.earthlink.net/software/nmfree/ 

Note: If you suspect that you've already responded to a phishing scam with personal or
financial information or entered this information into a fake Web site, there may be ways you
can minimize any damage. Click here for more. 

______________________________
______________

Tips and Tricks

Use Google as a Dictionary
To see a definition for a word or phrase, simply type the word "define," then a space, and then
the word(s) you want defined. If Google has seen a definition for the word or phrase on the
Web, it will retrieve that information and display it at the top of your search results. Try this
one.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Wrap Text Around a Picture
1.   Select the picture you inserted into the document.  
2.   Go to the Format menu, and select Picture.  
3.   Select the Wrapping (or Layout) tab in the Format Picture window.  
4.   Select one of the five Wrapping Style choices.  
5.   Select one of the four "Wrap to" (or alignment) choices if you want, or leave this
unselected.  
6.   Select the Distance From Text in inches to set the amount of space between the text and
the graphic (top, bottom, left, right). (You may need to click the Advanced button to set this
option.)  
7.   Click OK to set these parameters.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FeedReaders
You are probably starting to see the little orange "XML" or "RSS" icons on websites everywhere.
These icons are for people using a new class of software called a FeedReader. If you haven't
discovered the joys of using a FeedReader, you will quickly come to love it. They are cheap or
free to get, take just a few minutes to set up, and will allow you to monitor your favorite
websites in a couple of minutes per week. Check out the complete article for details on how to
use a FeedReader.
http://www.mrexcel.com/tip108.shtml 

http://www.earthlink.net/earthlinktoolbar
http://www.earthlink.net/software/nmfree/
http://www.microsoft.com/athome/security/email/phishingrespond.mspx
http://www.google.com/search?q=define+%22school+counselor%22
http://www.mrexcel.com/tip108.shtml
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Photo & Video Clinic
Whether you're a novice who's just picked up your first digital camera or someone who's been
shooting for a few years, there are always new tricks to learn to get the most out your gear for
the holidays--and beyond. In these specially designed online courses, our experts will teach you
everything from camera and camcorder basics to editing your shots for holiday cards, to
sharing and storing images online. Best of all, you can learn right from your computer. (Free
website registration required).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Enlarging your mouse pointer in Windows
Many people have difficulty seeing the mouse pointer. The pointer takes several different forms
depending on where it is on the screen. Most often it appears as a small white arrow with a
black outline. Over a white background this is simply a black outline. In some cases it is even
less easy to see. For example, over any area where you can type it turns into a slender I-beam.
This module shows you how to increase the size of your mouse pointer so that it will be easier
to see under all conditions.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Reducing the Size of Your PowerPoint Presentations

PowerPoint presentations can become very large when you are inserting images into the slides.
One option you have to get around this problem is to manually convert all the graphics to a
more compressed file type such as a JPG. An even easier method is to have PowerPoint take
care of this for you. Once you have your presentation open, click View, point to Toolbars, and
place a check beside Pictures. The Picture toolbar will appear in your presentation. On this
toolbar there is a button called Compress Pictures. If you click on this button, the Compress
Pictures dialog box will appear. 

Under the Apply to section, you can select which pictures you want to compress. You can
compress selected pictures or you can compress all pictures in the presentation. You can also
change the resolution of the pictures. The resolution for Web/Screen is 96dpi and 200 dpi for
the Print option. You can also have the cropped areas of pictured deleted (in case you didn't
know, the cropped area of pictures is usually just hidden, not deleted). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.cnet.com/4520-11484_1-6365898-1.html?tag=nl.e404
http://www.abilitynet.org.uk/myway/keyboard/mouse/intro-enlarge-mouse.htm
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Sort Your Slides in PowerPoint 2002

PowerPoint 2002 gives you the ability to reorganize the slides in a presentation. This is not a
new feature as it was also included in previous versions. In most cases, you could reorganize
your slides by selecting the Slide Sorter option from the View menu.

PowerPoint 2002 has enhanced the slide sorter feature to make it a little simpler to reorganize
and reorder your slides. Once your presentation is open, click View and select Normal. Your
slides will appear as thumbnails in a list on the left side of the window. You can display any
slide in a larger view by clicking on the appropriate thumbnail. If you want to quickly change
the order of the slides, simply click a thumbnail, drag it, and drop it where you want the slide
located in the list of thumbnails. 

SchoolCounselor.com 2.0: A Friendly and Practical Guide to the World Wide Web 
by Russell A. Sabella, Ph.D.
The Internet gives counselors a vast amount of resources and a powerful medium for
connecting with others. Following a counselor-friendly introduction to computers and the
World Wide Web, readers are introduced to over 1,200 web sites and given a practical guide
to gaining access, navigating, searching for relevant materials, and creating websites.
Related issues of interest to both novice and experienced users are discussed.
ISBN 1-930572-24-7 
8-1/2 x 11, 240 pages, soft bound 

____________________________________________

Worthy Websites and Software

Become 
Become isn't just a comparative shopping site. It promises to guide you every step of the way
during your shopping experience, offering research resources and links to useful sites directly
related to what you want to purchase. 
http://www.become.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Family Watchdog
Family Watchdog will show you if there are offenders in your area. Just enter your address in
the search box. You'll get a map showing where the offenders are.
http://www.familywatchdog.us/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=SCC2
http://www.become.com/
http://www.familywatchdog.us/
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Indezine: Free PPT Templates
You'll find free PowerPoint templates and backgrounds here - to use them as you like in your
personal presentations.
http://www.indezine.com/powerpoint/templates/freetemplates.html 

Also see free backgrounds ...

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Patrick Crispen's PowerPoint Files: The Complete List 
Tons of great technology topics and tutorials, very convenient!
http://www.netsquirrel.com/powerpoint/complete.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Base
Google Base is a place where you can easily submit all types of online and offline content that
Google will host and make searchable online. You can describe any item you post with
attributes, which will help people find it when they search Google Base. In fact, based on the
relevance of your items, they may also be included in the main Google search index and other
Google products like Froogle, Google Base and Google Local. 
http://base.google.com/base/default 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

iSerenity
Ambient sound environments at your desktop for relaxation and solitude. 31 sound and image
environments to choose from, and counting. 
http://www.iserenity.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Leet Speek and Children’s Computer Slang
source (www.komando.com)
Children today often use abbreviations online or in text messages. They also use leet, a
"language" that uses misspellings and replaces letters with characters and numbers. If you see
things that you don't understand in your child's messages, you should investigate. The Internet
Slang Dictionary and Translator makes it easy. You can copy and paste text to translate it. Or
you can browse the dictionary. I should warn you that the slang can be vulgar.
http://www.noslang.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.indezine.com/powerpoint/templates/freetemplates.html
http://www.indezine.com/powerpoint/templates/freetemplates.html
http://www.indezine.com/powerpoint/backgrounds/freebackgrounds.html
http://www.netsquirrel.com/powerpoint/complete.html
http://base.google.com/base/default
http://www.iserenity.com/
http://www.komando.com
http://www.noslang.com/
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What are School Counselors Doing w ith Technology? The results of a quick e-mail
survey sent out to readers of the SchoolCounselor.com Newsletter are now available. Download
a document with over 50 responses replete with creative and innovative uses of technology in
school counseling! http://tinyurl.com/dgfjd 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Teacher's Guide to International Collaboration
The Teacher's Guide to International Collaboration was developed to help teachers use the
Internet to "reach out" globally. These materials were prepared as part of the Department of
Education's International Education Initiative.
http://www.ed.gov/teachers/how/tech/international/index.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Free Dictionary
Providing innovative, easy-to-use reference and learning tools. Ton of reference tools. 
http://www.thefreedictionary.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Weather Watcher
Weather Watcher is your (free) personal Windows desktop weather station. Automatically
retrieve the current conditions, hourly forecast, daily forecast, detailed forecast, severe weather
alerts, and weather maps for over 77,000 cities world-wide. The current conditions can be
quickly viewed by holding your mouse pointer over the Weather Watcher system tray icon.
http://www.singerscreations.com/AboutWeatherWatcher.asp 

____________________________________________

Just for Fun

Putfile 
Putfile is a FREE dedicated digital media hosting service. Here you can upload videos and
images to the internet for free. Your media will be hosted on our reliable servers offering zero
downtime. Go directly to their top rated videos ...
http://www.putfile.com/topvideos 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.schoolcounselor.com/counseling-tech-survey.htm
http://tinyurl.com/dgfjd
http://www.logmein.com
http://www.ed.gov/teachers/how/tech/international/index.html
http://www.thefreedictionary.com/
http://www.singerscreations.com/AboutWeatherWatcher.asp
http://www.putfile.com/topvideos
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Museum of Bad Album Covers
http://www.zonicweb.net/badalbmcvrs/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

60 Optical Illusions & Visual Phenomena
These pages demonstrate visual phenomena, called »optical illusions« or »visual illusions«. The
latter is more appropriate, because most effects have their basis in the visual pathway, not in
the optics of the eye. 
http://www.michaelbach.de/ot/index.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Who Would Buy That?
From the site: How often have you found an online auction item that was so hideous you
couldn't help but ask, "Who would buy that?" We have. A lot. So much so, in fact, that we
couldn't keep our good fortune to ourselves. 
http://www.whowouldbuythat.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free Trees and Plants
Free Trees and Plants "rescues" unsold plants. Then they're offered to you for free -- you only
pay postage and handling.
http://www.freetreesandplants.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Watch Your Computer Think
This is an online game of computer chess with a difference.  While the computer is thinking it
shows in graphic form the various moves it is considering. Quite fascinating for anyone who
plays chess.
http://turbulence.org/spotlight/thinking/chess.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

National Forest Fall Foliage Hotspots
Take in the Fall colors (from where I live, this is lots of fun).
http://www.fs.fed.us/news/fallcolors/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.zonicweb.net/badalbmcvrs/
http://www.michaelbach.de/ot/index.html
http://www.whowouldbuythat.com/
http://www.freetreesandplants.com/
http://turbulence.org/spotlight/thinking/chess.html
http://www.fs.fed.us/news/fallcolors/
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PopCap 
From the website: Here at PopCap our goal is to create simple but deep games that literally
everyone can enjoy! You can play all our web games instantly right in your browser... or quickly
download the Deluxe versions in just a few minutes, even with a slow modem connection.
http://www.popcap.com/ 
____________________________________________

http://www.popcap.com/
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SchoolCounselor.com eNewsletter #52 - Dec. 13, 2005

RAM disk is not an installation procedure.  ~Author Unknown

The Internet is the world's largest library.  It's just that all the books are
on the floor.  ~John Allen Paulos

Give a person a fish and you feed them for a day; teach that person to
use the Internet and they won't bother you for weeks.  ~Author Unknown

____________________________________________

Security Overview Part 5: Anti-Spam

Sources:
Spam Abuse Network: http://spam.abuse.net/ 
SpamCon Foundation: http://law.spamcon.org/ 
E-mail Addresses: http://www.emailaddresses.com/email_nospam.htm 

Spam is flooding the Internet with many copies of the same message, in an attempt to force
the message on people who would not otherwise choose to receive it. Most spam is commercial
advertising, often for dubious products, get-rich-quick schemes, or quasi-legal services. Spam
costs the sender very little to send -- most of the costs are paid for by the recipient or the
carriers rather than by the sender.

There are two main types of spam, and they have different effects on Internet users.
Cancellable Usenet spam is a single message sent to 20 or more Usenet newsgroups. (Through
long experience, Usenet users have found that any message posted to so many newsgroups is
often not relevant to most or all of them.) Usenet spam is aimed at "lurkers," people who read
newsgroups but rarely or never post and give their address away. Usenet spam robs users of
the utility of the newsgroups by overwhelming them with a barrage of advertising or other
irrelevant posts. Furthermore, Usenet spam subverts the ability of system administrators and
owners to manage the topics they accept on their systems.

E-mail spam targets individual users with direct mail messages. E-mail spam lists are often
created by scanning Usenet postings, stealing Internet mailing lists, or searching the Web for
addresses. E-mail spams typically cost users money out-of-pocket to receive. Many people -
anyone with measured phone service - read or receive their mail while the meter is running, so
to speak. Spam costs them additional money. On top of that, it costs money for ISPs and online
services to transmit spam, and these costs are transmitted directly to subscribers.

http://spam.abuse.net/
http://law.spamcon.org/
http://www.emailaddresses.com/email_nospam.htm
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One particularly nasty variant of e-mail spam is sending spam to mailing lists (public or private
e-mail discussion forums). Because many mailing lists limit activity to their subscribers,
spammers will use automated tools to subscribe to as many mailing lists as possible, so that
they can grab the lists of addresses, or use the mailing list as a direct target for their attacks. 

The main problem with spam is that it inundates our mailboxes and robs us of time and control
over our mail. At the very least it’s annoying, at best it negatively impacts our productivity and
drains our resources.  Also, there are now various laws that regulate and/or prohibit spam. For
instance, on January 1, 2004, the CAN-SPAM Act, went into effect in the US. This law puts
specific requirements on senders of commercial e-mail, including providing a valid physical
postal address, honoring unsubscribe requests within a specific time frame. The downside of
the law is that it pre-empts stronger state laws and places enforcement in the hands of the
FTC, state Attorney's General and ISPs. Check out other state and federal laws at
http://www.spamlaws.com/.

What You Can Do About Spam

There is a good chance that your school already has installed a spam filtering solution.
Following are other methods for reducing spam in case you have other e-mail accounts you
want to protect and/or you can practice in addition to the mechanisms already in place: 

Use Spam Filters. There is available an array of both hardware and software filters that will
help you to remove spam before it ends up in your inbox. For instance:

• Thunderbird e-mail client is a free program that comes with a built in
Junk or Spam filter. 

• Microsoft Outlook 2003 now comes with a Junk e-mail filter, read
more here. For Outlook express, click here. 

• SpamAssassin is generally regarded as one of the most effective spam
filters, especially when used in combination with spam databases.
Even simple text-matching alone may, for most users, be sufficient to
correctly classify a majority of incoming mail.

• Cloudmark spam and phishing solution. 
• Qurb has received PC Magazine's Editors' Choice Award three years

running (2003-2005), and also won their Best of 2003 award. 
• Spam Shield is an anti-spam product for Outlook and Outlook Express. 

Report Abuse. There are steps you can take to assist the US government with enforcing
existing laws that are broken by spammers. 

http://www.spamlaws.com/federal/108s877.html
http://www.spamlaws.com/
http://www.barracudanetworks.com/
http://www.mozilla.com/thunderbird/
http://www.microsoft.com/office/editions/prodinfo/junkmail.mspx
http://www.hiwaay.net/support/faq/index.cgi?view=1&id=95&catid=61
http://spamassassin.apache.org/downloads.cgi?update=200509141634
http://www.cloudmark.com/desktop/
http://www.qurb.com/
http://www.pcsecurityshield.com/webapp/90024.asp?trk=DTK&bid=108&aid=CD567&opt=CTgoog-best+free+spam+blocker#download
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• Spam that is fraudulent - offering products that don't work or don't exist,
pyramid schemes and so on - -  can be sent to the US Federal Trade
Commission at uce@ftc.gov. 

• Spam that promotes stocks can be sent to the U.S. Securities and Exchange
Commission at enforcement@sec.gov.. 

• Spam containing or advertising child pornography is illegal in most of the
world under existing law. In the US, you can report suspected criminal
activity to the Federal Bureau of Investigation via this form. You can also file
child-pornography-specific reports with the National Center for Missing and
Exploited Children here.

Also ...

• Just hit delete. If you're only getting a few spam messages a day, the best
solution is probably to just chill out and hit delete. Yes, it's annoying. And no,
it's not right. But it's just not worth the effort to banish spam unless it's
really impacting your ability to use e-mail effectively. 

• Don’t forward chain letters or other urban legends. 
• Before subscribing to a listserv or newsletter, check out the privacy policy. 
• Don't respond to spam. 
• Don't post your e-mail address in "plain" form anywhere on the Web.

Instead, you can disguise your e-mail address by writing it in a convoluted
way so that humans can still read it, but bots can't. For example, instead of
writing "russ@example.com", use "russ  AT example DOT com". 

• Keep a "private" e-mail address which you share only with close friends and
family. Never use this private e-mail address on any site. 

• Use a feedback form on your website instead of providing a contact e-mail
address. 

• DON'T follow "remove me" instructions. While reputable e-mailers will offer
you a way to get off their e-mail lists, spammers just use their "remove me"
instructions to validate your e-mail address as "live," thus paving the way for
even more spam. So, no matter how much spam annoys you, don't bother
responding -- it just makes the problem worse.

• Watch out for pre-checked boxes. When you buy things online, companies
sometimes pre-select check boxes to indicate that it's fine to sell or give your
e-mail address to responsible parties. Clear the check box if you don't want
to be contacted.

• Use the internal Rules or Junk e-mail filter provided by your e-mail software
to automatically delete or quarantine emails with certain words or phrases,
or from certain e-mail addresses, so that you don’t have to even become
aware of them. For example, to learn more about this feature in Microsoft

mailto:uce@ftc.gov
mailto:enforcement@sec.gov
https://www.ifccfbi.gov/complaint/terrorist.asp
https://web.cybertip.org/cyberTipII.html
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Outlook, click here. For your Yahoo! Mail account, go here. For Microsoft
Hotmail, check this page out. 

TIPS AND TRICKS

Most Word Processing Programs: Move Among Sentences and Pages Better
Next time you're using your arrow keys to go from one area of a sentence to another (left and
right arrows), hold down your CTRL key. Instead of moving one space at a time, you'll go one
word at a time. If you're using the up and down arrows to go from line to line, holding down
the CTRL key will make your cursor jump from paragraph to paragraph. Finally, if you hold
down the SHIFT key while you do this (i.e. hold down SHIFT + CTRL at the same time), you
select text as you arrow along. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: How do I get Word to stop helping me type? 
1. There are several places to look to turn off Word's various automatic

features: 
2. Choose AutoCorrect (or AutoCorrect Options) from the Tools menu, then click

on the AutoCorrect tab. 
3. Clear the check boxes for the AutoCorrect items that you want to disable. 
4. Do the same for the AutoFormat As You Type tab. 
5. On the AutoText tab, clear the Show AutoComplete tip check box. 
6. Choose Options from the Tools menu, then click on the tabs and clear any

check boxes for features that you want to disable. For example: 
7. Edit tab (Tabs and backspace set left indent). 
8. Spelling & Grammar tab (Check spelling as you type and Check grammar as

you type). When these features are on, spelling and grammar that Word does
not recognize are underlined with wavy red and green lines. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Renaming a File
There are three ways to do this:

1. Hold down the Alt key and double-click the file to open the Properties box. Type the new
name in the name box.
2. Click the file name once to highlight, click a second time to make it available to change, then
type in the new file name.
3. Right-click the file and choose Rename. This will highlight the file name allowing you to type
in a new one. (This is what I do, seems the easiest).

http://www.slipstick.com/rules/junkmail.htm
http://help.yahoo.com/help/us/mail/manage/manage-06.html
http://security.msn.com/articles/msmailprotect.armx
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Alphabetize icons in your start menu
Quickly and easily alphabetize the icons in programs on your start menu by right clicking within
programs on the start menu and clicking on "Sort by Name".

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™:  How do I change the default document font? 
You have a favorite font that you switch to with every new document? Quit it and make it the
default font: 

1. Choose Font from the Format menu, then set all of the attributes you want
for your default font. 

2. Click the Default button. 
3. Word will inform you that this change will affect all documents based on the

Normal template. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Outlook: Add Holidays to your Calendar

By default, Outlook does not display holidays on the calendar. Most people prefer having
holidays listed in their calendar for reminders, planning work schedules, deciding upon holidays,
and so on. If you want holidays listed, you can add country specific holidays to your calendar.

1. Open Outlook.
2. From the tools menu, click Options.
3. On the Preferences tab, click Calendar Options as shown in the figure.
4. Click Add Holidays.
5. Place a check beside the appropriate country/countries.
6. Click OK.
7. Click OK to close the Calendar Options dialog box.
8. Click OK to close the Options dialog box.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Point to Value Thresholds in a Cell
You can use conditional formatting to alert you to significant changes in cell values. For
example, in a worksheet that tracks students' grades, conditional formatting can draw attention
to quiz averages that have fallen below a passing grade of 60 percent. To apply conditional
formatting so average values below 60 percent are displayed in red, follow these steps:
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1. Select the cells you want to format.
2. Go to Format | Conditional Formatting.
3. Under Condition, choose Cell Value Is.
4. Select Less Than from the first drop-down list, and enter 60% in the text
5. Click Format and change the font color to red.
6. Click OK twice.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Gizmo Project
Gizmo Project uses your Internet connection (broadband or dial-up) to make calls to other
computers. With the click of a mouse, you’re connected to friends, family, and colleagues
anywhere on earth. It’s just that simple. You talk clearly. For as long as you want. For free.
http://www.gizmoproject.com/ 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Neevia Document Converter eXpress
Neevia Document Converter eXpress makes it possible for anyone to instantly convert their files
to PDF or Image without the need of installing special software.

There is a 1 MB file size limitation so make sure you do not upload files that are over this limit.
http://convert.neevia.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Writely
Writely is a free service that allows you to edit and publish documents online, either privately,
in collaboration with specific people, or publicly on the Internet. 
http://www.writely.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™ Calendar Template
2005-2006 school year calendar (monthly themes, July-July)
http://office.microsoft.com/en-us/templates/TC100072591033.aspx 

also, check out the 2006 photo calendar with graphics (12-pp) at
http://office.microsoft.com/en-us/templates/TC011752321033.aspx 

http://www.gizmoproject.com/
http://convert.neevia.com/
http://www.writely.com/
http://office.microsoft.com/en-us/templates/TC100072591033.aspx
http://office.microsoft.com/en-us/templates/TC011752321033.aspx
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

MailFrontier Field Guide to Fishing (PDF)
With the MailFrontier" Field Guide to Phishing", you ll find clear, concise explanations and visual
representations of sneaky, dangerous phish that may find their way to your computer. To help
you identify these nasty threats   and trust your other incoming mail   at the end of this field
guide are some suggestions on how you can protect yourself, as well as other phishing
resources for more information." This is a must-read!
http://www.mailfrontier.com/docs/field_guide.pdf 

Also see http://www.mailfrontier.com/docs/dont_take_the_bait.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

LearnOutLoud.com
LearnOutLoud.com provides audio and video learning. Browse over 9,000 educational audio
books, MP3 downloads, podcasts, and DVD videos. This link connects you to the free ones!
http://www.learnoutloud.com/free 
This link will take you directly to the self-development category:
http://www.learnoutloud.com/Free-Audio-Video/Self-Development 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

PC World Guide to Purchasing a Digital Camera
If you're searching for the perfect DIGITAL CAMERA gift, or maybe you want one for yourself,
this SUPER GUIDE will leave no question unanswered. Brought to you FREE thanks to
DURACELL. 
http://www.marketing.pcworld.com/duracell/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Hide the Annoying Office Assistant
From Degunking Microsoft Office, by Christina Palaia and Wayne Palaia [ISBN: 1-932111-95-6].
2005, Paraglyph Press. 
If you’re stuck with that whacky paper clip as an Office Assistant, you’ll want it to go away and
never come back—the thing is just creepy looking with its sly smirks and springy eyes. (You can
now choose between nine incarnations, from cheerful Dot to Mother Nature herself.) If you
think the animations prove distracting (as we do) and you’d rather use the Help menu when
you’ve got a question, you can easily hide the assistant. Just right-click it and choose Hide from
the context menu. If you get lonely and want your pal back, on the Help menu, choose Show
the Office Assistant.

http://www.mailfrontier.com/docs/field_guide.pdf
http://www.mailfrontier.com/docs/dont_take_the_bait.pdf
http://www.learnoutloud.com/free
http://www.learnoutloud.com/Free-Audio-Video/Self-Development
http://www.marketing.pcworld.com/duracell/
http://www.amazon.com/exec/obidos/ASIN/1932111840/schoolcounselorc/002-2179641-0489618
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Anatomy of Excel Data Analysis: Creating and modifying simple graphs.
Sometimes we take for granted what users know. While Microsoft Excel™ may be familiar to
you, if you are on a help desk you will have to explain how the application works to users that
fall within a vast range of skill level and knowledge. This series of Excel tutorials can make that
training much simpler. This installment of the series shows you how to create and use Excel's
built-in graphing functions.
http://techrepublic.com.com/i/tr/downloads/home/lowe_excel-graphs_1.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free Web Page Editors
I use Microsoft Frontpage 2003 to do my website development. This program is powerful,
relatively easy to use, and much cheaper than its competitors. However, you might want to
check out several free alternatives:

– Nvu (http://www.nvu.com)
- Amaya (http://www.w3.org/Amaya/)
- Selida (http://selida.camelon.nl/)

JUST FOR FUN

Blifaloo
Here you will find a ton of games, jokes, puzzles, free stuff, activities and interesting
information to temporarily relieve your boredom.
http://www.blifaloo.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

KCRW
An auditory feast featuring a cornucopia of eclectic sounds from bebop to baroque, served up
with compelling interviews and live performances from a dazzling array of artists from around
the world.
http://www.kcrw.com/music/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Games for the Brain
Play neverending quiz and memory games to train your thinking skills.
http://www.gamesforthebrain.com/ 

http://techrepublic.com.com/i/tr/downloads/home/lowe_excel-graphs_1.pdf
http://(http://www.nvu.com
http://(http://www.w3.org/Amaya/
http://(http://selida.camelon.nl/
http://www.nvu.com
http://www.blifaloo.com/
http://www.kcrw.com/music/
http://www.gamesforthebrain.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Ctrl-Alt-Delete
Curious about how Ctrl-Alt-Delete came into existence? Watch this 
short video, and don't miss Bill's reaction: 
http://www.bassfiles.net/ctl-alt-del.mov 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HP Activity Center
Fuel your creative side with hundreds of FREE print projects offered by HP.

Also from HP ... Create your family holiday card. Embellish holiday card templates with your
favorite family photos. HP Photosmart Essential makes it easy to create and share. Simply
drag-and-drop your favorite photos into these wonderful holiday cards. Share the joy of the
holidays with your loved ones.  
 
Additional templates or addins at
http://www.hp.com/united-states/pse/plugins.html 

http://www.bassfiles.net/ctl-alt-del.mov
http://h10025.www1.hp.com/ewfrf/wc/activityCenterHome?lc=en&cc=us
http://www.hp.com/united-states/pse/download.html?idl=&hp_customer_email_submit=Download+%BB
http://www.hp.com/united-states/pse/holiday_download.html
http://www.hp.com/united-states/pse/plugins.html
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SchoolCounselor.com eNewsletter #53 - January 8, 2006

The nice thing about standards is that there are so many to choose from.
- Andrew S. Tannenbaum 

Computers make it easier to do a lot of things, but most of the things
they make it easier to do don't need to be done.  - Andy Rooney 

2006 Calendars

As the new year rolls in, you might be thinking about how to make a
special 2006 counseling calendar. Here are several ways you might find useful (and fun).

First, make it easy on yourself and purchase one online. There are hundreds of themes to
choose from – some will make you laugh, others will inspire you. Afterwards, you can cut the
photos out, frame, and display them in your office. Check out the SchoolCounselor.com
calendar line developed especially for you at http://www.schoolcounselor.com/calendars.htm. 

Or, you might like to create your own personalized calendar with work-related or family photos.
Here are several ways you can do this:

1. First, download a Calendar template for Microsoft Word™, insert photos, print
on a color printer (perhaps using photo paper), and bind. You can download a
2006 calendar template here. Templates include academic years, school year,
mulit-year, and more; or

2. Use a software program (e.g., Custom Calendar Maker) to create just the
calendar you want. You may already have Microsoft Publisher™ which is
usually included in the MS Office suite. This program does an excellent job of
helping you create custom calendars. After you create your calendar, you can
upload it, have it professionally reproduced, and made available for purchase.
This would work well if you developed a calendar as a fund-raiser, for
instance. 

3. You can upload your photos and create a calendar online which will then be
professionally produced and available for purchase. I suggest you “Google”
the words “create calendar online” [without quotes] to find a variety of
services. You might also try an online publisher, several of which are listed in
this issue under Worthy Websites. 

Or, with Microsoft Outlook, you can easily print a calendar full of your appointments, meetings,
and events. But, did you know that you can also use Outlook to print a blank calendar? Blank
calendars may be useful to take notes on or to consult when meeting to discuss a project.

http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.schoolcounselor.com/calendars.htm
http://office.microsoft.com/en-us/templates/CT011653371033.aspx
http://www.asensoft.com/custom-calendar-maker.shtml
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1. On the File menu, point to New, and then click Folder. 
2. Type a name for the folder, such as Blank Calendar. 
3. In the Folder contains list, click Calendar Items. 
4. Under Select where to place the folder, click Calendar, and then click OK. 
5. In the Folder List, click the new folder. 
6. On the File menu, click Print, and then under Print style select the type of

calendar you want. 
7. Under Print range, select the start and end date, and then click OK. 

By the way, you might want to maintain more than one calendar such as one for yourself and
one for the public (e.g., Counseling Program Calendar) which you share with others
electronically. Microsoft Outlook 2003 gives you 3 different calendars to start with. Simply
choose one to make public, click on “Share My Calendar” in the Navigation pane (if you don’t
see the Navigation Pane, click on View and check this off).  Also know that Microsoft Outlook
makes it pretty easy to publish your Calendar to a webpage. To do this, just go to your
Calendar, click on File, and Save as Webpage. 

Finally, you can use a free online calendaring website service such as
http://www.calendars.net/. I have not used this particular one personally so I can’t recommend
it although it seems to get very good reviews from others. Note that it seems to include
advertising banners, no surprise. 

TIPS AND TRICKS

Microsoft Outlook™: Calendaring
Excerpted from “What are School Counselors Doing with Technology?” 

One of the most challenging aspects of the school counselor's role is maintaining interview logs
and keeping track of commitments. As an ASCA member, a secondary school counseling head
[and Vice-President: Communication for OSCA (Ontario School Counsellors' Assoc.)],  I decided
to tackle this issue. In 1996, I perused MS Outlook, the business scheduling and
contact-management software, included in MS Office.  I adapted it my counseling needs for
task-management, appointment-scheduling and interview/contact-management.  As the head
of a secondary school counseling department, I encouraged my dept-members to also use. 
Since then, we have been aggressively using this productivity vehicle.  Now, it is being by other
counselling departments in our school district.  I have been invited to demo it at provincial
conferences.  
 
This has dramatically improved our productivity, accountability, and professionalism.

1. When going to a case-conference, I have detailed contact-notes.

http://www.calendars.net/
http://www.schoolcounselor.com/counseling-tech-survey.htm
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2. When one of my counselors was subpoenaed, she was able to give the
attorney a copy of her interview notes [both in paper-based and disk-based].

3. When a Vice-Principal asks if I have seen a certain student, I can affirm the
date, time and length of the session.

4. When a counselor retired, her interview-notes were transferred via server to
the new counselor, thus allowing for continuity of service to the students.

5. The files are backed-up onto a counselor-protected sector of the school 
administrative server.

6. When a student enters my office, I have on-screen all the history of our
interactions [which they know... and makes THEM more accountable].

7. I can easily download my files onto my  memory-stick [as well as PDA].
8. All interactions about a said student [including emails from teachers and

Vice-Principals] are included in the contact-file.

This software appliance has significantly improved our "professional Outlook" as counselors.
 
Submitted by Marc Verhoeve, Counseling Services Head, Forest Heights C.I. Kitchener, ON
Canada (verhoeve@sympatico.ca).

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Change the Color Of a Hyperlink

1. On the Format menu, click Slide Design. 
2. In the task pane, click Color Schemes, and then click Edit Color Schemes. 
3. Click the Custom tab. 
4. Under Scheme colors, click Accent and hyperlink or Accent and followed

hyperlink, and then click Change Color. 
5. Do one of the following: 

a. Click the Standard tab to select from the Standard color palette. Click the color
you want, and then click OK. 

b. Click the Custom tab to mix your own color. Click to select a color, and then click
OK.

6. Click Apply

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft FrontPage 2003—Create a Web site with Frontage (PowerPoint)
This template contains FrontPage 2003 training content about how to create a Web site. This
content is geared for a corporate trainer to present to a group although you might also find it
helpful.

mailto:verhoeve@sympatico.ca
http://office.microsoft.com/en-us/templates/TC011949781033.aspx
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Difference Between the Internet and the World Wide Web
from the Webopedia
Many people use the terms Internet and World Wide Web (a.k.a. the Web) interchangeably,
but in fact the two terms are not synonymous. The Internet and the Web are two separate but
related things.  The Internet is a massive network of networks, a networking infrastructure. It
connects millions of computers together globally, forming a network in which any computer can
communicate with any other computer as long as they are both connected to the Internet.
Information that travels over the Internet does so via a variety of languages known as
protocols. 

The World Wide Web, or simply Web, is a way of accessing information over the medium of the
Internet. It is an information-sharing model that is built on top of the Internet. The Web uses
the HTTP protocol, only one of the languages spoken over the Internet, to transmit data. Web
services, which use HTTP to allow applications to communicate in order to exchange business
logic, use the Web to share information. The Web also utilizes browsers, such as Internet
Explorer or Netscape, to access Web documents called Web pages that are linked to each other
via hyperlinks. Web documents also contain graphics, sounds, text and video. 

The Web is just one of the ways that information can be disseminated over the Internet. The
Internet, not the Web, is also used for e-mail, which relies on SMTP, Usenet news groups,
instant messaging and FTP. So the Web is just a portion of the Internet, albeit a large portion,
but the two terms are not synonymous and should not be confused. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Roadmap to FrontPage 2003 Training
Whether you're a new user or a seasoned FrontPage veteran, there’s always something to
learn. And what better way to do that than by taking an Office Online Training course? With
rich audio and visual components and interactive, hands-on practice sessions, courses give you
real experience. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

WORTHY WEBSITES AND SOFTWARE

Online Book Publishers
Source: Microsoft Web Page

http://www.webopedia.com/DidYouKnow/Internet/2002/Web_vs_Internet.asp
http://office.microsoft.com/en-us/assistance/HA011102171033.aspx
http://www.microsoft.com/windowsxp/using/digitalphotography/shareit/book.mspx
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Take a look at the some of the publishers that offer custom book making, and decide which
one is right for you. Follow their step-by-step instructions for creating your custom book
project, and then sit back and wait for the finished product to arrive.

Shutterfly
www.shutterfly.com 
You can create professional-looking photo books with Shutterfly’s easy-to-use Web site.
Shutterfly offers a variety of book styles, covers, and layouts to fit your project. You can choose
a hardcover coffee-table style book, a soft-cover book, or a spiral-bound book. These make
great gifts to celebrate a special occasion or commemorate a vacation.

MyPublisher
www.mypublisher.com 
MyPublisher offers easy-to-use online tools and user-friendly publishing options with a variety of
material choices. Creating basic picture books or oversized hardcover compositions filled with
gorgeous, high-resolution pictures is easy with MyPublisher's proprietary BookMaker software.

AuthorHouse
www.authorhouse.com 
Turn your visual essay, professional portfolio, or photographic journal into a color paperback.

Trafford Publishing
www.trafford.com 
Ever wished you could work as a children's author? Dream no more. Send in your artwork and
watch it become a beautiful picture book that kids of all ages will adore.

BookSurge
www.booksurgepublishing.com 
A division of Amazon.com, this company lets you print any type of manuscript in marvelous
color. Decorate your creation with plug and play designs, fonts, and templates.

Xlibris
www.xlibris.com 
Cookbooks, catalogues, comics, graphic novels...this site's picture-book program caters to all
customers. Any sort of picture-based content is fair game as long as it's between 24 and 80
pages in length.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

School Clip Art (free) from Microsoft
Download these to your computer and use them in all your favorite applications. 

http://www.shutterfly.com
http://www.mypublisher.com
http://www.authorhouse.com
http://www.trafford.com
http://www.booksurgepublishing.com
http://www.xlibris.com
http://office.microsoft.com/clipart/results.aspx?lc=en-us&Scope=MC%2CMM%2CMP%2CMS&Query=school&Origin=HA012309051033&CTT=5
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Paint.NET
Advanced image editors are great, although sometimes all you want to do is click a button to
remove red eye. Paint.NET (free; Windows only) makes it easy to remove red eye, crop images,
change image size and create really cool effects. And you won't have to take a class to figure it
all out.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

RegClean v4.1a
This utility cleans your Registry of unnecessary entries that were created when you installed or
uninstalled programs on your computer. This release of the utility fixes a few problems and
creates an "undo.reg" file so that you can undo changes you inadvertently make to the
Registry. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows Live Safety Center is a new, free service designed to help ensure the health of
your PC.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

TimeGen Time Tracking Software
TimeGen is a time tracking utility that is designed to help you keep track of the time you've
spent on various tasks and projects throughout the day. You add projects or tasks to TimeGen
and click between them as you work on different things. TimeGen keeps a running total of all
time spent on specific projects and displays accumulated time in the format you specify.
http://www.brianhansen.com/timegen/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Counseling & Guidance Directory
A beginning directory of relevant sites for our profession. Let’s build on this. If you have sites
that you find valuable, click on “Submit a site.”

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Buddy Lee: Guidance Counselor
Don’t know what to make of this one although it’s a definitely must see.
http://www.buddyleeguidancecounselor.com/ 

http://www.eecs.wsu.edu/paint.net/
http://downloads.pcworld.com/pub/new/utilities/system_resources_tune_up/regclean.exe
http://safety.live.com/site/en-US/default.htm
http://www.brianhansen.com/timegen/
http://www.google.com/Top/Reference/Education/K_through_12/Counseling_and_Guidance/?il=1
http://www.buddyleeguidancecounselor.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Allway Sync
Allway Sync is free file and folder synchronization software for Windows.
http://allwaysync.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

MrExcel Video Podcast on a Windows PC
But you don't need to own an iPod nor do you need to own a Macintosh to enjoy podcasts. In
fact, the Podcast experience is better on a computer, like the computer that you are reading
this on right now. It can seem daunting to dip into the Apple world - it took me weeks before I
could figure out how to watch video on iTunes. I am going to get you up and running on your
PC in less than 15 minutes. And - once you are set up, you will be able to subscribe to new TV
and radio shows that are being produced just for the podcast crowd.
Learn more >>> http://www.mrexcel.com/tip106.shtml 

JUST FOR FUN

Longest List of the Longest Stuff with the Longest Domain Name at Long Last!
Ever wonder what the longest (insert item) in the world is?

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Gourmet Recipe Manager
Gourmet Recipe Manager is a simple but powerful recipe-managing application. Gourmet is
intended for the GNOME desktop environment, but works on any platform that gtk supports,
including windows. Gourmet allows you to collect, search and organize your recipes, and to
automatically generate shopping lists from your collection. Gourmet's features includes simple
searching and sorting, easy recipe editing, import and export from various formats, a shopping
list creator and organizer. When you get to the download page, click any “mirror” on the right
side of the page.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Archive Your Photos Fast
Capturing pictures with your digital camera is so easy that you're sure to collect hundreds—if
not thousands—of photos in a very short time, all stored on your computer. After you print
pictures or e-mail them off to family and friends, you need a way to preserve them for the
future. That's why remembering to archive your digital photos to CD is so critical. After all,
"memories lost" is not a phrase that you want to describe the state of your digital photos. If

http://allwaysync.com/
http://www.mrexcel.com/tip106.shtml
http://thelongestlistofthelongeststuffatthelongestdomainnameatlonglast.com/
http://prdownloads.sourceforge.net/grecipe-manager/gourmet-0.8.5.12-1-full_gtkglade-2.6.10.exe?download
http://www.microsoft.com/windowsxp/using/digitalphotography/printit/archive.mspx
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you take just a few minutes each month you can easily archive your photos. You'll rest easy
knowing that you always have backup copies safely stored away. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Send an E-mail to Your Future Self
http://futureme.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

10x10
Every hour, 10x10 scans the RSS feeds of several leading international news sources, and
performs an elaborate process of weighted linguistic analysis on the text contained in their top
news stories. After this process, conclusions are automatically drawn about the hour's most
important words. The top 100 words are chosen, along with 100 corresponding images, culled
from the source news stories. At the end of each day, month, and year, 10x10 looks back
through its archives to conclude the top 100 words for the given time period. In this way, a
constantly evolving record of our world is formed, based on prominent world events, without
any human input.

http://futureme.org/
http://www.tenbyten.org/
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SchoolCounselor.com eNewsletter - #54 February 1, 2006

Back up my hard drive?  How do I put it in reverse?  -Author Unknown

Give a person a fish and you feed them for a day; teach that person to
use the Internet and they won't bother you for weeks.  -Author
Unknown

If you give someone a program, you will frustrate them for a day; if
you teach them how to program, you will frustrate them for a lifetime. - Author Unknown

Technology Training and more for Counselors
Download a booklet with comprehensive descriptions of technology training and resources for
counselors (PDF; 116KB).
http://www.schoolcounselor.com/pdf/booklet.pdf 

____________________________________________

Blogs

You’ve probably heard the term blog more than once, most likely used on television or
print news media. However, you may still not exactly understand what a blog is. According to
the Webopedia (Blog, 2005), a blog, short for “web log,” is a web page that serves as a publicly
accessible personal journal for an individual. Typically updated on a daily basis, blogs often
reflect the personality of the author.  Google owned Blogger.com describes a blog as, “A blog is
a personal diary. A daily pulpit. A collaborative space. A political soapbox. A breaking-news
outlet. A collection of links. Your own private thoughts. Memos to the world.”  Creating a blog is
simple and free. It only takes a few minutes by entering your name, e-mail address and a few
other pieces of (usually personal) information. You select "the look" (template) for your blog
from a set of standard options, click a few buttons, and another blog has been added to the
“blogosphere.” Once the blog is set up, you can post text, links, audio, video, and more  to
your hearts delight. From your computer or cell phone, you can say or show anything and
everything. With a bit of know-how, you can even syndicate to other blogs and websites.
Syndication is a process by which the latest content from a blog, or from any other web page,
can be made available for re-publication in another website or in some other application. And
millions of people (including children) are doing it. 

As compared to dynamic websites, blogs feature several unique characteristics (How
Blogs Work, 2005) such as:

http://www.schoolcounselor.com/pdf/booklet.pdf
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• A blog is normally a single page of entries. There may be archives of older
entries, but the "main page" of a blog is all anyone really cares about. 

• A blog is organized in reverse-chronological order, from most recent entry to
least recent. 

• A blog is normally public -- the whole world can see it. 
• The entries in a blog usually come from a single author. 
• The entries in a blog are usually stream-of-consciousness. There is no

particular order to them. For example, the blogger sees a good link, he or she
can throw it in his or her blog. The tools that most bloggers use make it
incredibly easy to add entries to a blog any time they feel like it. 

• A typical blog has a main page and nothing else. On the main page, there is a
set of entries. Each entry is a little text blurb that may contain embedded
links out to other sites, news stories, etc. When the author adds a new entry,
it goes at the top, pushing all the older entries down. This blog also has a
right sidebar that contains additional permanent links to other sites and
stories. The author might update the sidebar weekly or monthly. 

The technology that allows individuals to write one’s own blog is so relatively simple and
inexpensive that it is no surprise that blogs have proliferated the Web as fast as they have. Any
counselor can create a basic blog for free, and most of these toolsets have additional features
available for a price. Here are just a few of the services available.

• Blogger is a free, automated weblog publishing platform in one easy to use
website. http://www.blogger.com/ 

• bBlog is a powerful, elegant personal publishing system written in PHP and
released as free, Open Source software under the GPL. It is a flexible but
simple way to blog that works for blogging beginners, and can grow into a
more advanced user's needs. http://www.bblog.com/ 

• Xanga is a community of online diaries and journals.
http://www.xanga.com/ 

• TypePad is similar to blogger, another blogging service although this one has
a minimal cost. http://www.sixapart.com/typepad/ 

• LiveJournal is free although users can choose to upgrade their accounts for
extra features. http://www.livejournal.com/ 

• Moveable Type is another popular web publishing platform.
http://www.sixapart.com/movabletype/ 

• MySpace.com is actually a hybrid site that allows people to post their
personal interests, write blogs, put up video and set up ways to communicate
with their friends. http://www.myspace.com/ 

Consumers of blogs, in this case, our stake holders, have several ways that they can
learn about new updates or additions to your blogs. First, they can periodically visit your blog

http://www.blogger.com/
http://www.bblog.com/
http://www.xanga.com/
http://www.sixapart.com/typepad/
http://www.livejournal.com/
http://www.sixapart.com/movabletype/
http://www.myspace.com/
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and look for any updates which is easy to do since entries are listed in chronological order.
Second, if your blog allows it, they can sign up to receive e-mail notification of any new
information. Or third, you can subscribe to the blog if the blog host offers RSS (Real Simple
Syndication) feed capability. In this case, you simply copy the website address of the feed into
a feed reader or aggregator (e.g., see http://blogspace.com/rss/readers). Anytime the blog is
updated, you automatically receive a copy of it right in your reader. 

Blog. (Retrieved December 11, 2005). Webopedia. [Online]. Available:
http://www.webopedia.com/TERM/b/blog.html 

How blogs work. (Retrieved December 21, 2005). Howstuffworks. [Online]. Available:
http://computer.howstuffworks.com/blog1.htm 
____________________________________________

Educational and Inspirational Posters for your Home and Office
http://www.schoolcounselor.com/posters.htm 

TIPS AND TRICKS

Fix Split Links
Have you ever received an e-mail where half of a link is missing? The first part is clickable, but
the other half is just kinda out in space and it takes you nowhere? Well, here's a free video for
you to watch and in seconds, you'll know how to fix a split link!
http://imgsrv.worldstart.com/videotips/index.htm

By the way, avoid split links all together. If you have a long link, go here to make it shorter. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Quickly Convert Text To Lower Case 
from http://www.theexceladdict.com/_t/t031112.htm 
Have you ever had data in a worksheet where all the text was all uppercase? Then you had to
retype it all to get it into lowercase? No more! 
Next time here's what you can do: 

1. Find a blank cell to the right of the cell containing the uppercase text and
enter the formula =LOWER(origtext). 

2. Replace 'origtext' in the formula with the address of the cell that contains the
original uppercase text i.e. =LOWER("A1"). Excel will instantly convert it to
lowercase. 

http://www.xml.com/pub/a/2002/12/18/dive-into-xml.html
http://www.xml.com/pub/a/2002/12/18/dive-into-xml.html
http://blogspace.com/rss/readers
http://www.webopedia.com/TERM/b/blog.html
http://computer.howstuffworks.com/blog1.htm
http://www.schoolcounselor.com
http://www.schoolcounselor.com/posters.htm
http://imgsrv.worldstart.com/videotips/index.htm
http://tinyurl.com/
http://www.theexceladdict.com/_t/t031112.htm
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3. Copy the formula down for each cell you want to convert. 
4. Select all of the cells containing the formulas and click Edit, Copy. 
5. Select all of the cells containing the original text and click Edit, Paste Special,

Values, and OK. 
6. Go back and delete the cells containing the formulas. 

You can also use the UPPER and PROPER worksheet functions to convert text. 
NOTE: It's always a good idea to backup your data before making wholesale changes to it like
this. Better safe than sorry.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Send 1.5GB Emails for Free
Limited by your ISP to a maximum e-mail size of 10MB or less? No problem, use this file upload
service from FileFactory and you can e-mail files up to 1.5GB. FileFactory also allows you to
upload non-e-mail files up to 500MB and share them with multiple users. While the maximum
size of individual files is limited, the total of all your files stored on the server is not. Not bad for
nix.
http://www.filefactory.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows OneCare
Windows OneCare is a comprehensive and integrated PC health service that helps protect and
maintain your computer with antivirus, firewall, PC maintenance, and file backup and restore
functionality. This new service is in beta testing. 
http://www.windowsonecare.com/purchase/Default.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Adjust The Mouse Wheel Scroll Speed
If you own a wheel mouse, then you can control how many lines your mouse scrolls when you
turn the wheel.

1. Click the Start menu and open the Control Panel.
2. Click the Printer and Other Hardware icon, then the Mouse icon. (Note: This is in Category
view, not Classic view.)
3. Click the Wheel tab in the dialog box, change the number of lines your mouse scrolls with
each turn of the wheel, and then click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.filefactory.com/
http://www.windowsonecare.com/purchase/Default.aspx
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Internet Explorer Browser Shortcuts

ALT + Home = Homepage
ALT + Left Arrow = Back to the previous page
ALT + Right Arrow = Forward to the next page
ALT + Up Arrow = Scroll page up
ALT + Down Arrow = Scroll page down

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Add a Chat Room to your Website
Adding a chat room to your website is very simple. Fill out the form below, click create chat
room and follow the direction on the confirmation page.
http://www.everywherechat.com/addchat.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint®: Just Give it a Nudge
Source: http://www.worldstart.com/newsletters.htm 

When working in MS PowerPoint, are you frequently frustrated when you try to move objects
just a teensy little bit?

I mean, you're only trying to nudge the text box or graphic up the smallest amount, but every
time you try to drag and drop with the mouse, it's just too far.

A solution for that predicament certainly would come in handy!

Fortunately I've got one that's easy to use and remember.

First, select the object to be moved. (If it's a text box, be sure that you have the text box itself
selected and that the cursor isn't inside the text box for editing).

Ready to move? Good! It goes quick, so pay attention!

Simply tap an arrow key to move the selected object 1/12 of an inch in any of the four
directions.

Yep! That's the whole thing.

With the object selected, one press of an arrow key and it moves just the smallest amount.
Talk about fine tuning!

http://www.everywherechat.com/addchat.asp
http://www.worldstart.com/newsletters.htm
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Have a large distance to cover?

Don't worry! You can use this tip for that too.

Instead of a quick tap, hold down the arrow key. You'll find that your object is zipping around
the slide as though it had on running shoes!

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Google Pack
A free collection of essential software from trusted Google.com. Includes Google-tweaked
version of Firefox, Adobe Acrobat Reader, antivirus software from Symantec, AdAware, Photo
Screensaver, and Google's own offerings, including Google Desktop Search, Picasa, and Google
Earth.
http://www.schoolcounselor.com/resources/  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Web Album Generator
Web Album Generator is a free software application for Windows that helps you easily create
photo albums for the World Wide Web. Publishing your photographs to the Internet has never
been easier! Simply drag-and-drop your digital photos onto Web Album Generator, give them
optional titles and captions, select your favorite color scheme and generate! Web Album
Generator takes care of the dirty work, creating the necessary JPG thumbnails, HTML and CSS
files with strict standards compliance.
http://www.ornj.net/software/webalbum/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HomeworkSpot.com is a free homework information portal that features the very best K-12
homework-related sites together with engaging editorial in one high-utility, educational spot.
With the help of students, parents and teachers, our team of educators, librarians and
journalists has scoured the Web to bring you the best resources for English, math, science,
history, art, music, technology, foreign language, college prep, health, life skills, extracurricular
activities and much more. For your convenience, we have made every effort to organize these
resources into grade-appropriate categories for elementary, middle and high school.
http://www.homeworkspot.com/ 

http://www.schoolcounselor.com/resources/
http://www.ornj.net/software/webalbum/
http://www.homeworkspot.com/
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Also see LIBRARY SPOT which has convenient links to popular online Almanacs, Calculators,
Dictionaries, Directories, Encyclopedias, Historic Documents, Quotations, Statistics, and
Thesauri. http://www.libraryspot.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™ Hotkeys/Keyboard Shortcuts
Sometimes its faster to key your fingers on the keyboard. Here is one (PDF document, one
page) that you can neatly print out. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

1-800-FREE411 is a free, nationwide directory assistance service. It is free from all phones,
whether you’re calling from home, your business, or your cell phone. If you call from a cell
phone your cell phone carrier may charge you minutes according to your cell phone plan as
they would with you dialing any other 800 number, but we will not charge you anything.
http://www.free411.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Indezine 
Indezine has evolved as a platform for PowerPoint presentations, image editing and clip media -
the PowerPoint section can be directly accessed from the links on this page.
http://www.indezine.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint Timers
These might come in handy during presentation or classroom guidance.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

100 Things You Should Have Learned From Crabby By Now
The Crabby Office Lady has hit a milestone: 100 columns. I certainly hope that you've learned a
thing or two (or possibly 100) since you've been reading my weekly yarns. Let's just see, shall
we?

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Icing on the Cake: Online Tools for Classroom Use by Kathy Schrock
http://kathyschrock.net/cooking/ 

http://www.libraryspot.com/
http://www.helpwithpcs.com/tipsandtricks/keyboard_shortcuts_microsoft_word.htm
http://www.its.qut.edu.au/assist/userguides/exfiles/word.pdf
http://www.free411.com/
http://www.adcritic.com/interactive/view.php?id=5927
http://www.indezine.com/
http://office.microsoft.com/en-us/templates/CT011873811033.aspx
http://office.microsoft.com/en-us/assistance/HA100152241033.aspx
http://kathyschrock.net/cooking/
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JUST FOR FUN

SUDOKU is the latest puzzle craze. Play the Japanese numbers game that’s driving everybody
mad. We guarantee that once you’ve tried one SUDOKU puzzle, you’ll be hooked. Our SUDOKU
puzzles are updated daily so add this page to your favorites so you can easily get your daily
Lovatts SUDOKU fix.
http://www.lovatts.com.au/sudoku/sudoku.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Convert iTunes to MP3 Format
"I've purchased a bunch of music from iTunes and have enjoyed listening to them on my
computer. But my portable music player is not an Apple iPod, so I can't take my songs with me.
Is there any way I can get around this unfair restriction and convert my Itunes tracks to good
old MP3?"
http://www.askbobrankin.com/convert_itunes_to_mp3_format.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Diner Dash
Diner Dash isn't your average shoot-em-up computer game. The game requires strategy and an
agile computer mouse.
http://www.shockwave.com/sw/content/dinerdash 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Dolphin Dream Screensaver 1.3
Let your desktop become the setting of this dolphin dream. This screensaver is unlike anything
you have seen before. The 3D-rendered photorealistic animation is unbelievable. With the
sounds of the ocean waves crashing gently upon the shore and the dolphins dancing in the
moonlight, this surreal ocean cove scene is sure to take your breath away. Version 1.3 fixed
temp folder problems. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Pizza Palace
Critical spoof about electronic databases. Hilarious and scary!
http://www.adcritic.com/interactive/view.php?id=5927 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.lovatts.com.au/sudoku/sudoku.htm
http://www.askbobrankin.com/convert_itunes_to_mp3_format.html
http://www.shockwave.com/sw/content/dinerdash
http://www.download.com/Dolphin-Dream-Screensaver/3000-2385-10408384.html?part=winmp&subj=dl&tag=feed&jump=winmp
http://www.adcritic.com/interactive/view.php?id=5927
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Tennis Anyone?
The premise of the Tennis Challenge is simple. You have to keep the tennis ball in the air as
long as possible. Click it with your mouse to stop it from landing on the court.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Photography
My son Joseph (6  grader) has been into photography lately. We’ve enjoyed several websitesth

that have provided tips, techniques, and even encouragement. I’ve enjoyed the work of others
who share their photos online:
http://www.photography-cafe.com 
http://www.usefilm.com/ 
http://www.betterphoto.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FatFingers
Thousands of items on eBay are listed with descriptions containing spelling mistakes. These
items often expire with no bids on them as no-one can find them. Type in a keyword below and
click the Find button. Then click the link and uncover those hidden gems...
http://www.fatfingers.co.uk/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

American Idol
These folks didn’t quite make it.
http://www.bofunk.com/video/2787/american_idol_rejects.html 

Visit http://www.schoolcounselor.com/newsletter to subscribe or unsubscribe from this
newsletter. To change your e-mail address, please subscribe your new address and unsubscribe
your old one.

http://www.mcsaatchi.webcentral.com.au/tennischallenge/optus_tennis_site_edited.html
http://www.photography-cafe.com
http://www.usefilm.com/
http://www.betterphoto.com/
http://www.fatfingers.co.uk/
http://www.bofunk.com/video/2787/american_idol_rejects.html
http://www.schoolcounselor.com/newsletter
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SchoolCounselor.com eNewsletter #55 - February 22, 2006

When computers (people) are networked, their power multiplies
geometrically. Not only can people share all that information inside their
machines, but they can reach out and instantly tap the power of other
machines (people), essentially making the entire network their
computer. Peter Drucker -Scott McNeely.

Computers are magnificent tools for the realization of our dreams, but
no machine can replace the human spark of spirit, compassion, love,
and understanding. Louis Gerstner

Full-Text Electronic Databases

The number of journal, magazine, and newspaper titles available online has grown
rapidly in recent years. Many databases are only accessible by paying a fee although, often,
schools and local universities provide free access to anyone while on campus. Some databases
are designed for individual users and are more reasonably priced. Finally, other full-text
databases have been provided for free as a government service or by the incredible generosity
of individuals and organizations. Following are examples:

Larger and More Expensive Databases Typically Subscribed to by Institutions

1. CollegeSource® Online features over 33,550 college catalogs in complete
cover-to-cover original page format including 2-year, 4-year, graduate, and
professional schools. http://www.collegesource.org/ 

2. Congressional Universe is a web-based indexing and abstracting service for
Congressional committee publications, including hearings (testimony),
committee prints, reports, documents, and public laws. It also includes the
full text and status of bills, selected testimony, regulations, and two
periodicals, National Journal and Congress Daily. Additional features include
Member directories and campaign contributions and a guide to creating
citations. The publisher, Congressional Information Service, is an affiliate of
LEXIS-NEXIS, so much of the full text is identical to material found in the
LEXIS on-line data base. https://web.lexis-nexis.com/congcomp/

3. EBSCO Information Services provides information access and management
solutions through print and electronic journal subscription services, research
database development and production, online access to more than 150
databases and thousands of e-journals, and e-commerce book procurement.

http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.collegesource.org/
https://web.lexis-nexis.com/congcomp/
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EBSCO has served the library and business communities for more than 60
years. http://www.ebscohost.com/ 

4. IngentaConnect allows subscribers to search over 19 million articles,
chapters, reports and more. http://www.ingentaconnect.com/ 

5. LexisNexis® provides authoritative legal, news, public records and business
information; including tax and regulatory publications in online, print or
CD-ROM formats. http://www.lexisnexis.com/ 

6. Online Computer Library Center (OCLC) is a nonprofit, membership, library
computer service and research organization dedicated to the public purposes
of furthering access to the world’s information and reducing information
costs. http://www.oclc.org  

7. Ovid is a Platform-independent access to bibliographic and live full text
databases for academic, biomedical and scientific research.
http://www.ovid.com/ 

8. ProQuest® online information service provides access to thousands of
current periodicals and newspapers, many updated daily and containing
full-text articles from 1986. Deep backfiles of archival material are also
expanding daily as they digitize 5.5 billion pages from their distinguished
microfilm collection. http://www.proquest.com/ 

9. ReferenceUSA contains more than 12 million U.S. businesses; 102 million
U.S. residents; 683,000 U.S. health care providers; 1 million Canadian
businesses; and 11 million Canadian residents.
http://reference.infousa.com/ 

Inexpensive Full-Text

For those that do not have access to expensive full-text databases provided by schools
or other institutions, HighBeam Library Research (http://www.highbeam.com/library/) has an
extensive archive of more than 35 million documents from over 3,000 sources -- a vast
collection of articles from leading publications, updated daily and going back as far as 20 years.
As of this writing, a monthly subscription is $19.95 or $99.95 for an annual subscription.

Another example of an inexpensive full-text database ($11.95 per month) is the
Encyclopedia Britannica online (http://www.britannica.com/) which includes the complete
encyclopedia as well as other resources such as dictionary, thesaurus, and newsletters. 

Free full-text

Following are examples of various full-text resources which are freely available online:

1. National Center for Research in Vocational Education (NCRVE) is the nation's
largest center engaged in research, development, dissemination and

http://www.ebscohost.com/
http://www.ingentaconnect.com/
http://www.lexisnexis.com/
http://www.oclc.org
http://www.ovid.com/
http://www.proquest.com/
http://reference.infousa.com/
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outreach in work-related education, and is funded by the Office of Vocational
and Adult Education of the U.S. Department of Education. The Center's
mission is to strengthen school-based and work-based learning to prepare all
individuals for lasting and rewarding employment, further education, and
lifelong learning. http://vocserve.berkeley.edu/fulltext.html 

2. Maintained by an individual, this page links to websites containing full-text
state constitutions, statutes (called codes or compiled laws in some states),
legislation (bills, amendments and similar documents) and session laws (bills
that have become laws). http://www.prairienet.org/~scruffy/f.htm 

3. The Education Resources Information Center (ERIC), sponsored by the
Institute of Education Sciences (IES) of the U.S. Department of Education,
produces the world’s premier database of journal and non-journal education
literature. The ERIC online system provides the public with a centralized
ERIC Web site for searching the ERIC bibliographic database of more than
1.1 million citations going back to 1966. More than 107,000 full-text
non-journal documents (issued 1993-2004), previously available through
fee-based services only, are now available for free. ERIC is moving forward
with its modernization program, and has begun adding materials to the
database. http://www.eric.ed.gov/ 

4. A list of free (29 titles at the time of this writing) free full-text journals on
the Web and maintained by the Lesley College Library are located at
http://www.lesley.edu/faculty/kholmes/libguides/cpfulltext.html 

5. The Journal of Technology Education provides a forum for scholarly
discussion on topics relating to technology education. Manuscripts should
focus on technology education research, philosophy, and theory. In addition,
the Journal publishes book reviews, editorials, guest articles, comprehensive
literature reviews, and reactions to previously published articles.
http://scholar.lib.vt.edu/ejournals/JTE/ 

6. The Journal of Technology in Counseling publishes articles on all aspects of
practice, theory, research and professionalism related to the use of
technology in counselor training and counseling practice. The Journal accepts
manuscripts that respond to the full scope of technology interests of its
readers. The Journal recognizes that modern technology has surpassed
traditional ways of presenting information to readers by encompassing
learning methods that go beyond the two-dimensional page. Authors are
encouraged to use the full range of available web resources when submitting
manuscripts including hyperlinks to other web resources, audio, graphics,
video clips and video-streaming. http://jtc.colstate.edu/ 

7. FindArticles. Search millions of articles from leading academic, industry and
general interest publications. http://www.findarticles.com/ 

http://vocserve.berkeley.edu/fulltext.html
http://www.prairienet.org/~scruffy/f.htm
http://www.eric.ed.gov/
http://www.lesley.edu/faculty/kholmes/libguides/cpfulltext.html
http://scholar.lib.vt.edu/ejournals/JTE/
http://jtc.colstate.edu/
http://www.findarticles.com/
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8. Technology Horizons in Education (T.H.E.) is a free magazine for educators
dedicated to technology solutions in education. 
http://www.thejournal.com/ 

9. Edutopia Magazine gives practical, hands-on insight into what works, what’s
on the horizon, and who is shaping the changing future of education.
http://www.edutopia.org/  

Support SchoolCounselor.com for FREE

Here are four ways you can support the eNewsletter and not spending an extra
dime:

1.       Go to the home page (www.schoolcounselor.com) and download the new
and improved Firebox browser with enhanced Google Toolbar. After
downloading, Google will make a donation. 

2.       Visit the online version of this newsletter and click on one or more
Google Advertisements at the top of the page (or other Google ads throughout
the site). 

3.       Whenever searching and purchasing anything from Amazon.com, instead
of going directly to their website, start your Amazon search on mine at
http://www.schoolcounselor.com/amazon.htm.

4.       Forward this e-mail to teachers, administrators, and others whom might
find it useful. 

TIPS AND TRICKS

10 things you should know about fighting spyware in Windows XP
This PDF document from TechRepublic can help you protect yourself against malicious spyware. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Quickly Sum Non-Contiguous Cells 
Source: http://www.theexceladdict.com/_q/q040428.htm 

http://www.thejournal.com/
http://www.edutopia.org/
http://www.schoolcounselor.com/amazon.htm
http://www.schoolcounselor.com
http://techrepublic.com.com/i/tr/downloads/home/10_things_spyware_xp.pdf
http://www.theexceladdict.com/_q/q040428.htm
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There may be times when you want to calculate the sum of a group of non-contiguous cells.
How do you do that now? Do you enter a formula such as =B5+D5+F5+H5+J5? That can be
very cumbersome, especially if you're dealing with a lot of cells. That's how I used to it until I
discovered a much faster and easier way. 

Click the AutoSum button. Then, one at a time, click each of the cells you want to sum, typing
a comma to separate each cell in the formula (i.e. =SUM(B5,D5,F5,H5,J5). So basically what
you're doing is clicking the cells with your mouse and pressing the comma with your free hand.
Even if you have many cells to sum, this way allows you do it very fast and easy. 

Another option is to hold down the CTRL key (instead of pressing the comma) as you are
selecting the cells. 

You can also drag to select if there are some contiguous cells in your formula (i.e.
=SUM(B5,D5,F5:H5,J5) 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: The Little-Known, Seldom-Used AutoComplete Trick 
Source: http://www.theexceladdict.com/_q/q040226.htm
If you're like me, it didn't take long after starting to use Excel to wonder if there is an easier
way to repeat data in a column that you already have entered in previous cells in that column.
The natural response is to copy and paste. But often that involves scrolling up the sheet to
copy the data from previous cells and then scrolling back down to paste it. 
Wouldn't it be great if you could just select an item previously used in that column from a list
and have it automatically entered for you? Wouldn't that be cool?  Well you can! 

Any time you want to repeat data that is already in a column, simply press ALT+DOWN
ARROW. Just like magic, you've got an list of all previous entries in that column. Just use the
arrow keys to select an item and press Enter. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Microsoft Windows Malicious Software Removal Tool checks computers running
Windows XP, Windows 2000, and Windows Server 2003 for infections by specific, prevalent
malicious software—including Blaster, Sasser, and Mydoom—and helps remove any infection
found. When the detection and removal process is complete, the tool displays a report
describing the outcome, including which, if any, malicious software was detected and removed.
http://www.microsoft.com/security/malwareremove/default.mspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.theexceladdict.com/_q/q040226.htm
http://www.microsoft.com/security/malwareremove/default.mspx
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Microsoft Word™:  Insert A Hard Hyphen (Or Hard Space) 

As you work through a paragraph and Word automatically wraps your text down onto the next
line, it makes the break at the most convenient spot such as between a person’s prefix and
their first name. Sometimes, however, you may not want this split to occur. Another example is
phone number that is best kept together on one line. You can avoid these splits by using a hard
space or hard hyphen, which looks the same as a regular space or hyphen but refuses to let its
partners in text be pushed around. Instead of pressing the hyphen key alone, press
CTRL-SHIFT--, and your hyphenated number, name, or word will be solidified into a single
unbreakable entity. For hard spaces, it’s the same idea: CTRL-SHIFT-Spacebar. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft® PowerPoint® 2000 Tutorials
These tutorials are designed for use with Microsoft® PowerPoint® 2000. However, the
information provided here is applicable to other versions of PowerPoint as well. If you are using
a different version of PowerPoint, you may find slight variations in steps. Additionally, if you are
using an older version of PowerPoint, you may find some features unavailable.
http://presentersonline.com/tutorials/powerpoint/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: AutoShape (From TechRepublic)
You are not limited to rectangular text boxes when it comes to positioning and formatting text
for best effect. Word provides a wealth of AutoShapes—from arrows and banners to clouds and
trees—that can be used as text containers. To create a text box from an AutoShape, follow
these steps:

Go to View | Print Layout (if you are not already in this view). 
Click the Drawing tool in the Standard toolbar. 
Click AutoShapes and select the shape to contain the text. 
Click and drag to draw the shape in your document. 
Right-click the shape and select Add Text. 
Type the desired text. 
You can now select the text in your AutoShape and format it as you would any document text.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Internet Explorer: Go Back and Forth Through Multiple Web Pages
You probably know that you can use the back and forward buttons in Microsoft Internet
Explorer to go backward or forward exactly one page. But did you know that you can also jump

http://presentersonline.com/tutorials/powerpoint/
http://techrepublic.com.com/5100-10877_11-6033983.html?tag=nl.e056
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several pages at once? Just click the down arrow beside the buttons to view recently visited
pages. Then click any page title to jump to it immediately.

WORTHY WEBSITES AND SOFTWARE

Jetable.org
To avoid spam, jetable.org provides you with a temporary e-mail address. As soon as it is
created, all the emails sent to this address are forwarded to your actual e-mail address. Your
antispam address will be deactivated after the lifespan you selected comes to its end. 
http://www.jetable.org/en/index 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Buddy Project was created in 1988 by a group of visionary Indiana business and
education leaders. They believed all families, regardless of financial circumstances, needed
access to information, technology and training to enhance learning in school, home and the
community. Many years and 30,000+ participants later, Buddy2 continues to be guided by this
belief. As technology and information have proliferated in our homes and schools, Buddy2 has
moved from the initial focus on access to a focus on learning enhancement.
http://www.buddyproject.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mediasite.com is a search tool that helps you find expert presentations and lectures.
http://www.mediasite.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Process Explorer
Ever wondered which program has a particular file or directory open? Now you can find out.
Process Explorer shows you information about which handles and DLLs processes have opened
or loaded.  The Process Explorer display consists of two sub-windows. The top window always
shows a list of the currently active processes, including the names of their owning accounts,
whereas the information displayed in the bottom window depends on the mode that Process
Explorer is in: if it is in handle mode you’ll see the handles that the process selected in the top
window has opened; if Process Explorer is in DLL mode you’ll see the DLLs and
memory-mapped files that the process has loaded. Process Explorer also has a powerful search
capability that will quickly show you which processes have particular handles opened or DLLs
loaded. 
http://www.sysinternals.com/Utilities/ProcessExplorer.html 

http://www.jetable.org/en/index
http://www.buddyproject.org/
http://www.mediasite.com/
http://www.sysinternals.com/Utilities/ProcessExplorer.html
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

mailbigfile.com
Send big files quickly and easily, without clogging up your e-mail! 
http://www.mailbigfile.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Chart Tutorial from FGCU
Charts allow you to present data entered into the worksheet in a visual format using a variety
of graph types. Before you can make a chart you must first enter data into a worksheet. This
page explains how you can create simple charts from the data. 
http://www.fgcu.edu/support/office2000/excel/charts.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Choosing a Chart Type For Your Spreadsheet
There are a lot of different chart types out there, and it can be confusing to work out just which
chart type you need for a particular set of data. Some of the most common types of chart and
their uses are explained below. The definitions of the charts remain the same no matter what
operating system you use, or what spreadsheet program. 
http://spreadsheets.about.com/od/spreadsheetdesign/a/charttypes.htm 

JUST FOR FUN

Worth1000
They say a picture is worth 1,000 words. You will agree after seeing this site. This site provides
contests for Photoshop users. See how creative people can get with a program like Photoshop. 
http://www.worth1000.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FindMyCover.com
For your CD’s and DVD’s. Just enter the name of an artist or album, and it finds the cover for
you. Then you can download it and add it to your computer's music library.
http://www.findmycover.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.mailbigfile.com/
http://www.fgcu.edu/support/office2000/excel/charts.html
http://spreadsheets.about.com/od/spreadsheetdesign/a/charttypes.htm
http://www.worth1000.com/
http://www.findmycover.com/
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“At Cute Overload®, we scour the Web for only the finest in Cute Imagery™. Imagery that is
Worth Your Internet Browsing Time. We offer an overwhelming amount of cuteness to fill your
daily visual allowance. Drink it in!”
http://cuteoverload.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

At Caedes, you'll find thousands of images for your desktop. They're divided into categories
such as photography and abstract. You're sure to find at least one that suits your taste.
http://www.caedes.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Super Bowl XL Commercials
No need to worry if you missed them. Or, maybe you might just want to watch them again!
http://video.google.com/superbowl.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

fd's Flickr Toys
Helping you do fun things with your digital camera since 2005. ;-) 
http://flagrantdisregard.com/flickr/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Online Jigsaw Puzzles
An online Jigsaw Puzzle where you choose the level of difficulty from a simple 6 piece cut to a
challenging 247 piece cut.
http://www.jigzone.com/ 

____________________________________________

SUBSCRIPTION

Visit http://www.schoolcounselor.com/newsletter to subscribe or unsubscribe from this
newsletter. To change your e-mail address, please subscribe your new address and unsubscribe
your old one.
____________________________________________

http://cuteoverload.com/
http://www.caedes.net/
http://video.google.com/superbowl.html
http://flagrantdisregard.com/flickr/
http://www.jigzone.com/
http://www.schoolcounselor.com/posters.htm
http://www.schoolcounselor.com/newsletter
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SchoolCounselor.com eNewsletter #56 - March 11, 2006

Politically Correct Virus: Doesn't refer to itself as a virus - instead, refers
to itself as an "electronic microorganism." — Mark Kaye

A computer lets you make more mistakes faster than any invention in
human history - with the possible exceptions of handguns and tequila. —
Mitch Ratliff

List Servers 

List servers are programs that allow an administrator to create lists of e-mail addresses
and attach them to a single e-mail address (called the listserv address). All messages that are
e-mailed to the listserv are distributed, again via e-mail, to all subscribers, sometimes by a
"moderator" who reads them first (in a "moderated list") or more typically in an automated
manner (or "unmoderated list"). Some list servers require an administrator to add people to the
list. In others, anyone who wishes can automatically subscribe (or unsubscribe) by either
sending an e-mail message to the program which resides on a server or by completing an
online form. List server programs can provide some security by allowing only authorized users
to post to the list or by using a moderator to approve messages before they are posted to the
list. Counselors can also set up their listserv to act more like a mailing list for those who simply
want to receive reminders, newsletters, or announcements. This is called a post-only listserv.
Creators (or "owners") of these listservs are usually the only people who can send an e-mail via
the listserv. Any one else who tries is humbly and automatically rejected. Try subscribing to two
different types of listservs, a post only newsletter listserv and a full fledged discussion listserv,
respectively. The Scout Report is the flagship publication of the Internet Scout Project.
Published every Friday both on the web and by e-mail, it provides a fast, convenient way to
stay informed of valuable resources on the Internet. The report is developed by a team of
professional librarians and subject matter experts who select, research, and annotate each
resource. Visit http://scout.wisc.edu/mailman/listinfo/scout-report, and complete the form.
Next, you will be sent an e-mail requesting confirmation to prevent others from gratuitously
subscribing you (this is called a double opt-in list). Second, the International Counselor Network
(ICN) is a network for counselors working in all specialty areas. Topics range widely, including
such issues as self-esteem, multicultural issues, program development, career planning, play
theory, professional issues and more. Complete the online form at
http://listserv.utk.edu/cgi-bin/wa?SUBED1=icn&A=1 and you will once again receive an e-mail
with instructions for how to confirm your identity. 

http://scout.wisc.edu/mailman/listinfo/scout-report
http://listserv.utk.edu/cgi-bin/wa?SUBED1=icn&A=1
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List servers are an efficient way of sending e-mail to large and/or specific groups and
are ideal for disseminating timely information, such as announcements of conferences, pointers
to new websites of interest, and descriptions of print resources. Anyone on the list can be a
source of information. List servers are well-suited to groups of users who regularly use e-mail
and who need to receive information in a timely way. They are less effective for extended or
lengthy discussions, because participants may not be able to remember all the previous entries
when they respond to a particular item. Another disadvantage is that mailing list servers can be
inconvenient for recipients, filling their e-mail in-boxes when they're busy with other things.
Two of the most commonly used mailing list server programs are Majordomo
(http://www.greatcircle.com/majordomo/) and Listserv (http://www.lsoft.com). 

There are primarily two methods for learning about available listservs of interest. First
and most popular, a specific listserv of interest may be announced in relevant professional or
related publications such as journals, magazines, newsletters, or newspapers. Second, you may
seek for listservs of interest by conducting a basic web search using keywords such as
"counseling listserv" which should take you to web pages that describe the listserv and provide
instructions for subscribing. Remember, however, not all listservs are open to the public, some
are private and require administrative approval. Creating your own listserv is not always easy
although definitely doable. The best thing to do is work with your school's technology people to
see if they can do it for you. Or, you can use a free online mail list service such as
http://www.coollist.com. Otherwise, read up on how to do this yourself by visiting web pages
such as http://www.librarysupportstaff.com/4creategroup.html and
http://lists.gurus.com/creating.html. 

TIPS AND TRICKS

Microsoft Excel™: Transposing Data
This trick will help you switch data from columns to rows and vice versa.

1. Highlight the data to be switched.
2. Now copy the data. (CTRL-C or Edit, then Copy)
3. Select the cell where the data should begin.
4. Go to the Edit menu and choose Paste Special. 
5. At the bottom of the Paste Special window, you're looking for the option to

Transpose the data.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Automatically Wrapping Text in a Cell 
1. Type the following text into a cell: "This is the best Excel Tip book".
2. Press Ctrl+1, and select the Alignment tab.

http://www.greatcircle.com/majordomo/
http://www.lsoft.com
http://www.coollist.com
http://www.librarysupportstaff.com/4creategroup.html
http://lists.gurus.com/creating.html
http://www.schoolcounselor.com
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3. Select the Wrap text checkbox.
4. Click OK. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Extend Selection Mode
Extend Selection mode allows you to select text by clicking the mouse or pressing navigation
keys. When this mode is active, the letters "EXT" appear on the status bar. To cancel Extend
Selection mode, press ESC, and then click anywhere in your document.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Moving to the Bottom of a Column
Quickly move from the top to the bottom of a long column of data by doing the following:
Select a cell (any cell) in the column, hold down the CTRL key and press the down arrow. In an
instant, you'll be at the bottom of the data in that column, even if it is 20,000 rows long. Just in
case you are wondering ... CTRL+Up Arrow will bring you back to the top of your data and the
left and right arrow keys work the same way. Also, here is a bonus tip ... If you want to select
all of the cells of data from top to bottom in a column, go to the top cell, then hold down the
Shift key while you do the same shortcut. So that's CTRL + SHIFT + Down Arrow. The Up, Left
and Right arrow keys work the same way.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Save All Your Word Documents at Once
Hold down SHIFT and click the File menu. When you hold down SHIFT, two new options
appear on the file menu: Close All and Save All. To save all your open documents at once, click
Save All. Or, to close all your open documents, click Close All; Word will prompt you to save
your changes before closing any documents. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Centering a page vertically
Centering a page horizontally is a very easy thing to do. However, sometimes you may wish to
center your text vertically on the page (not a common practice). To do this, simply click on the
file menu and select page setup. Then click on the layout tab, and there will be a drop-down
menu with the caption “vertical alignment”. Select center (or whatever you would like) from the
menu and click on ok.

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Microsoft Word™: Select Columns of Text in Word
To select a vertical block of text in Word, such as a column of numbers, press and hold down
ALT, and then drag your mouse over the text. Then, you can delete it or copy it into another
file. (You cannot use this in tables)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Find Your Place in Word Documents
If you are working on a long document, it's easy to lose your place. With Microsoft Word™
documents, you can pick up where you left off in your last editing session because Word keeps
track of the last three locations where you typed or edited text. Just press SHIFT+F5
immediately after opening the document, and the cursor will appear at the exact point where
you last made a change. To reach the previous two editing locations, press SHIFT+F5 until you
reach the location you want. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™:  Finding synonyms on the fly
Find that word you're looking for fast. You can find a common synonym for a word without
using the Thesaurus command. Just right-click the word and point to Synonyms on the shortcut
menu. Then, click the synonym you want, and it automatically appears in place of your original
word. Word will sometimes even supply antonyms for the selected word, for those times when
you only know what you don't mean to say. 

WORTHY WEBSITES AND SOFTWARE

Microsoft Templates: CD/DVD and Video Labels
http://office.microsoft.com/en-us/templates/CT063477751033.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Link200
Link200 will determine the validity of bookmarks or favorites in Firefox, Internet Explorer, and
Netscape. Link200 is an easy to use step-through wizard that guides you through the entire
process. No longer do you have to worry about going to a favorite or bookmark only to find out
the site is no longer valid. Link200 will handle the checking and cleaning. Users can
automatically delete the bad websites using Link200's clean option or you can specify which
ones you would like to remove on a per website basis. This is “donationware (suggested $10).” 
http://www.veign.com/download_app.asp?app=103 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://office.microsoft.com/en-us/templates/CT063477751033.aspx
http://www.veign.com/download_app.asp?app=103
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WaxMail 
WaxMail is a free voice e-mail service for Outlook (and Outlook Express). WaxMail requires a
small download and a quick installation with Outlook. From there, all you have to do is click a
button to record a voicemail. The sound file is saved as an MP3 and is attached to the e-mail,
which can also include text and other attachments. WaxMail is free, although there is a small
text advertisement added to the e-mail. For those wishing to exclude the add, WaxMail charges
a $29.95 one time fee.
http://www.waxmail.biz/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Evaluation Exchange
Harvard Family Research Project's evaluation periodical, The Evaluation Exchange, addresses
current issues facing program evaluators of all levels, with articles written by the most
prominent evaluators in the field. Designed as an ongoing discussion among evaluators,
program practitioners, funders, and policymakers, The Evaluation Exchange highlights
innovative methods and approaches to evaluation, emerging trends in evaluation practice, and
practical applications of evaluation theory. It goes out to its subscribers free of charge four
times per year. Subscribe now for free.
http://www.gse.harvard.edu/hfrp/eval.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

STAR Legacy Modules
Research has shown that effective instruction often begins with an engaging challenge or
scenario that introduces the lesson and invites student inquiry. The combination of a challenge,
interactive activities, and multiple opportunities for sharing, assessment, and revision is called a
STAR Legacy module, a design for learning developed at Vanderbilt University. Utilizing web
and CD technology, modules may cover content to be explored during one class period, as with
IRIS, or over several. All IRIS materials are freely available for use via the website and may be
printed without permission. 
http://iris.peabody.vanderbilt.edu/onlinemodules.html

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Internet Explorer: Saving and Sending Web Pages
Sometimes it’s just convenient to e-mail someone a link to a web page. Other times, however,
it is nice to send them a copy of the entire web page for their convenience. Have you
considered saving as an MHT file (Web archive - single file)? The advantage of doing this is that
MHTML enables you to send and receive Web pages and other HTML documents using e-mail
programs such as Microsoft Outlook, and Microsoft Outlook Express; or even your custom e-

http://www.waxmail.biz/
http://www.gse.harvard.edu/hfrp/eval.html
http://iris.peabody.vanderbilt.edu/onlinemodules.html
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mail sending solutions. MHTML enables you to embed images directly into the body of your
e-mail messages rather than attaching them to the message. To save a web page as an MHT
file:

1. Click on file, then Save As
2. Accept or rename the file name.
3. In the file type section right below, choose Web Archive, Single File.

You can e-mail this file as an attachment. The recipient can then open it on their end with
Internet Explorer. The Firefox browser can open these type files with a bit of help (see here). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Study Smart with these Sites
Lists of useful websites for students.  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Technology Safety and Security Among Children: What Caretakers Need to Know
I am presenting to parents/families much more frequently these days about the dangers of
technology among children (and what they can do about it).  I would like to share my handout
with you which is now available online.
http://coe.fgcu.edu/faculty/sabella/safety.pdf 

P.S. I’m developing more resources and tools as I have time which I will continue sharing with
you.  

____________________________________________

JUST FOR FUN

MySpace.com: The Movie
Web parody of social site launches young film maker's career.
http://www.youtube.com/watch?v=oJ_dam5DmsM 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

You Tube
Video is proliferating like crazy on the Internet. There are a number of sites that host video
clips. And search sites will help you find them. I like to browse the videos. And You Tube is a
great place to find them. Most are fairly short, so you’ll have time to watch quite a few. The

http://labnol.blogspot.com/2006/01/display-microsoft-mht-files-in-firefox.html
http://adjunct.diodon349.com/Vets_Stuff/study_smart_with_these_sites.htm
http://convert.neevia.com/
http://coe.fgcu.edu/faculty/sabella/safety.pdf
http://www.youtube.com/watch?v=oJ_dam5DmsM


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 97

videos are posted by people like you and me. Some are funny, others are mundane. And yet
others were made by aspiring film makers.
http://www.youtube.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

I'm Telling you for the Last Time - Jerry Seinfeld.  After the end of his successful TV
show Seinfeld, Jerry did his one last stand-up comedy and said goodbye for ever..Now he only
performs in small clubs, and started fresh, this was his last official big show..A must watch 
http://video.google.com/videoplay?docid=5376500300074523363 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Tennis Anyone?
The premise of the Tennis challenge is simple. You have to keep the tennis ball in the air as
long as possible. Click it with your mouse to stop it from landing on the court.
http://tinyurl.com/a3pe8 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Retro Coolness
Are you ready for a trip down memory lane? 
http://www.ephemeranow.com/ 

____________________________________________

SchoolCounselor.com 2.0: A Friendly and Practical Guide to the World Wide Web 
by Russell A. Sabella, Ph.D.
The Internet gives counselors a vast amount of resources and a powerful medium for
connecting with others. Following a counselor-friendly introduction to computers and the
World Wide Web, readers are introduced to over 1,200 web sites and given a practical guide
to gaining access, navigating, searching for relevant materials, and creating websites.
Related issues of interest to both novice and experienced users are discussed.
ISBN 1-930572-24-7 
8-1/2 x 11, 240 pages, soft bound 

http://www.youtube.com/
http://video.google.com/videoplay?docid=5376500300074523363
http://www.mcsaatchi.webcentral.com.au/tennischallenge/optus_tennis_site_edited.html
http://tinyurl.com/a3pe8
http://www.ephemeranow.com/
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=SCC2
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SchoolCounselor.com eNewsletter #57 - March 28, 2006 

Asking if computers can think is like asking if submarines can swim. –
Anonymous

The Internet is the world's largest library.  It's just that all the books are
on the floor.  ~John Allen Paulos
____________________________________________

Highlights from SchoolCounselor.com

Technology Safety and Security Among Children: What Caretakers Need to Know
I am presenting to parents/families much more frequently these days about the dangers of
technology among children (and what they can do about it). I would like to share my handout
with you which is now available online.  Please share or use it as you see appropriate. 
http://www.schoolcounselor.com/macomb/ 

P.S. I’m developing more resources and tools as I have time which I will continue sharing with
you. 

Technology Training (and more) for Counselors
Download a booklet with comprehensive descriptions of technology training and resources for
counselors (PDF; 116KB).
http://www.schoolcounselor.com/pdf/booklet.pdf 

Counselor Best-Selling Posters Updated
http://www.schoolcounselor.com/poster-best-sellers.asp 

____________________________________________

A Valuable School Counseling Website 
Excerpted From

SchoolCounselor.com 2.0: A Friendly and Practical Guide to the World Wide Web 

Although creating a guidance and counseling website can be fun and intrinsically
rewarding, most webauthors would like to know that their sites are useful to others in some
way. School counselors would probably like to know that their website assists them in reaching
their guidance and counseling goals and advancing the program mission. So how can
counselors help others to make use of their site? Several tips follow:

http://coe.fgcu.edu/faculty/sabella/safety.pdf
http://www.schoolcounselor.com/macomb/
http://tinyurl.com/dgfjd
http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.schoolcounselor.com/poster-best-sellers.asp
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=SCC2
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1. Make your site valuable. If the information is useful and valuable,
people will stream to your site to get it. If it is information they need
and want, and if it is not available elsewhere, you can be assured that
your intended audience will be connecting regularly. On the other
hand, if there is nothing on the site that is not already published
somewhere else, or if the information is old, or if it is information that
no one really needs, then you cannot expect to see many visitors.

2. Make your site timely. One reason to use the Internet rather than the
printed handbook is the ability to reflect last-minute changes. For most
schools, daily or weekly updates of information will allow the website
to provide things that are available nowhere else. Regular changes will
keep people coming back. Reasonably frequent updates make a site
much more useful to its audience.

3. Make your site user-friendly. If the material on the site is easy to find
and easy to read, it will be used more. A clear writing style allows
people to read quickly and to find the ideas they need. Accurate labels
and titles and subheadings also make it easier for the user to find
content for which he or she is looking. Do not be afraid to divide an
article into short sections with subheadings.

4. Help teachers to be involved. If teachers have been involved from the
beginning in the planning and development of the site, then you are on
the right track. Teachers are key to utilization of the school’s Website.
Teachers will provide new material to keep the site updated; they will
tell their students to connect to the site, and these students will tell
their parents. The more you can involve teachers in the authoring of
the various sections of the Website, the more likely you are to find
your site well used. If your teachers are not familiar with the World
Wide Web, then provide a short in-service training program. You can
also arrange a training program of your own, perhaps calling on the
school librarian or technology coordinator, who are often well-versed
in using the Internet.

5. Help students to be involved. Many schools find that students are the
chief users of the school Website. Students have a big stake in their
school. They are familiar with the new technologies, and they love to
see their own works published on the Web. The more you call on
students to develop and update different parts of your site, the more
they will encourage use of the Website among their friends. You may
find, as many schools have, that students are quite willing and
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prepared to locate and type the daily and weekly updates of
information that are essential to a well-used site. Also, to get students
using the site early on, consider a contest of some sort. Provide clues
on your site that change each day; students who collect all the clues
might win a school sweatshirt or other valuable prize. You might also
conduct training sessions in the computer lab or library, to show
students how to connect to the school Website, and how to find the
information that is valuable for them.

6. Help parents and the community to be involved. Use every means
possible to let the parents and community know your site is up and
ready. Send notices home with students. Conduct a “School Counseling
Web Night” at school, with hands-on introduction to the Internet for
parents and community. Put a notice in the school newspaper and in
the local paper. Recruit a parent volunteer to post a notice of the site
in all the large workplaces in the community. Better yet, involve
parents in authoring parts of your site, perhaps a parenting support
section. You might also consider an informational evening for parents,
in cooperation with local Internet Service Providers. Show people how
easy it is to connect to the Internet from home, give them advice on
getting connected, and answer their questions on what they would
need at home to become part of the “information infrastructure.”

7. Help everyone remember your site. Take every opportunity to let
people know that you have a Website. Include your site’s URL on your
school stationery and on your business card. Include it in the school
newspaper and at the bottom of all relevant announcements that go
from school to home. Post it in the front hall, and on the sign in front
of the school. Make a big banner of the URL, and hang it at basketball
and football games. This will let everyone in the school community
know that the school counselor is publishing on the Web.

A counseling website can assist you in interacting with your students and other
stakeholders, post valuable and timely information, and increase your program’s presence
throughout the school and community. Web authoring software has made the task much easier
and more fun. Like everything else, you will want to regulate your time, especially limiting
yourself to those parts of web authoring which you believe truly augment your efficiency and
effectiveness. The interactions with others, especially students, as part of your website
development should also serve to build healthy and productive working relationships. Stay
focused on your web authoring purpose and prepare to be excited by the possibilities.
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Several cool school counseling websites:

• http://cyberguidance.net/
• B.F. Yancey''s Counseling & Guidance Program- Esmont, Virginia
• Cibola High School
• Guidance Department, Los Gatos High School
• Lee County Schools Guidance Services
• Lunt Elementary School Counseling Website
• Sequoia Middle School- Ms. Jarman-Dunn, School Counselor

____________________________________________

TIPS AND TRICKS

Mouse Wheel Tips
If you have a mouse with a scroll wheel on it, you should know about some neat shortcuts.
First, hold down the Shift key on a Web page and spin the wheel on your mouse. Internet
Explorer goes either backward or forward through he pages you've recently visited, depending
on which direction you spin. Try it ... open Internet Explorer and follow a few links. Then, hold
down your Shift key and start spinning that wheel. Second, if you are most Windows
applications (e.g., Word, IE, PowerPoint, etc.), hold down your Ctrl key and spin your mouse
wheel. It makes the text larger or smaller depending on which way you spin. For Opera users,
it magnifies both the images and the text. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Tips and Tricks
http://www.ellenfinkelstein.com/powerpoint_tip.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Working with your Video Clips in Windows Movie Maker 2
You've shot hours of footage with your digital video camera. You've captured this footage on
your computer and maybe you've even edited a few movies. Now what? Read on to find out
how to organize your collections and clips in Microsoft Windows Movie Maker.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Outlook
Free online course: Know the basic types of Outlook Calendar entries, book activities into your
calendar efficiently, and stay on top of important dates with more advanced features such as
recurrence and reminders.

http://cyberguidance.net/
http://schoolcenter.k12albemarle.org/education/staff/staff.php?sectiondetailid=4082
http://www.cibolacougars.com/~chscounsel/
http://www.lghs.net/guid/index.asp
http://www.leeschools.net/dept/stusvc/Counseling_Services/materials.html
http://www.falmouthschools.org/k2counseling/
http://fusd.tv/sites/middle/jarmna/IndexMain.html
http://www.ellenfinkelstein.com/powerpoint_tip.html
http://www.microsoft.com/windowsxp/using/moviemaker/getstarted/collections.mspx
http://office.microsoft.com/training/training.aspx?AssetID=RC011719291033
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Setting the Enter Key Direction

In Microsoft Excel™, you can specify which direction the cursor moves when you press the
Enter key. You can have the cursor move up, down, left, right, or not at all. You will now make
sure the cursor is set to move down when you press the Enter key.

1. Choose Tools > Options  from the menu. The Options dialog box opens. 
2. Choose the Edit tab. 
3. Make sure there is a check mark in the "Move Selection after Enter" box. 
4. If Down is not selected, click to open the Direction drop-down box. Click

Down. 
5. Click OK. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Quickly Entering Dates and Times
If you are looking for a quick way to enter the current date or time into a cell, Excel provides
an excellent shortcut. To enter the current date, just select a cell and press Ctrl+; (that's the
semicolon). Closely akin to that is entering the time, which is done by using Ctrl+: (that's the
colon). These shortcuts work even when you are entering formulas. For instance, let's say you
wanted to have today's date as a string (within quote marks) in a formula. All you need to do is
enter your formula, up to the first quote mark. Then type Ctrl+; and the date appears in the
formula. Type your closing quote mark, and you can continue with your formula.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: How do I tell the Office Assistant to go away? 
1. Click on the Office Assistant, then click on Options. 
2. Clear the Use Office Assistant check box. 
3. You can also customize the behavior of the Office Assistant by checking or

clearing the checkboxes on the Options tab. If you want to learn how to
customize the Office Assistant, but it's not currently visible, choose Show the
Office Assistant from the Help menu.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™ 2003: Add a Table of Contents
Here's a step-by-step process on adding a table of contents (TOC) to your Microsoft Word™
2003 document. 
http://malektips.com/word_2003_0002.html 

http://malektips.com/word_2003_0002.html
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WORTHY WEBSITES AND SOFTWARE

GetHuman.com
The goal of this service is to improve the quality of customer service and phone support in the
US. This free website is run by volunteers and is powered by over one million consumers who
demand high quality phone support from the companies that they use. 
http://www.gethuman.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Templates for Meetings
This site has neat templates for meeting agendas, minutes, and even timers.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Kids Certificates and other Templates (free)
http://www.kidscerts.com/free.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Blogging 101
Over the past few years, "blogs" have taken over where personal Web sites left off. Once the
domain of journalists, commentators, politicians, and savvy University students, blogs are now
used by people from all walks of life and of all ages. It has been said that there are now
millions of blogs on the Web. Bloggings rise in popularity has been nothing short of
phenomenal. Blogs are used as online diaries, soapboxes, political commentaries, to report
breaking news, to share the latest family events with those we love, or just to talk to the world
at large.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™
If you are looking for information on Microsoft Excel™, our Microsoft Excel™ tutorial will
provide the help you need to develop your Microsoft Excel™ skills. It covers entering data,
formatting, cell alignment, fonts, mathematical calculations, functions, and much more.
http://www.baycongroup.com/excel_2003/excel_04.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Evaluating Software (written for counselors)
http://www.schoolcounselor.com/pubs/software.pdf 

http://www.gethuman.com/
http://office.microsoft.com/en-us/results.aspx?Scope=TC&Query=agenda+minutes
http://www.kidscerts.com/free.php
http://www.microsoft.com/windows/ie/community/columns/blogging.mspx
http://www.baycongroup.com/excel_2003/excel_04.htm
http://www.schoolcounselor.com/pubs/software.pdf
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Welcome to cyberbullying.us - a central repository and information clearinghouse for the
phenomenon of cyberbullying. To note, cyberbullying is also called "cyber bullying," "electronic
bullying," "e-bullying," "sms bullying," "mobile bullying," "online bullying," "digital bullying," or
"Internet bullying." Here we will make available the latest news and headlines, and provide
research findings, press releases, reports, and a number of useful resources and materials to
assist those in positions that directly or indirectly deal with this problem. 
http://www.cyberbullying.us/ 

____________________________________________

JUST FOR FUN

Sudoku from Newsweek
Three Sudoku puzzles are available every day. (1) The normal 9x9  puzzle we all know and
love; (2) A smaller 6x6 mini puzzle.  This is a great place to start if you've never played Sudoku
before; (3) A massive 16x16 puzzle that uses both numbers and letters.  If you are addicted to
Sudoku, or if you have never played it and want to see what everyone is talking about, hop on
over to Newsweek's free Sudoku page and watch the hours slowly disappear from your life.
http://www.uclick.com/client/nwk/nwdoc/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

School Counselor in the Trenches
A school counselor’s blog: This is my third year as a school counselor in a middle school. I am a
peon in the trenches, trying to make a difference in the lives of kids. The stories are real, the
people are survivors in their own right and the feelings can be raw. Their stories need to be
told.
http://schoolcounselorinthetrenches.blogspot.com/ 

Click here to see other blogs (from blogger.com) that mention the term “guidance counselor.”

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Test-drive Your Dream Job.™
Let's face it, most of us spend the majority of our waking moments at work -- and yet few of us
are actually doing work that we're passionate about. But who says it has to be that way? 
http://www.vocationvacations.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.cyberbullying.us/
http://www.uclick.com/client/nwk/nwdoc/
http://schoolcounselorinthetrenches.blogspot.com/
http://search.blogger.com/?q=guidance+counselor&hl=en&ie=UTF-8&ui=blg
http://www.vocationvacations.com/
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National Archives films on Google Video
Over 70 years ago, the National Archives was founded to preserve American historical
documents, as well as the moments and events that could be saved in still photos, films, and
audio recordings. Today the Archives is home to everything from rare historical footage
(newsreels and government documentaries from the 1930s) to the 1969 moon landing. Now
Google is launching a pilot program to digitize its video content and offer it to everyone in the
world for free, and you can watch a growing selection on Google Video.
http://video.google.com/nara.html 
____________________________________________

http://video.google.com/nara.html
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SchoolCounselor.com eNewsletter #58 - April 11, 2006

If you don't know how to do something, you don't know how to do it with
a computer.

If a program is useless, it will have to be documented.  - Laws of
Computer Programming, IV

Online Career Journey 

Probably one of the most extensive uses of computers in
counseling so far has been in the area of career development where there
is a need to process a great deal of information. Information includes knowledge about various
careers, the career decision-making process, and an assortment of clients' personal and
professional characteristics. Computers do a splendid job of compiling and sorting data to help
individuals select the best fit among workplace environments, required aptitudes, interests,
values, and other human qualities. The Internet in particular has made various interactive tools
available which can assist counselors in obtaining up-to-date information, communicating with
one or more others, and even developing advanced competencies in areas of weakness.
Interactive tools can include search engines, online databases, personal websites, e-mail,
instant messaging, wizards, and videoconferencing. As an example, the authors provided the
following self-guided career development webquest for school counselors:

Your fantasy takes place in cyberspace where you begin by perusing the online Career
Development Manual from the University of Waterloo's Career Services
(http://www.cdm.uwaterloo.ca/). Here, you review important information and links addressing
each step of the career development process, from self-analysis to life planning.

     While continuing to close your eyes and taking deep breaths, you then think about the
beginning questions for your career search ... Do I have what it takes to be successful and
happy in school counseling or another field? What exactly are my current or renewed career
goals? What kinds of tasks get me really motivated and excited? What skills do I have that will
help me to effectively fulfill my various needs? To answer these Self-knowledge Questions, you
need to learn more about yourself. So, you beam yourself over to the Job Hunters Bible website
(http://www.JobHuntersBible.com). This site is developed by the author of What Color is Your
Parachute?, Richard Bolles, and comes with a "Free Online Tests Dealing With Careers" section,
a brief review of test taking procedures called "The Seven Rules About Taking Career Tests,"
links to John Holland's SDS (Self-Directed Search), The Career Interests Game, and The Career
Key. Other sections of the site include links to help you create and post your resume; salary

http://www.cdm.uwaterloo.ca/
http://www.JobHuntersBible.com
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information for a specific job; and a search engine for contacts. After you engage this site, you
recognize that it could be the focus of an entire classroom guidance unit for your students!

     Now you transport yourself to your next stop – Franklin Covey's Create a Personal Mission
Statement site (http://www.franklincovey.com/missionbuilder/). This fun and enlightening
exercise helps you to create your own personal mission statement by first defining your values,
principles, and what matters most to you in your life. At the speed of thought, you then go to
http://www.keirsey.com to take the Keirsey Temperament Sorter. The results of this free online
questionnaire are similar to the Myers-Briggs Type Indicator® (MBTI). Your results inspire you
to know more and so you quickly click over to http://www.typelogic.com to read the details
about your profile. You are intrigued by the insights you gain about yourself and notice that
your curiosity only elevates. Click ... Whiz .. Whoosh ... you're now off to Queendom
(http://www.queendom.com), a site that offers a variety of personality, intelligence and
health-related tests, trivia quizzes, and much more. Although the tests are for entertainment
purposes, they provide you with much food for thought. You notice the joy and sense of peace
that comes with advanced self-understanding.

      Now consider the personal profile information you have just gathered as a career criteria
list against which to apply Information about the World of Work. Your first stop is the U.S.
Department of Labor's Bureau of Labor Statistics' Occupational Outlook Handbook
(http://www.bls.gov/oco), one of the best resources of general occupational information. Its
web version, like its printed predecessor, is revised every two years and describes what workers
do on the job, working conditions, the training and education needed, earnings, and expected
job prospects in a wide range of occupations. You hear your mind buzzing with potential. You
jump over to O*NET™ OnLine! (http://online.onetcenter.org/), a database that includes
information on skills, abilities, knowledge, work activities, and interests associated with
occupations. You realize that you've hit the jackpot with this massive supply of information
which is composed largely from data supplied by occupational analysts using sources such as
the Dictionary of Occupational Titles (DOT). 

     You are ready to continue. You open the next virtual door which takes you to ACT™'s World
of Work Map (http://www.act.org/wwm). According to the site, the map "organizes occupations
into six clusters (parallel to John Holland's six occupational types), 12 regions, and 26 career
areas (groups of similar jobs). It shows you how occupations relate to each other according to
primary work tasks." You take the map with you to further help you navigate the world of work.
A career path that you never before imagined – theatrical design – becomes apparent as one
that can potentially meet your interests and values. You need to find a search tool that can help
you locate a post-baccalaureate certificate program in this area. You find just the thing at
http://www.gradschools.com and proceed to investigate.

     Your personal mission and search has lead you to the conclusion that you wish to remain a
school counselor but you might consider changing school districts or geographic locations. You

http://www.franklincovey.com/missionbuilder/
http://www.keirsey.com
http://www.typelogic.com
http://www.queendom.com
http://www.bls.gov/oco
http://online.onetcenter.org/
http://www.act.org/wwm
http://www.gradschools.com
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are now at the point of conducting a Job Search. To begin, you update your resume at
JobStar's Resume Center (http://jobstar.org/tools/resume/) by first reviewing resume style and
function tips. You check out examples of chronological and functional resumes. You also notice
that this site has links to help you learn how to post your resume electronically. Before posting
your resume, however, you "snap" yourself over to The CareerLab Cover Letter Library
(http://www.careerlab.com/letters/) to see samples of cover letters designed to communicate
different messages ranging from "Answering Want-ads Like a Pro" to "Saying Thank You with
Class." Oh, and one other thing, you will need an updated business card for interviews so you
click over to VistaPrint (http://www.vistaprint.com/) where, for a small shipping and handling
fee, you design and order your own custom business cards. 

     With a quality resume ready to be printed and electronically posted, you are ready to "hit
the virtual pavement." First, you head over to Monster.com (http://www.monster.com) to
search over one million posted jobs by location, job category, and/or keyword. At Monster.com
you can post your resume and create/manage a personal career account. Similarly, you also
venture over to http://www.hotjobs.com, http://www.careerbuilder.com, http://www.ajb.org,
http://www.nationjob.com, and http://www.jobtrak.com  to do the same.

     As you locate potential positions, you begin to conjure up questions about each respective
school district and the community in which you might relocate. And you remember that the URL
or website address for most school districts' follow a formula, http://www.xxx.k12.yy.us where
xxx is the name of the district and yy is the two letter acronym for the state. For example, the
Lee County School Board's website in Florida is located at http://www.lee.k12.fl.us. And, if this
happens to be unproductive, you are sure to learn more about any school and its district by
consulting National Center for Educational Statistic's National School Locator
(http://nces.ed.gov/ccdweb/school/school.asp) to learn about other characteristics and
demographics about your schools of interest. Finally, your research would not be complete
without visiting the Homestore website once again
(http://www.homestore.com/Move/Tools/Closeup.asp) where you create a free report which
provides extensive comparisons between where you currently live and where you may move.
Comparisons include community demographics, housing, crime, climate, travel to work, and
more.

     You continue to be relaxed and confident. You are pleased with your career journey as of
yet because you have identified several new schools that could provide you with a welcomed
change. Your journey continues over several days as you persistently pursue new knowledge
about yourself, about the world of school counseling, and about available jobs in the field. After
only three weeks, you receive a job offer from your first choice of possibilities. The job is yours,
if you want it and you need to decide if it is worth making the move. You need to evaluate The
Job Offer. As is typical, the first question on your mind is, "Is my new salary truly better than
my current salary?" Although salary is only one part of a total benefits package, it is quite an
important one for many people. You decide to conduct a comparative analysis of salaries which

http://jobstar.org/tools/resume/
http://www.careerlab.com/letters/
http://www.vistaprint.com/
http://www.monster.com
http://www.hotjobs.com
http://www.careerbuilder.com
http://www.ajb.org
http://www.nationjob.com
http://www.jobtrak.com
http://www.lee.k12.fl.us
http://nces.ed.gov/ccdweb/school/school.asp
http://www.homestore.com/Move/Tools/Closeup.asp
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take into consideration cost of living for given locales at http://www.salary.com and
www.homefair.com/homefair/calc/salcalc.html. After determining that the salary is acceptable,
and before accepting the job, you consult with the U.S. Department of Labor's tips for
evaluating a job offer at http://www.bls.gov/oco/oco20046.htm. You also complete a
worksheet at the University of Virginia's Career Center
(http://www.career.virginia.edu/students/resources/handouts/evaluating_offer.pdf/) which is
designed to help you weigh important factors of a job offer (Also see other handouts at
http://www.career.virginia.edu/students/resources/handouts/).

     You accept the offer and are now ready for The Move. Most people would agree that
relocating is difficult at best. In your imagination, you envision a wizard that can provide a
financial calculator, property locator, and look up mortgage rates and property values in real
time, for instance. Poof! You are taken to http://www.realtor.com and
http://www.homegain.com where these and more are available. 

     As you arrive to your final cyberspace career development destination, you sigh with relief
as you check the remaining few items on your list of things to do. All that is left now is to
download a new eBook and a few easy listening music files, both of which you will enjoy as you
ride as a passenger in the moving truck – the truck that you happen to have reserved online
during a pit stop.

CounselingData.com was created by Dr. Madelyn Isaacs in January 2006 as a website
dedicated to facilitating data-driven decision making and accountability work among
educators and helping professionals. Here, you will find valuable resources, training
opportunities, links, and other tools. Dr. Isaacs consults with organizations, school districts,
and individual schools across several data and accountability related areas. You can also
subscribe to the CounselingData.com eNewsletter, a monthly publication distributed for free.
The newsletter contains practical and useful information, valuable links, tutorials, and other
resources about the topic of data-driven decision making and accountability. 
www.CounselingData.com 

http://www.salary.com
http://www.bls.gov/oco/oco20046.htm
http://www.career.virginia.edu/students/resources/handouts/evaluating_offer.pdf
http://www.career.virginia.edu/students/resources/handouts
http://www.realtor.com
http://www.homegain.com
http://www.schoolcounselor.com/pubs/career%20counseling%20and%20technology.pdf
http://www.schoolcounselor.com
http://www.CounselingData.com
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TIPS AND TRICKS

From www.Worldstart.com.

Q: What is the difference between all the drives we use on our computers?

A:

1. Hard Drive - A hard drive is a fast, high capacity internal disk drive found in all modern PCs.
Unless the computer is older than say, 12 years, it should have a hard drive in it. Any PC
running Windows does.

The reason for having a hard drive is to give you a permanent place to keep your computer's
information. They are generally much more reliable than keeping your data on a floppy disk
(that's not to say you shouldn't back up your info though), they are much faster and hold tons
more information.

Adding a second hard drive is a great way to add more space for files. They are available as
both internal or external.

2. Floppy Drive - These little 3.5" disks hold about 1.4 MB of information. It seems like just
yesterday that floppy disks ruled the planet, but now with the cheap price of CD and CD-R
drives, the floppy drive is being put to pasture. Most new computers don't even have one.

3. Zip Drive - A zip drive is basically a floppy drive on steroids. The disks work in the same
manner as a regular 3.5" floppy disk, except they can store up to 100 MB. A 3.5 floppy can only
store 1.4.

In case you're wondering, no, you can't stick a zip disk into your 3.5" floppy drive and expect it
to work. In fact, you would have to insert it with the assistance of a hammer. If you wanna use
zip disks, you'll need a zip drive.

Oh, and a zip drive should not be confused with zip files!

4. CD-R - A CD-R is a writable CD, meaning you can record data to the CD. Works just like a
regular CD ROM drive otherwise. Although you can add data to a CD-R, you can't delete data
from it. Once it's there, it's there. Most CDs hold 675 meg of info.

5. CD-RW - Same as a CD-R, except you can rewrite the CD. So, you can remove old files and
add new ones if you like. The only disadvantage to this one over the CD-R is the disks are
generally more expensive.

http://www.Worldstart.com
http://www.worldstart.com/tips/tips.php/585
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5. DVD-R/+R - As DVD recording comes of age and the prices come down, more of us will likely
be adding DVD writers to our computers. If you are adding a DVD writer to your computer, I
would suggest getting one that writes to both DVD+R and DVD-R disks. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Windows: Select continuous or noncontinuous files

Did you know that you can select multiple files at once to open or delete them or perform other
tasks?

To select continuous files (files that are next to each other in a list):

1. Click the first file that you want to select, then press and hold the Shift key.
2. Move your pointer to the last file that you want to select and scroll over it (or single-click)
with your mouse, and all files in between are automatically selected.

To select noncontinuous files (files that are not next to each another in a list):

1. Press and hold the Ctrl key.
2. Point to (or single-click) each file that you want to select.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Computer Maintenance: Put your PC maintenance routine on autopilot
Set up an automated PC maintenance schedule to keep your computer working its best. Learn
to automate the weekly cleaning of your hard disk, rearrange fragmented files monthly, and
check your hard disk weekly for errors.
http://www.microsoft.com/athome/moredone/maintenance.mspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

 Organize your PC files in five easy steps
Whether today's offices are truly paperless or not, one thing is certain: Unless you have a plan
for organizing, filing, and finding your documents, your PC hard drive can become as cluttered
as a paper-covered desk. Let a Work Essentials productivity pro show you how to dig out from
under your electronic files.
http://office.microsoft.com/en-us/FX012057681033.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.microsoft.com/athome/moredone/maintenance.mspx
http://office.microsoft.com/en-us/FX012057681033.aspx
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Microsoft PowerPoint Presentation tips
Source: http://www.123ppt.com/forum/topic/50.htm (Jonathan Stock, Presentation Consultant)

1. Above all else….KISS: The old "Keep it simple stupid". Keeping things simple
does not mean producing a presentation aimed for fifth graders. It means
that slides within your slide show should be brief. Statements should be
clear. Points should sum up any communications messages you are trying to
express. You can always elaborate your points in dialogue, but on screen, on
slides, they should be simple, brief, and to the point. This is a good way to
stop you from reading your slides to the audience. There is nothing worse
than a presenter who simply stands there reading their slides to their
audience.  Most audience members are literate and can read for themselves.
If you only read what is written why should you stand before them? What are
you presenting in actual fact? A reading class?

2. Wherever possible, use graphics and pictures to illustrate your point. This
helps people to understand what you are saying and removes any possible
misinterpretations.

3. Try to never use more than 3 bullets per slide. 

4. Practice makes perfect! Practice by yourself, then practice in front of your
spouse, partner, or friend, and get their feedback.

5. Break things down. Instead of explaining complex methods, or concepts try
to depict it as a story. People can relate to stories. Stories are much easier to
accept and understand, and that is the goal of your presentation.
Understanding.

6. End as you begin. Your introduction slide should give a brief overview of the
whole presentation. Your summary slide should then repeat in brief what you
have tried to explain as you come "full circle".

7. Your audience is watching! Try to make your font size at least 24 point. It
may look good on your computer, but people have to read it from the back
row of the conference hall or auditorium and 12 point Times New Roman will
be nothing more than a blur.

8. Keep contrasts and keep distinction.  Use contrasting colors for your text and
background, for example, a dark blue background with white text. Our
creative department create background slides that provide strong contrast
for presenters, but I have seen a lot of online PowerPoint template producers

http://www.123ppt.com/forum/topic/50.htm
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who call themselves "professional" designers who really don't know the first
thing about communication and the legibility of text upon their backgrounds
almost impossible for an audience to decipher.

9. Consistency is the key. Try to use the same colors for headline, body text,
quotes etc., throughout the presentation. If you use blue for a quote on the
first slide and then green for a quote on the tenth slide how will your
audience know it is a quote? Communicate consistency.

10. And finally, but as equally as important, know your audience. Your audience
can be a specific "mix" of people, for example, some may only want data and
facts. Others may want fancy animation and a "show". Know your audience,
and you can produce your presentation to please your audience as well as
achieve your communication goals!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

10 Things You Can Do to Optimize and Maintain Your PCs
Keeping PCs running at their best and extending the life of the equipment requires some
diligent upkeep. This list of tasks will help you cover your maintenance bases. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Search Tips Poster
http://www.google.com/librariancenter/downloads/Tips_Tricks_85x11.pdf  

WORTHY WEBSITES AND SOFTWARE

Microsoft Windows Movie Maker 2: Download documentation and code samples for
creating custom effects and transitions

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Technology Safety and Security Among Children: What Caretakers Need to Know 

I am presenting to parents/families much more frequently these days about the dangers of
technology among children (and what they can do about it). I would like to share my handout
with you which is now available online. Please share or use it as you see appropriate. 

http://www.schoolcounselor.com/macomb/index.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://techrepublic.com.com/5100-10877_11-6059366.html?tag=html.alert
http://www.google.com/librariancenter/downloads/Tips_Tricks_85x11.pdf
http://www.microsoft.com/downloads/details.aspx?FamilyID=6DA22934-8BD4-4875-B68E-A9723476B6B5&displaylang=en
http://www.schoolcounselor.com/macomb/index.htm
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Develop a Website for Free:  Looking for a fast and easy way to create a free website,
online photo album, online journal, and more? Freewebs has spent the past 4 years developing
the easiest and most powerful free website publishing system on the net. Now, building your
website is as easy as using e-mail.

http://members.freewebs.com/ 

Also check out http://www.pandela.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Podzinger

PODZINGER unleashes the content within audio and video.  To find the podcast you want, don't
just search for it ... ZING IT! 

http://www.podzinger.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows Media Encoder 9 Series 

Download Windows Media Encoder 9 Series, a powerful tool for content producers who want to
take advantage of the many innovations in Windows Media 9 Series.  Capture content with
frame-accurate control. Protect live streams and initiate broadcasts. Author for a range of
delivery scenarios including MBR streaming and CD/DVD. Create the clearest audio from
multichannel to voice-only content. Encode to any level from HD quality (1080i/1080p) to low
data rate screen capture. Fine tune compression using new encoding modes.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Foxit Reader is an alternative viewer/reader for PDF documents. Foxit PDF Reader is less than
1MB to download and doesn't need lengthy installation (just download, unzip, and run). It
works with all types of PDF documents you might have, with high display quality. Supports
different languages including most Asian languages. You can zoom in/zoom out or rotate page
display, copy text information to other application, search text in PDF document, and print PDF
documents. Version 1.3 build 0104 allows typing on any document.

http://www.foxitsoftware.com/pdf/rd_intro.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

PDF Creator. This printer driver lets you create Adobe Acrobat files from any application, just
by selecting Print from within that app and choosing PDF Creator as your printer. It offers a
multitude of options for controlling the output, including the ability to password-protect PDF
files to limit users' ability to print, copy, or modify the documents. 

http://sourceforge.net/projects/pdfcreator/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://members.freewebs.com/
http://www.pandela.com/
http://www.podzinger.com/
http://www.microsoft.com/downloads/details.aspx?familyid=5691ba02-e496-465a-bba9-b2f1182cdf24&displaylang=en
http://www.foxitsoftware.com/pdf/rd_intro.php
http://sourceforge.net/projects/pdfcreator/
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Google Desktop. Harness the power of the Internet's most popular search engine on your
own PC. Google Desktop indexes nearly every document on your hard drive and then includes
those files in your Google searches. A sidebar displays information modules that you select,
such as current news, updated items from recently visited sites, and local weather.

http://desktop.google.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FreeConference.com. Interested in hosting a 3-hour conference call with up to a hundred
participants? You can set up calls via this Web site, and people join by calling a number that
FreeConference.com specifies. These calls are rarely local, so use your cell phone (if it offers
free long distance) to keep this service truly free. 

http://www.freeconference.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

OpenOffice.org. Though it's a full-fledged, Microsoft Office-compatible word processor,
spreadsheet, presentation package, and database, OpenOffice.org won't cost you one thin
dime. It's solid enough (and sufficiently compatible with Office documents) that you may never
have to invest in an office suite again.

http://www.openoffice.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Calendar! Seeing the big picture
With Google Calendar, you can see your friends' and family's schedules right next to your own;
quickly add events mentioned in Gmail conversations or saved in other calendar applications;
and add other interesting events that you find online.

http://www.google.com/calendar/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Empowering Youth BBS. Peer tutors from across the continent can connect with each other
to improve the peer tutoring programs in their schools. 
http://www.empowering-youth.com/ 

____________________________________________

JUST FOR FUN

What Should I Read Next?
Enter a book you like and the site will analyze our database of real readers' favorite books (over
20,000 and growing) to suggest what you could read next. It's a bit like browsing the
bookshelves of a (very) well read friend!
http://www.whatshouldireadnext.com/ 

http://desktop.google.com/
http://www.freeconference.com/
http://www.openoffice.org/
http://www.google.com/calendar/
Http://calendar.google.com
http://www.empowering-youth.com/
http://www.whatshouldireadnext.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~
Ever want to be a country-western star? At today’s Cool Site, you can try it out. Upload a
picture of yourself or a friend. Make sure your pictures are 1 megabyte or less in size. Fit the
face to the screen and voila; your very own music video.

~~~~~~~~~~~~~~~~~~~~~~~~~~~
Paris by Night
Once you have the picture, move the bottom scroll bar slowly for a wrap around view of Paris. 
http://framboise781.free.fr/Paris.htm
~~~~~~~~~~~~~~~~~~~~~~~~~~~

Frappr (Friend Mapper) lets you see the zip code where your friends live or work, letting you
find out who works in the office building next door and who lives in the apartment complex
across the street. 
http://www.frappr.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Zunafish
Trade the stuff you’re done with for the stuff you want.
http://www.zunafish.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Arcaplay has a commanding list of games from which to choose. I counted over 125. If you
have the necessary Flash plug-in, they run glitch free. Games are searchable by categories.
There is also a list of tags. Tags are like subcategories, which can span categories.
http://www.arcaplay.com/ 

____________________________________________

http://www.usanetwork.com/series/nashvillestar/interactive/musicvideo/index.php
http://framboise781.free.fr/Paris.htm
http://www.frappr.com/
http://www.zunafish.com/
http://www.arcaplay.com/
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SchoolCounselor.com eNewsletter #59 - May 8, 2006

If it keeps up, man will atrophy all his limbs but the push-button finger. 
~Frank Lloyd Wright

It is a medium of entertainment which permits millions of people to
listen to the same joke at the same time, and yet remain lonesome. 
~T.S. Eliot, about radio

TIPS AND TRICKS:
(Special Focus on Microsoft Word™)

For this issue, I  focus on the most common questions I  get about M icrosoft Word™. 
Enjoy.

________________________________________________

Microsoft Word™: How do I get Word to stop helping me type? 
There are several places to look to turn off Word's various automatic features: 

1. Choose AutoCorrect (or AutoCorrect Options) from the Tools menu, then click
on the AutoCorrect tab. 

2. Clear the check boxes for the AutoCorrect items that you want to disable. 
3. Do the same for the AutoFormat As You Type tab. 
4. On the AutoText tab, clear the Show AutoComplete tip check box. 
5. Choose Options from the Tools menu, then click on the tabs and clear any

check boxes for features that you want to disable. For example: 
6. Edit tab (Tabs and backspace set left indent). 
7. Spelling & Grammar tab (Check spelling as you type and Check grammar as

you type). When these features are on, spelling and grammar that Word does
not recognize are underlined with wavy red and green lines. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Collect & Paste
This procedure helps you to copy more than one block of text to the clipboard, then paste
everything into my document. Just copy up to 12 blocks of text (24 blocks in Word XP), then,
when you're ready to paste use the Clipboard toolbar in Word 2000 or the task pane on the
right side of the screen in Word XP (you can also choose Edit and then Office Clipboard). You
can paste everything at once, or individual items in different locations. Hover the mouse over
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the icons on the Clipboard toolbar or on the task pane on the right side of the screen to get a
preview of the content. Click here for more details.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Comparing Two Documents
Comparing documents is an option within the Track Changes command. When this command is
activated, Word will compare a document you select with the document displayed in the
document window, then combine the documents with the differences highlighted in the same
way the Track Changes feature highlights edits (see How can I track changes made to a
document?). To compare a document with the current document: 

1. Save the current document (just in case). 
2. Choose Track Changes from the Tools menu, then choose Compare

Documents. 
3. Word will combine the documents as described above. 
4. Use the Accept or Reject Changes feature to finalize the document, as

described in the How can I track changes made to a document? section. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: How do I delete a footnote or an endnote? 
To delete a note, you work with the note reference mark, not the text in the note pane. Select
the reference mark of the note you want to delete, then press the [Delete] key.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Put a Horizontal Line in my Document that Moves When I Add
New Text? 
One easy way to do this is to put a border on the paragraph (either a top border or a bottom
border will work, just be aware of which paragraph you put the border in): 

1. Place the cursor in the paragraph. 
2. Choose Borders and Shading from the Format menu. 
3. On the Borders tab, select a line style. 
4. Click the buttons in the Preview area (you can choose top, bottom, left, or

right borders). 

You can also draw a graphic line with the Line tool: 

1. Choose Toolbars from the View menu. 

http://support.microsoft.com/?kbid=221190&sd=RMVP
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2. Select Drawing to display the Drawing toolbar (it usually appears at the
bottom of the screen).

3. Note: There is usually a Drawing button on the Standard toolbar that will
display the Drawing toolbar. 

4. Click on the Line tool to activate it. 
5. Click and drag in your document to draw the line.
6. Hold the [Shift] key while you drag to draw a perfectly straight, horizontal

line. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Create a Table of Contents
Word has a feature that will automatically generate a Table of Contents for your document.
First, you must format your chapter or section headings with certain "heading styles" that Word
uses to determine the text for the table of contents entry, as well as the page number where
that section or chapter begins. To mark a chapter or section heading so it will appear in your
table of contents: 

1. Select the chapter or section heading. 
2. Choose Heading 1 from the Styles list on the Formatting toolbar. For

subheadings, choose Heading 2, Heading 3, etc. 

When you have finished typing your document, you can generate your table of contents: 

1. Place the cursor where you want to insert the table of contents. 
2. Choose Index and Tables (or Reference, then Index and Tables) from the

Insert menu 
3. Select Table of Contents tab, then and select the style you want. 
4. Choose OK to insert the table of contents into your document. 

If you edit your document after creating the table of contents, you will have to update it: 

1. Click to the left of the table of contents you want to update. 
2. Press [F9]. 

Note: When you update the table of contents, any text or formatting you added to the finished
index or table is lost.

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Microsoft Word™: Tell the Spell Checker to skip the parts of my document that are
not in English.

1. Select the block of text you want the Speller to skip. 
2. Choose Language from the Tools menu, then choose Set Language. 
3. Check the Do not check spelling and grammar check box. 
4. Click OK. When the Speller is finished, you'll see the message: The spelling

and grammar check is complete. Text marked with "Do not check spelling
and grammar" was skipped. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Nick's PowerPoint Workshop is an excellent set of PowerPoint tutorials. They're very
thorough and cover both PC and Mac. I especially liked the one on "Creating a Single Web
Graphic" in PowerPoint.

This is worth a look too: http://idea.uwosh.edu/nick/effectivepresentations/index.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: How do I do a mail merge?
This one is a bit involved so I refer you to the following excellent website that has an animated
tutorial:
http://mistupid.com/technical/mailmerge/ 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Google SketchUp (free) is an easy-to-learn 3D modeling program that enables you to explore
the world in 3D. With just a few simple tools, you can create 3D models of houses, sheds,
decks, home additions, woodworking projects - even space ships. And once you've built your
models, you can place them in Google Earth, post them to the 3D Warehouse, or print hard
copies.
http://sketchup.google.com/download.html 

Relatedly, check out the Google 3D warehouse at http://sketchup.google.com/3dwarehouse/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet use involves both pros and cons for children and adolescents, according to
special issue of developmental psychology. Some youth benefit from Internet use while

http://idea.uwosh.edu/nick/usingppt.htm
http://idea.uwosh.edu/nick/effectivepresentations/index.html
http://mistupid.com/technical/mailmerge/
http://sketchup.google.com/download.html
http://sketchup.google.com/3dwarehouse/
http://www.microsoft.com/windows/ie/default.mspx
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for others it can exacerbate self-destructive behaviors. Download seven articles from Special
Section: "Children, Adolescents, and the Internet"; Special section of Developmental
Psychology, Vol. 42, No.3.
http://www.apa.org/releases/youthwww0406.html 
 
~~~~~~~~~~~~~~~~~~~~~~~~~~~

The George Lucas Educational Foundation (GLEF) was founded in 1991 as a nonprofit
operating foundation to celebrate and encourage innovation in schools. Since that time, we
have been documenting, disseminating, and advocating for exemplary programs in K-12 public
schools to help these practices spread nationwide. GLEF publishes the stories of innovative
teaching and learning through a variety of media -- a magazine, an e-newsletter, CD-ROMs,
DVDs, books, and this Web site. Here, you'll find detailed articles, in-depth case studies,
research summaries, instructional modules, short documentary segments, expert interviews,
and links to hundreds of relevant resources. You'll also be able to participate as a member of an
online community of people actively working to reinvent schools for the twenty-first century. 
http://www.edutopia.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
 
MarcoPolo: Internet Content for the Classroom is a nonprofit consortium of premier national
and international education organizations and the Verizon Foundation dedicated to providing
the highest quality Internet content and professional development to teachers and students
throughout the United States.
http://www.marcopolo-education.org 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

43 Things.  Discover what's important, make it happen, share your progress. People have
known for years that making a list of goals is the best way to achieve them. Why is that? First,
getting your goals in writing can help you clarify what you really want to do. You might find you
have some important and some frivolous goals. That is OK. You’ve got space for 43 Things on
your list. Not every one of them has to change the world (but save room for the ones that
might).
http://www.43things.com/  

~~~~~~~~~~~~~~~~~~~~~~~~~~~
 
Ask the Techies is a how-to technology podcast from Ohio University that focuses on
computers and the software that runs on them.
http://cscwww.cats.ohiou.edu/aac/lab/techies/ 

http://www.apa.org/releases/youthwww0406.html
http://mailinator.com/mailinator/index.jsp
http://www.bbc.co.uk/schools/gcsebitesize/games/bingo/bingo.swf
http://www.bbc.co.uk/schools/gcsebitesize/games/bingo/bingo.swf
http://www.edutopia.org/
http://www.bbc.co.uk/schools/gcsebitesize/games/bingo/bingo.swf
http://www.marcopolo-education.org
http://www.bbc.co.uk/schools/gcsebitesize/games/bingo/bingo.swf
http://www.43things.com/
http://www.bbc.co.uk/schools/gcsebitesize/games/bingo/bingo.swf
http://cscwww.cats.ohiou.edu/aac/lab/techies/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Thunderbird delivers. Enjoy safe, fast, and easy e-mail, with intelligent spam filters, quick
message search, and customizable views. Brought to you by Mozilla, Thunderbird makes e-mail
better. Free.
http://www.mozilla.com/thunderbird/ 

____________________________________________

JUST FOR FUN

Peerflix. DVD Movie Trading Post ... Keep what you receive. You own them. You own what
you receive.  That means you can keep them as long as you like or trade them again.  There
will never be any late fees.
http://www.peerflix.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Soaphoto is a place to share your cool pictures! This site gives professional and amateur
photographers a chance to share pictures, camera tips, and win prizes. They offer you your
own digital photo album. You can also take part in an amateur photo contest that will allow you
to win prizes. BTW, my son Joseph, an avid photography buff, would like your help. He has
entered a photo in one of the contests and would like your vote (free membership required).
You can see his photo entitled “Glowing Dragon” directly at: http://tinyurl.com/hfwl5 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Spell with Flickr is a small program that lets you type in whatever you want, then goes to
flickr and grabs pictures for each an every letter! It also allows you to change the images that
you see, so you can find better images for your word or phrase! 
http://metaatem.net/words/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Care Maintenance Coming Up?
Keeping up with the maintenance on your car or truck? Fill in a form below to see the
Manufacturer's Recommended Maintenance Schedule plus any available Recall or Technical
Service Bulletin information for your vehicle.
http://www.edmunds.com/maintenance/MaintenanceServlet 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.mozilla.com/thunderbird/
http://www.peerflix.com/
http://tinyurl.com/hfwl5
http://metaatem.net/words/
http://www.edmunds.com/maintenance/MaintenanceServlet
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Crack the Davinci Code (from Google)
http://flash.sonypictures.com/movies/davincicodequest/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Date lets you enter a date and then searches using Google for what happened on that
date and shows three results. Since Google isn't very good at sorting documents for relevance
when it comes to dates, it usually doesn't give you a list of big events, but of the things
happening in the lives of random people. 
http://douweosinga.com/projects/googledate

Also try Google Battle
Google Battle measures which of two terms has a higher Google rating by searching for term1
OR term2 and then counting the hits of either in the returned top 100.
http://douweosinga.com/projects/googlebattle 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Setting Up Your First Home Theater Surround System: Do's and Don'ts
http://forum.ecoustics.com/bbs/messages/34579/219978.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Aerial Views from Around the World
http://news.jasonhawkes.com/archives/2006/04/aerial_views_fr.html

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://flash.sonypictures.com/movies/davincicodequest/
http://douweosinga.com/projects/googledate
http://douweosinga.com/projects/googlebattle
http://forum.ecoustics.com/bbs/messages/34579/219978.html
http://news.jasonhawkes.com/archives/2006/04/aerial_views_fr.html
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SchoolCounselor.com eNewsletter #60 -  May 19, 2006

I believe that this notion of self-publishing, which is what Blogger and
blogging are really about, is the next big wave of human communication.
The last big wave was Web activity. Before that one it was e-mail.
Instant messaging was an extension of e-mail, real-time e-mail.
Eric Schmidt 

It shouldn't be too much of a surprise that the Internet has evolved into
a force strong enough to reflect the greatest hopes and fears of those
who use it. After all, it was designed to withstand nuclear war, not just
the puny huffs and puffs of politicians and religious fanatics. 
Denise Caruso, (digital commerce columnist, New York Times) 

New Workshop for your Staff and Parents

Guarding the Innocent: Keeping Kids Out of High-Tech Trouble
The goal of the seminar is to alert parents, educators and other caretakers about the
dangers that technology poses to children and to give them tools they can readily use to
keep kids safe and away from high tech trouble. 

The workshop covers topics such as social networks (e.g., Myspace.com), sexual
predators, threats to privacy such as online diaries/blogs, cyberbullying and hate,
inappropriate web sites and other materials, inappropriate use of gadgets such as cell
phones, mp3 players, game appliances, and electronic communication such as e-mail,
instant messaging, chatrooms and bulletin boards. Visit
http://www.schoolcounselor.com/safety for more details. 

Ideal for a parent workshop ... pass this on to your PTA! E-mail me for a prospectus or
other inquiries.

TIPS AND TRICKS

in Pictures. Computer books based on pictures, not text. Free! For a limited time, In Pictures
books can be downloaded for free. We think the best way to promote them is to let people try
them. If you like them, spread the word!
http://inpics.net/ 

http://www.schoolcounselor.com/safety
mailto:sabella@schoolcounselor.com
http://inpics.net/
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Technology Tutorials found on the Web 
http://www.internet4classrooms.com/on-line2.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

This is the web site of FunctionX dedicated to Microsoft PowerPoint, reviewing different
techniques of creating  presentations using this member of the Microsoft Office suite. The
lessons are mostly incremental and cumulative. This means that, for example, Lesson 2
assumes that you have reviewed Lesson 1 and Lesson 2 is a prerequisite to Lesson 3.
http://www.functionx.com/powerpoint/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Search Modifiers
Here are some nifty modifiers to type in your Google search box to refine your searches and
get the best results. (8.5 x 11 PDF file)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Catalogs helps you browse and search merchant-provided catalogs right on your
computer. You can flip through any catalog to find what interests you, or simply type in what
you're looking for, and you'll find every place that your search term appears in the catalog. If
you're not sure what catalog to look in, just search all of the catalogs in our index. 
http://catalogs.google.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Calculator 
You have an easy accessible and powerful calculator at your fingertips and you probably didn’t
know it! To use Google's built-in calculator function, simply enter the calculation you'd like done
into the search box and hit the Enter key or click on the Google Search button. The calculator
can solve math problems involving basic arithmetic, more complicated math, units of measure
and conversions, and physical constants. Try one of the sample expressions below, or refer to
our complete instructions for help in building your own. 

These sample queries demonstrate the utility and power of this new feature:

5+2*2 
2^20 
sqrt(-4) 
half a cup in teaspoons 

http://www.internet4classrooms.com/on-line2.htm
http://www.functionx.com/powerpoint/
http://www.google.com/librariancenter/downloads/Tips_Tricks_85x11.pdf
http://catalogs.google.com


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 126

160 pounds * 4000 feet in Calories 

For more details: http://www.google.com/help/calculator.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Fancy Google Search Tricks

link:www.yoursite.com - This command will show you all of the backlinks to your site. Handy
tool for finding out who is linking to you.

related:www.yoursite.com - This command will show you a list of pages that Google thinks are
related to your site in some way.

site:www.yoursite.com - Searches only those pages from the site you list.

allinurl: - If you start a query with [allinurl:], Google will restrict the results to those with all of
the query words in the url. For instance, [allinurl: google search] will return only documents
that have both “google” and “search” in the url.

define: - The query [define:] will provide a definition of the words you enter after it, gathered
from various online sources. The definition will be for the entire phrase entered (i.e., it will
include all the words in the exact order you typed them). 

inurl: - If you include [inurl:] in your query, Google will restrict the results to documents
containing that word in the url. For instance, [inurl:google search] will return documents that
mention the word “google” in their url, and mention the word “search” anywhere in the
document (url or no). Note there can be no space between the “inurl:” and the following word.

allintitle: - If you start a query with [allintitle:], Google will restrict the results to those with all
of the query words in the title. For instance, [allintitle: google search] will return only
documents that have both “google” and “search” in the title.

intitle: - If you include [intitle:] in your query, Google will restrict the results to documents
containing that word in the title. For instance, [intitle:google search] will return documents that
mention the word “google” in their title, and mention the word “search” anywhere in the
document (title or no). Note there can be no space between the “intitle:” and the following
word. 

cache: - If you include other words in the query, Google will highlight those words within the
cached document. For instance, [cache:www.subnixus.com web] will show the cached content
with the word “web” highlighted.

http://www.google.com/help/calculator.html


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 127

info: - The query [info:] will present some information that Google has about that web page.
For instance, [info:www.google.com] will show information about the Google homepage. Note
there can be no space between the “info:” and the web page url. 

spell: - Does a spell check of any given word.

stocks: - If you begin a query with the [stocks:] operator, Google will treat the rest of the query
terms as stock ticker symbols, and will link to a page showing stock information for those
symbols. For instance, [stocks: intc yhoo] will show information about Intel and Yahoo. (Note
you must type the ticker symbols, not the company name.)

filetype: - Does a search for a specific file type, or, if you put a minus sign (-) in front of it, it
won’t list any results with that filetype.

daterange: - Is supported in Julian date format only. 2452384 is an example of a Julian date.

maps: - Is a shortcut to do a google maps search.

phone: - Searches for anything that looks like a phone number.

allinlinks: - Searches only within links, not text or title.

allintext: - searches only within text of pages, but not in the links or page title.

WORTHY WEBSITES AND SOFTWARE

A "No-Bullying Proposal" Webquest
Everyone has the right to feel safe coming to school. Unfortunately, that isn't always the case.
In this webquest, you are going to work in groups of four to create a proposal to do something
about it! Your school is a great place to learn, play and to have friends. Nobody likes to be
bullied.
http://www.gecdsb.on.ca/d&g/nobullying/ 

and ...

Bye-bye Bully!  A WebQuest for 4th Grade  
(Reading and Writing to be Informed, Health Education)
http://bgeagles.tripod.com/webquest/index.htm 

http://www.gecdsb.on.ca/d&g/nobullying/
http://bgeagles.tripod.com/webquest/index.htm
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Check out other Webquests by searching the WebQuest Portal
http://webquest.org/search/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Polly Glotto. Need a phrase translated? Let Polly Glotto read it to you in 11 different
languages. Just select a language pair under Translate, type in your phrase, and hit return.
Want to hear how a foreign phrase sounds? Select a language under Speak, and type away. 
http://www.pollyglotto.com/index8.php 

Also check out this translator.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

New from Google.com!
With Google Trends, you can compare the world's interest in your favorite topics. Enter up to
five topics and see how often they've been searched for on Google over time. Google Trends
also displays how frequently your topics have appeared in Google News stories, and which
geographic regions have searched for them most often.  Try this one just for fun. Or how abut
this one. 

Google Desktop 4. Want a clock on your desktop? How about a calendar, a WiFi indicator, a
TV, or anything else you can dream up? Say hello to Google Gadgets. These interactive
mini-applications can be anything from games to search tools to media players, and they can
be any shape and size – use a weather globe to show you the latest forecast. We’ve got a lot of
ready-made gadgets to get you started, but they’re so easy to create that you can probably
figure out how to build your own. You can also save your gadget content and settings online to
protect your info from computer crashes and be able to access it from your other computers by
logging into your Google Account with Google Desktop. For instance, you can now ‘synch’ the
To Do list on both your laptop and your desktop.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Public Service Advertisements (video and radio) from Cybertipline that you can use in your
work to help kids understand more about high-tech dangers. 
http://tcs.cybertipline.com/videos.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

ID the Creep.
A Children and Internet Safety Game.
http://www.idthecreep.com/ 

http://webquest.org/search/
http://www.pollyglotto.com/index8.php
http://ajax.parish.ath.cx/translator/
http://www.google.com/trends
http://www.google.com/trends?q=%22Clay+Aiken%22%2C+%22Taylor+Hicks%22
http://www.google.com/trends?q=%22britney+spears%22%2C+%22christina+aguilera%22&ctab=0&date=all&geo=all
http://desktop.google.com/index.html
http://tcs.cybertipline.com/videos.htm
http://www.idthecreep.com/
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Your Guide to Healthy Sleep
This patient and public booklet provides the latest science-based information about Sleep.
http://www.nhlbi.nih.gov/health/public/sleep/healthy_sleep.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Use Involves Both Pros and Cons for Children and Adolescents, According
to Special Issue of Developmental Psychology
A major goal for this cumulation of research is to show the good and bad sides of the Internet
as it relates to children," said coeditors of the special issue Patricia Greenfield, PhD, of the
Children’s Digital Media Center, University of California at Los Angeles and Zheng Yan, PhD, of
the State University of New York at Albany.
http://www.apa.org/releases/youthwww0406.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FaxZero lets you send a fax to any fax machine in the United States (including Puerto Rico) or
Canada for free. You don't need a fax machine yourself, but you do need a valid e-mail
address. You can type the text of your fax (for a quick text-based fax) or attach a file. You can
send plain text, PDF, Microsoft Word™ (DOC), or an Excel spreadsheet (XLS) file. Ready to
send? Whack the Send Free Fax Now button! The service is supported by advertising on the
web site and on the cover pages of the free faxes you send.
http://faxzero.com/ 

Also ...

Put Your Printer To Work - Free Printable Stuff!
Free Printable Business Cards 
http://www.FreePrintableBusinessCards.net 

Free Printable Certificates
http://www.FreePrintableCertificates.net 

Free Printable Stationery
http://www.FreePrintableStationery.net

Free Printable Gift Tags
http://www.FreePrintableGiftTags.net

Free Printable Recipe Cards
http://www.FreePrintableRecipeCards.net

http://www.nhlbi.nih.gov/health/public/sleep/healthy_sleep.htm
http://www.apa.org/releases/youthwww0406.html
http://faxzero.com/
http://www.FreePrintableBusinessCards.net
http://www.FreePrintableCertificates.net
http://www.FreePrintableStationery.net
http://www.FreePrintableGiftTags.net
http://www.FreePrintableRecipeCards.net
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Free Fax Cover Sheets
http://www.FreeFaxCoverSheets.net

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Filter Software—Shield Your Family from Pornography
Today's high-tech porn-pushers make it almost impossible to protect families from unwanted
pornography. Thankfully, with tools like Internet filter software, it's possible to fight back.
http://internet-filter-review.toptenreviews.com/ 

____________________________________________

JUST FOR FUN

Sketch Swap
Draw cartoons, art, brainstorms, anything. If you add text, please use English so we can
approve it. A graphic tablet helps sketching.
http://www.sketchswap.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Diner Dash™
Seat customers, clear dishes, take and deliver food orders - you're a one-woman show in this
frantic restaurant sim. But don't keep those customers waiting too long, or they'll dine and
dash. Ugh!! 
http://www.shockwave.com/gamelanding/dinerdash.jsp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Flash Mind Reader 
http://jo.zan.hu/poen/flash/magic.swf

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Remember the Old Rubic’s Cube?
http://www.innovationecology.com/cube.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.FreeFaxCoverSheets.net
http://internet-filter-review.toptenreviews.com/
http://www.sketchswap.com/
http://www.shockwave.com/gamelanding/dinerdash.jsp
http://jo.zan.hu/poen/flash/magic.swf
http://www.innovationecology.com/cube.swf
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Disappearing Man 
Count the men and watch how 12 men turn into 13 and then back to 12 again. How do they do
it? Stump a friend! 
http://www.crazy-jokes.com/Tricks/disappearing.shtml 

Also...  Bungee Baby 
http://www.crazy-jokes.com/funny-files/bungee-baby.shtml 

____________________________________________

http://www.crazy-jokes.com/Tricks/disappearing.shtml
http://www.crazy-jokes.com/funny-files/bungee-baby.shtml
http://www.schoolcounselor.com/posters.htm
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SchoolCounselor.com eNewsletter #61 - May 29, 2006

We started Yahoo in about April 1994. It started out as a way for us to
keep track of things that we were interested in. – David Filo

We're at the point now where the challenge isn't how to communicate
effectively with e-mail, it's ensuring that you spend your time on the
e-mail that matters most.
Bill Gates 
____________________________________________

Do you have a counseling technology related question. Click here to submit it. I can’t promise
that I will answer all the questions I get although I will do my best.

Teaching Kids the “Rules of the Road”

Note: Feel free to share this with others and include in your newsletters home with the
following citation: Source: www.schoolcounselor.com/newsletter.

Early on, our kids need to know that what applies in real life also applies in the virtual
world of cyberspace. When approached by a stranger, they must ask for parent permission to
speak to that person. This is important. Sexual predators and kidnapers are good at “grooming”
children to trust them and eventually lure them into a dangerous situation. They take their
time, determine the child’s vulnerabilities, and then say just the right things that appeal to their
sense of adventure. They help their prey with self-confidence and feelings of belonging – the
very same goals that we as parents and caretakers strive to achieve. In essence, they became
parental figures with a sick motive. Or worse, they use their adult knowledge and resources to
gain an unfair (and evil) advantage towards developing a “boyfriend” or “girlfriend”
relationship. They follow the same process that rapists follow: First, enter the child’s “personal
space.” They get to know the child and interact in friendly ways to create an illusion of trust.
Second, they rely on the child ignoring any violations thus leading to a “slippery slope” of
continued sexual banter and playfulness. Third, when the timing is right, they lure the child into
isolation where there is little chance of others, especially adults, getting in the way. This begins
with a private one-on-one chat in the virtual world and ends up with a secluded meeting in the
real world. Finally comes the assault. 

For your convenience, I have also gleaned from various websites and from personal experience
several other Rules of the Road that you should review and impress upon your students/child:

mailto:sabella@schoolcounselor.com?subject=Counseling%20Technology%20Related%20Question%20for%20Russ
http://www.schoolcounselor.com/newsletter.
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1. Never give out personal details such as your name, address or phone number. 
This applies to Internet profiles you may post as well as chat rooms. A
corollary to this is never give out private details about your parents, family or
friends. To a predator, these are clues to a puzzle that when finished, can
help him/her determine who you are and even where you live. Also, family
members may not want those details divulged for other reasons. For
instance, a fun photo of Uncle Joe at a party may get him in trouble with his
boss or compromise his relationship with co-workers if it were discovered at
work. 

2. Never reveal passwords to your e-mail or other online accounts, even to your
friends. Giving up your passwords means you give up control of the account
which, for the purposes of our focus, is a security breach. Even trusted
friends may accidentally do things online (e.g., send emails using your
account) which may attract unwanted attention and open you up to the very
kind of interactions you’ve been trying to avoid. 

3. Never arrange to meet with anyone you have met online. If you think a
meeting would benefit you, work with your parent to make it happen and
only be present at the meeting with your parent. 

4. Only put on your buddy list those “friends” approved by your parents. Parents
should always meet and know the people on your child’s buddy lists.

5. Never open e-mail messages from others you don't recognize. It could very
well contain a virus or inappropriate content. Even when you do recognize
the name in the e-mail, don’t open any attachments that you weren’t
expecting. Many viruses use a recipients address book to send out emails and
even use first names as they appear in the address book to make the e-mail
look genuine when it is really not. 

6. Remember that people online may not be who they say they are, no matter
how long you have been in contact with them. The internet makes it very
easy to conceal ones identity and masquerade as someone else. That 13 year
old “friend” you have been interacting with could easily be a 45 year old man
who intends to harm you. 

7. If at any time you feel uncomfortable or uneasy, something is probably
wrong. Stop what you are doing (don’t log off just yet) and get a parent or
other trusted adult. The adult should review the message or other interaction
and if appropriate, use the content (including message headings) as evidence
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and report the person to the authorities. Also remember that it is not your
fault if someone is trying to frighten you. 

8. Do not reply to any bullying messages you receive. Bullies only take this as
fuel for the fire and things could easily get worse. Instead, save and report to
a trusted adult/parent. 

9. Always abide by the “Golden Rule” when in chat rooms, talking on instant
messenger, or sending email—treat others the way you’d wish to be treated. 

10. Do not download or/and install any programs, especially file sharing
software, without parental approval.

11. Be savvy when it comes to creating a user name. Ensure user names do not
reveal too much personal information.  It is inappropriate and dangerous for
anyone to use his/her name or home town as their user name.  Most user
names made up of personal information are easily deciphered leading
perpetrators to a student's identity and location.

12. No second chance for a first impression. Remember that once information is
posted online and deleted or modified, the original will never be completely
deleted.  People can copy and disseminate information to others so, even if
information is deleted from a website, older versions may exist on others'
computers.

 
____________________________________________

TIPS AND TRICKS

Microsoft Word™:  Four ways to select a block of text.

1. Use the mouse. Just click and drag the mouse to select text.
2. Use [Shift] plus the arrow keys. Hold down [Shift] and press an arrow key to

select text in the desired direction. To select a word at a time, press
[Ctrl][Shift] and the left or right arrow key.

3. Use the mouse with the [Shift] key. Move the mouse pointer away from the
insertion point position, hold down [Shift] and click to select all the text
between the insertion point and the place where you clicked.

4. Frustrated when you try to select text with the mouse past the bottom of the
currently visible page and Word leaps past what you want to select? Those
are the times to use [Shift] plus the down arrow key instead of the mouse.

http://www.missingkids.com/missingkids/servlet/PageServlet?LanguageCountry=en_US&PageId=169
http://www.schoolcounselor.com
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Also, to:

– Select a word. Double-click on it. If a space immediately follows the word you select, the
space gets selected, too. Punctuation is ignored.
– Select a sentence. Hold down [Ctrl] and click anywhere in the sentence.
– Select a paragraph. Triple-click within the paragraph or move the mouse just past the left
margin of the paragraph. When the pointer changes to a right-pointing arrow, double-click to
select the whole paragraph.
– Select a table. Select a table by holding down [Alt] and double-clicking anywhere in the
table.
– Select all the text between the insertion point and… To select all the text between the
insertion point and the end of the current line, press [Shift][End]. To select the text from the
insertion point through the end of the current paragraph, press [Ctrl][Shift] and the down
arrow. To select the text from the insertion point to the end of the document, press
[Ctrl][Shift][End].
– Select an entire document. Press [Ctrl]A. This is handy when you need to change the font
or add or remove formatting. Once you've selected the entire document, apply the formatting
to everything and either leave it applied or apply it again to remove it. For example, suppose
some text in your document is underlined and you want nothing underlined. To avoid spending
time visiting each underlined section of text and un-underlining it, select the whole document
with [Ctrl]A. Press [Ctrl]U to apply underlining to the entire document and then press [Ctrl]U
again to remove the underlining. Be careful when you use [Ctrl]A. If you accidentally press
[Delete] or type a keystroke and erase everything, don't panic. Just press [Ctrl]Z or choose
Undo from the Edit menu.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Add a Calculator 
Usually, you calculate numbers when you use Excel, so it only makes sense to add a calculator
to the Excel toolbar. 

1. Choose View, Toolbars, Customize. 
2. Click on the Commands tab. 
3. In the Categories list, choose Tools. 
4. In the Commands list, choose Custom (you'll see a little gray calculator icon next to it). 
5. Drag the calculator icon to the toolbar, letting it drop wherever you'd like it to reside. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~



SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 136

Microsoft PowerPoint™:  Password Protect Your Presentations

PowerPoint is a great application to use for putting together wonderfully creative presentations.
Imagine this though - you have just spent hours upon hours putting together the PowerPoint
presentation of a lifetime only to find out that another user has come along and made some
undesirable changes to it.  Fortunately in Office XP you can prevent this from happening by
password protecting your presentations. If you use passwords, you have two different options.
You can require a password to open the presentation or you can require a password to make
any changes to the presentation. To configure a password, open your PowerPoint presentation
and click Options from the Tools menu. Click the Security tab. You'll see there are two options
available. There is Password to open and Password to modify. To use either one, simply type a
password into the field.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Paste plain text. 
When you copy and paste text from a Web page or another document, the text brings its
formatting into your document. To get around that behavior, copy the text and place the
insertion point marker where you want to insert the copy. Then, open the Edit menu, choose
Paste Special, and select the Unformatted Text option.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Reducing the Size of Your PowerPoint Presentations

PowerPoint presentations can become very large when you are inserting images into the slides.
One option you have to get around this problem is to manually convert all the graphics to a
more compressed file type such as a JPG.  An even easier method is to have PowerPoint take
care of this for you. Once you have your presentation open, click View, point to Toolbars, and
place a check beside Pictures. The Picture toolbar will appear in your presentation. On this
toolbar there is a button called Compress Pictures. If you click on this button, the Compress
Pictures dialog box will appear. Under the Apply to section, you can select which pictures you
want to compress. You can compress selected pictures or you can compress all pictures in the
presentation. You can also change the resolution of the pictures. The resolution for Web/Screen
is 96dpi and 200 dpi for the Print option. You can also have the cropped areas of pictured
deleted (in case you didn't know, the cropped area of pictures is usually just hidden, not
deleted). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
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Accessing Recently Used Documents
The Documents menu holds a list of the last 15 files you’ve worked on, and gives you 1-click
access to them. Just go to Start, Documents, and choose the file you want. The necessary
program will open automatically. In many programs, there is also a list of recently used files at
the bottom of the File menu

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Add a border to a page.
To add a border to page, open the Format menu, select the Borders And Shading command,
and click the Page Border tab.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Using Right-Click menus
Many people forget that you can right-click anywhere in almost any program to get a right-click
menu with commonly used options. This may save you from needing to go up to the menus.
Experiment by right-clicking in various places to see what menu options are available.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows XP: Shortcuts
Create your own shortcut-key combinations to your favorite applications by right-clicking the
app of choice and selecting Properties. Under the Shortcut tab, enter your own key
combination, such as Ctrl+6, in the "Shortcut key" field. If the combination you choose is
already taken, Windows selects something similar. For instance, I use WordPerfect as my word
processor. To launch this program, I only have to press ALT-CTRL-W. My hands never leave the
keyboard!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google: Translation
Need to translate text? Head over to Google Translate, paste the text into the field and make a
selection from the drop-down menu. You can also insert URLs to translate Web pages. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Word™: Selective word count. 
Need to know how many words, characters, paragraphs, or lines appear in a portion of a
document? Just select the text you want to run the count on prior to choosing Word Count
from the Tools menu.

http://www.google.com/language_tools?hl=en
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WORTHY WEBSITES AND SOFTWARE

Yahoos Desktop Search is a great way to search you hard drive for info and documents. YDS
uses the award winning technology that X 1 designed for there paid desktop search engine. 
Yahoo comes out on top when it comes to the amount of file types. Yahoo can search over 200
different file types. Including PDF, ZIP, or PhotoShop which the Google Desktop Search engine
doesn't. Yahoo has also thought of your privacy so they decided not to search cached versions
of Web content as this could reveal sensitive information such as banking and personal
information to others who use the same computer.  FREE.
http://desktop.yahoo.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

FireAnt (Windows, Mac)
FireAnt is a great little application for downloading, organizing and viewing podcasts and
vidcasts. You can subscribe to any podcast that has an RSS feed. It will download both video
and audio content but video works the best with this application.  If you don’t know of many
video podcasts you can use the built in channels to select some content you would like to
watch. FREE.
http://fireant.tv/download 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mozilla Calendar (Win, Mac, Linux)
Mozilla is most famous for its browser, Firefox. But what you might not know is that Mozilla also
designs and develops great software to manage your e-mail, such as Thunderbird, and on
today’s show we’ll show off a tool that will let you manage your life, called Mozilla Calendar.
This FREE software, which has all the necessary features to organize important dates and
appointments, is very easy to use and it integrates well with other Mozilla tools. 
http://www.mozilla.org/projects/calendar/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

TEXTstats (Windows)
If you're carefully watching your words and want to keep tabs, this program can help. It
searches a webpage or document and logs the number of times each word is used. You then
get a report at the end with all the stats. You may or may not be pleased with the number of
times you use the word "like" in a document, like really. FREE.
http://www.niederlandistik.fu-berlin.de/textstat/software-en.html

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://desktop.yahoo.com/
http://fireant.tv/download
http://www.mozilla.org/projects/calendar/
http://www.niederlandistik.fu-berlin.de/textstat/software-en.html
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The Phrase Finder
If you've ever found yourself fumbling for the right words, trying to come up with a quick quip
or developing an eloquent turn of phrase, this online writer's resource has several useful
sections. There's a phrase thesaurus, which generates a list of phrases using the word you've
entered. You can learn about the origins of more than 1200 common sayings. Or, for the
know-it-all linguaphile, test your knowledge of phrases by taking a quiz or signing up for the
free phrase-a-week e-mail service.
http://Phrases.org.uk/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Favourville.com is a website where users can exchange favors without having to worry about
sneaky marketing or their information being sold. What makes this site unique is that it has no
ads or direct affiliations with any major corporations. It's a simple way to post what you are
looking for and offer a favor in return. 
http://favourville.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

HuckaBuck.com is a metasearch interface that takes the words you type into its search box,
and queries Google, Yahoo!, and MSN simultaneously to deliver results more relevant than
those from a single engine.  Tune your results using the Search Tuner! 
http://www.huckabuck.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

JUST FOR FUN

MooTube [Macromedia Flash Player] 
The world has long been familiar with the phrase “a birds-eye view”. Well, as a result of this
website, the web-browsing public may become intimately familiar with the phrase a “cows-eye
view”. Developed as part of the Texas Ranch House television program on PBS, this website
offers a first-hand look into how cows view the world. Basically, a number of cows (including
Two Night Beauty and Chastity) were outfitted with a series of cameras that allow the viewer a
glimpse into their world as they move about during the day. First-time visitors to the site can
skip through to some of the Cow Cam Archive, which highlights some memorable bits of
activity, as well as browse through the blog created for this rather unique endeavor.
Source: The Scout Report -- May 26, 2006 -- HTML Version
http://www.mootube.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://Phrases.org.uk/
http://favourville.com/
http://www.huckabuck.com/
http://scout.wisc.edu/Reports/ScoutReport/2006/scout-060526.html%20
http://www.mootube.com/
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Electric Sheep (Win,Mac,Linux)

If you fancy yourself a screen saver critic, this free file should be right up your alley. While your
computer is asleep, this screen saver will start a rotation of patterns. You can then rate the
current pattern using the up and down arrow keys. Based on your input, the program will
download similar patterns to your computer and include them in the new rotation. 
http://electricsheep.org 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Movie Database
Touted as the "Earth's biggest movie database," IMDB is an extremely useful resource for all
sorts of information pertaining to movies, television and even video games. 
http://www.imdb.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Just-For-Fun Tests
A whole new kind of Mini-Test! Entertaining yet revealing, the Just-For-Fun Tests give you a
quick glimpse into your psyche, sense of right and wrong, and personal quirks. 
http://www.queendom.com/tests/minitests/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Good grief!  Check out all these Peanuts-themed Web sites!
http://www.peanutscollectorclub.com/wwwfun.html 

http://electricsheep.org
http://www.imdb.com/
http://www.queendom.com/tests/minitests/
http://www.peanutscollectorclub.com/wwwfun.html
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SchoolCounselor.com eNewsletter #62 - June 7, 2006 

Give a person a fish and you feed them for a day; teach that person to
use the Internet and they won't bother you for weeks. – Unknown

The question of whether computers can think is just like the question
of whether submarines can swim. – Edsger W. Dijkstra

NEW: Google Essentials. Convenient links to all your Google.com essentials, all
free, on one page. Downloads include Firefox with Google Toolbar, Picasa (photo
management and editing software), Google Earth, and more! Go now to
http://www.schoolcounselor.com/resources/ 

Understand the Code: The New Shorthand

Children and some adults have developed their own type of shorthand to quickly keep up with
the pace of communication in chatrooms, on cell phones, and via instant messaging. When the
“room” is filled with 20, 30, or more people, the conversation can be fast and furious.
Limitations of time in addition to limitations of technology (e.g., the chat room does not support
including graphics or photos) have spawned a new set of acronyms and symbols. The bad news
is that these symbols may be difficult to decipher without practice. While in some chatrooms, I
still have to keep a computer lingo dictionary or converter open just to keep up. Its like being in
a foreign country and you don’t speak the language. These websites should help: 

1. http://www.city-net.com/~ched/help/lingo/jargonlinks.html 
2. http://www.web-friend.com/help/lingo/chatslang.html 
 

TIPS AND TRICKS

Microsoft Excel™: Trendlines
Adapted from TechRepublic
Trying to predict the future based on past experiences, but you're lacking the right formula? If
you've forgotten high school algebra, fear not. With trendlines, Excel can project future figures
based on previous history. Let's say you are keeping track of monthly attendance or discipline
data for the past six months (August through December), and you want to know what the
overall data will likely be for the second half of the year. You can use trendlines to have Excel
predict the answers based on your previous data. Follow these steps:

http://www.schoolcounselor.com/resources/
http://www.city-net.com/~ched/help/lingo/jargonlinks.html
http://www.web-friend.com/help/lingo/chatslang.html
http://www.schoolcounselor.com
http://techrepublic.com.com/5100-10877_11-6073923.html
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1. Create a bar chart of the data you've tracked so far. 
2. Click on your chart, and then click on the data series. 
3. Go to Chart | Add Trendline. 
4. Click on the Options tab. 
5. In the Forecast section, click on the up arrow in the Forecast box until the entry in the

box changes to 6. 
6. Click OK. 

Excel will extend the trendline to show estimated monthly sales figures for the rest of the year.
 
~~~~~~~~~~~~~~~~~~~~~~~~~~~

Virtually There and Everywhere via Windows XP's Remote Desktop 
Save Time and Hassle with XP Pro's Remote Desktop Feature 
Windows XP Professional's Remote Desktop feature allows you to see and control your office PC
as though you were sitting directly in front of it. You may never have to leave home again. 
http://www.winplanet.com/article/3256-.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google: Find Movies
To find reviews and showtimes for movies playing near you, type "movies", "showtimes" or the
name of a current film into the Google search box. If you've already saved your location by
using Google Local, the top search result will display showtimes for nearby theaters for the
movie you've chosen. 
http://www.google.com/help/features.html#movies 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google: Music Search 
Find information about artists, songs, albums and places to buy the music you are looking for.
If you enter the name of an artist popular in the U.S. into the search box, we will display user
reviews, song titles, stores to purchase the music and other useful information related to that
artist at the top of your search results. 
http://www.google.com/help/features.html#music 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Spreadsheets Sneak Peek
You can start from scratch and do all the basics, including changing the number format, sorting
by columns, and adding formulas.
http://www.google.com/googlespreadsheets/tour1.html 

http://www.winplanet.com/article/3256-.htm
http://www.google.com/help/features.html#movies
http://www.google.com/help/features.html#music
http://www.google.com/googlespreadsheets/tour1.html
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Notebook  
Clip and collect information as you browse the web. Google Notebook makes web research of
all kinds – from planning a vacation to researching a school paper to buying a car – easier and
more efficient by enabling you to clip and gather information even while you're browsing the
web. And since Google Notebook lives in your browser, you won't be left with a scattered
collection of notes, Word docs, and browser bookmarks to sort through; all your web findings
will be gathering into one organized, easy accessible location that you can access from any
computer.
http://www.google.com/googlenotebook/overview.html 

Search public notebooks here.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Conversions
Dividing by 1000 is a cinch (just move that decimal point over), but dividing by 1024? Not so
much. Happily when dealing with kilo, mega or gigabytage, Google’s built-in conversion
calculator will do the math for you. Google can tell you how many teaspoons are in a quarter
cup (quarter cup in teaspoons) or how many seconds there are in a year (seconds in a year) or
how many Euros there are to 5 dollars (5 USD in Euro). For the geekier set, bits in kilobytes
(155473 bytes in kilobytes) and numbers in hex or binary (19 in binary) are also pretty useful.
To do this just put what you want in the search box (e.g., quarter cup in teaspoons, 75 yen to
dollars, or 100 kilos to pounds). 
http://www.googleguide.com/calculator.html 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Middle-Schoolers Design Web Site with Career Resources
Three hundred middle school students from all over the country worked closely with developers
to design a Web site called Funworks that links the interests and hobbies of young people, ages
11 to 15, to future careers. The site, created by the Gender, Diversity, and Technology Institute
at Education Development Center, features information about careers in science, technology,
engineering, and math, as well as games, quizzes, and more. In addition, Funworks provides
educational resources for guidance counselors, teachers, media specialists, and parents.
http://www.thefunworks.org/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.google.com/googlenotebook/overview.html
http://www.google.com/notebook/search
http://www.googleguide.com/calculator.html
http://www.thefunworks.org/
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Project Safe Childhood
As technology advances and as the Internet becomes more accessible, the number of
computer-facilitated sexual exploitation crimes committed against children – including child
pornography offenses and enticement crimes – is expected to continue to grow. Introduced in
February 2006, the goal of Project Safe Childhood is to enhance the national response to this
growing threat to America’s youth.
http://www.usdoj.gov/ag/psc/projectsafechildhood.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Understanding User Accounts in Windows XP
Everyone who uses Windows XP needs a user account. User accounts act like cocktail party
nametags and help Windows recognize who's sitting at the keyboard. Windows XP dishes out
three types of user accounts: Administrator, Limited, and Guest.
http://www.dummies.com/WileyCDA/DummiesArticle/id-350.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Scribus is a a free open-source program that brings award-winning professional page layout to
Linux/Unix, MacOS X and Windows desktops with a combination of "press-ready" output and
new approaches to page layout. Underneath the modern and user friendly interface, Scribus
supports professional publishing features, such as CMYK color, separations, ICC color
management and versatile PDF creation.
http://www.scribus.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Smarts: Safeguarding your Children in Cyberspace.
The text of this booklet is provided by Cablevision's Power to Learn for educational use only
and may not be used for commercial purposes. CSC Holdings, Inc. holds the copyright to the
content of Internet Smarts: Safeguarding your Children in Cyberspace. If you are interested in
downloading multiple copies please request permission by emailing edinfo@cablevision.com or
by calling (516) 803-2727 and advising us of the planned use.
Download .pdf version at http://www.powertolearn.com/pdf/Internet_Smarts.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Welcome to Internet for Information and Communication Technology 
A free, "teach yourself" tutorial that lets you practice your Internet Information Skills. Click here
to enter. For other tutorials, click here. 
 
~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.usdoj.gov/ag/psc/projectsafechildhood.htm
http://www.dummies.com/WileyCDA/DummiesArticle/id-350.html
http://www.scribus.net/
http://www.powertolearn.com/pdf/Internet_Smarts.pdf
http://www.vts.rdn.ac.uk/tutorial/ict?sid=7644431&op=render&manifestid=48&page=indexhtml
http://www.vts.rdn.ac.uk/
http://www.vts.rdn.ac.uk/tutorial/
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Tons of Useful Links from Madison IT Resources
http://guest.portaportal.com/raehn 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Portaportal is a web based bookmarking utility that lets you store links to your favorite
websites online. Now your bookmarks are no longer limited to any one machine. 
http://www.portaportal.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

DisabilityInfo.Gov
This user-friendly Web site contains links to information of interest to people with disabilities,
their families, employers, service providers and many others. 
http://www.disabilityinfo.gov/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Priority Patrol    
Tired of nagging her daughters to get away from the computer and turn off the TV in order to
get things done, San Diego mother of two, Ellen Elleman, invented, copyrighted and hired the
“Priority Patrol” to do the job for her; and now you CAN too! Originally inspired by the hours
and hours spent in front of screens in her household, Ellen quickly realized that the “Priority
Patrol” applies to all time-wasting activities. She found that the “Priority Patrol” serves as a
gentle third party reminder, so that the interpersonal communication that takes place in her
home is not in the form of nagging. It is also designed to remove the phrase “Oh, I forgot”
from the vocabularies of her family and friends!! 
http://www.prioritypatrol.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Time Management from PBS. If you learn to tame the time monster, you might be surprised
at how much you can get done. The real reward, however, is that you'll probably feel less
stressed and more happy.  
http://pbskids.org/itsmylife/school/time/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Cyberbullying
Mobilizing educators, parents, students, and others to combat online social cruelty.
http://cyberbully.org/ 

http://guest.portaportal.com/raehn
http://www.portaportal.com/
http://www.disabilityinfo.gov/
http://www.prioritypatrol.com/
http://pbskids.org/itsmylife/school/time/
http://cyberbully.org/
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JUST FOR FUN

Earthcam
Check out live photos from around the world!
http://www.earthcam.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Evolution of Dance
A video created by a motivational speaker/comedian has become one of the most watched
videos on the Internet. And television networks are beginning to take notice. In the video,
Judson Laipply does a dance routine he uses to close his motivational speeches. 
http://www.youtube.com/watch?v=dMH0bHeiRNg 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Panorama Explorer
Explore the World ! View and share photos taken at beautiful places of the world. Panorama
Explorer is a photo sharing community which allows you to view, share and store your photos.
You keep the copyright of your photos. Your photos are published resized but otherwise with
no other modifications. It is free and will stay free ! 
http://www.panoramaexplorer.com/ 

http://www.earthcam.com/
http://www.youtube.com/watch?v=dMH0bHeiRNg
http://www.panoramaexplorer.com/
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SchoolCounselor.com eNewsletter #63 - June 24, 2006
__________________________________________

LIFE ON THE ETCH-A-SKETCH HELP DESK 

A day in the life at the etch-a-sketch help desk...

Q: My Etch-A-Sketch has all of these funny little lines all over the screen. 
A: Pick it up and shake it. 

Q: How do I turn my Etch-A-Sketch off? 
A: Pick it up and shake it. 

Q: What's the shortcut for Undo? 
A: Pick it up and shake it. 

Q: How do I create a New Document window? 
A: Pick it up and shake it. 

Q: How do I set the background and foreground to the same color? 
A: Pick it up and shake it. 

Q: What is the proper procedure for rebooting my Etch-A-Sketch? 
A: Pick it up and shake it. 

Q: How do I delete a document on my Etch-A-Sketch? 
A: Pick it up and shake it. 

Q: How do I save my Etch-A-Sketch document? 
A: Don't shake it.
 

Picasa
Did you know you can use free software to organize your photos? Picasa is software that helps
you instantly find, edit and share all the pictures on your PC, free!
http://www.schoolcounselor.com/resources/index.htm
____________________________________________

http://www.schoolcounselor.com/resources/index.htm
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Google Spreadsheets

Google, the worlds most famous search engine, continues to quietly brew and deliver new tools
concocted in their labs. One of the latest, still in beta, is online spreadsheets (beta means that
they are still experimental and not exactly official). I’m one of those typical folks who send
spreadsheets to others via e-mail, they work on them, send them back, and the process starts
over again. This type of collaboration seems to work fine for my purposes. Recently, however, I
found myself needing to have my students sign up for an event spanning over several days,
and only six of the 26 people could attend on any given day. The event was already happening
and so I had to move quickly. I wouldn’t see the class for another week and so it had to
somehow be done online. I thought of using the online form and database features of Microsoft
Frontpage™ although this would take some time. I thought of setting up a wiki although,
honestly, I had not done this before and thought that the learning curve would take more time
than I had. (I will definitely come back to learning more about wikis as I have more time as I
believe that they do have a place in our profession). Then I remembered the new Google
Spreadsheet which allows one to create, store and share spreadsheets on the web. 

You can start from scratch and do all the basics, including changing the number format, sorting
by columns, and adding formulas. Or, you can upload spreadsheets or worksheets from CSV
(comma separated value) or XLS (Excel Spreadsheet) format - all your formulas and formatting
will come across intact. To share the worksheet, you just enter the e-mail addresses of the
people you want to share a given document, and then send them a message.  People with
whom you share a given spreadsheet can access it as soon as they sign in. Signing in means
that each person you share with has to have a Google account which is free and allows you to
also enjoy many of the other online Google tools anyway (e.g., Gmail, news alerts, group
discussions, personalized home pages, and much more). 

Once signed in, multiple people can edit or view your spreadsheet at the same time as you -
their names will appear in an on-screen chat window. What I also found very helpful is that,
when others are logged in, a chat window appears and so you can conduct a text chat with
others while collaborating on the spreadsheet. Other cool aspects of the Google spreadsheet
tool is that it auto-saves your data as you input it which means that you need not fear hard
drive failures and power outages. Because the spreadsheet is online, you can access and work
on it from any internet connected computer in the world! Also, once your online spreadsheet is
complete, participants can download it to their computers in the familiar Microsoft Excel™
format. 

Using the Google spreadsheet system left me also wondering how useful it would for doing the
work of school counseling. Perhaps counselors may use this high-tech tool to collaboratively
look at and manipulate data in order to make decisions affecting their guidance and counseling
plans. The same tool can be used to look at outcome or other important data. Other ideas
include:

http://labs.google.com/
http://en.wikipedia.org/wiki/Main_Page
http://spreadsheet.google.com
http://spreadsheet.google.com
http://www.creativyst.com/Doc/Articles/CSV/CSV01.htm
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• similar to how I used it for my class, allowing teachers or parents to sign up
for different opportunities.

• committees might use Google Spreadsheets to track progress on a project
• counselors in a district could share a spreadsheet to track progress on a

district wide project (e.g., decreasing student retention rates across the
district)

• track assets
• keep a common database of donations or community partners

How else could an online group spreadsheet come in handy in your work? E-mail me with your
ideas which I will collate and send out to the group. 
____________________________________________

TIPS AND TRICKS

What is a Google Jockey?
A Google jockey is a participant in a presentation or class session who surfs the Internet for
terms, ideas, or Web sites mentioned by the presenter or related to the topic at hand. A screen
displays the jockey’s searches for all participants to see. Typically the instructor or presenter
will use at least one projection screen to show slides or other content to a class. Google
jockeying adds one or more screens to the session, allowing students to see related resources
and additional information that clarify the main topic. Although the term takes its name from
the Google search engine, any search engine will do, and the practice also includes navigating
directly to known Web sites that might (or might not) be directly mentioned in the lecture,
without passing through a search engine. A Google jockey might look for definitions of specific
terms, images or multimedia files that demonstrate concepts, or other online resources. 
Learn more at http://www.educause.edu/ir/library/pdf/ELI7014.pdf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Amicron NetBackup?
Amicron NetBackup is a FREE utility that is designed to copy all of your critical files from one
machine to another (i.e. file server to a workstation), or from one disk to another in a
multi-drive PC (i.e. C: to D:) as a secondary line of defense against data loss. It is not designed
to replace your tape backup drive, but to supplement it. 
http://www.amicron.com/downloads/netback.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Turn Down the Volume
Since mid-December 2005, ASHA Public Relations has mounted an aggressive public awareness
campaign on the potential link between the usage of  some popular technology devices that

http://mailto:sabella@schoolcounselor.com?subject=Idea%20for%20Onling%20Google%20Spreadsheet&body=Russ,%20I%20have%20an%20idea%20for%20using%20the%20Google%20Spreadsheets:%20
http://www.educause.edu/ir/library/pdf/ELI7014.pdf
http://www.amicron.com/downloads/netback.htm
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provide audio through ear buds or ear-phones-like Apple's iPod, other MP3 players, and
portable DVD players and hearing loss.  The campaign, which has featured the release of ASHA
commissioned national poll results about usage habits, has included an ASHA-sponsored panel
discussion involving leading experts and national legislators at the National Press Club on March
14, 2006. 
http://www.asha.org/turndownthevolume 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Automatic Press Release Builder
Build your ready-to-use Press Release by using an online form. Simply enter information in each
of the fields and click 'Generate Source'. Then click 'View Press Release'.
http://www.bmyers.com/public/541.cfm 

Also, here is a similar one for creating cover letters:
http://www.bmyers.com/public/540.cfm

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Anonymouse
Surf the web and send e-mail anonymously.
http://anonymouse.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Create Forms for Easier Data Entry
Entering large amounts of data into an Excel spreadsheet can be very time consuming. Using
data entry forms makes your task easier. A data entry form is a dialog box that gives you a
convenient way to enter a complete row of information at one time. 

To use a data entry form to edit a list:

1. Click a cell in the labeled row you want to add the record to. 
2. On the Data menu, click Form. 
3. Click OK. A data entry dialog box appears, with field labels that correspond with the column
labels in your list. 

To add a new record

1. Click New. 
2. Type the information for the new record. 
3. When you finish typing data, press the ENTER key to add the record. 

http://www.asha.org/turndownthevolume
http://www.bmyers.com/public/541.cfm
http://www.bmyers.com/public/540.cfm
http://anonymouse.org/
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4. When you finish adding records, click Close to add the new record and close the data form. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Use This Shortcut to Insert Time/Date in Excel or Access
Here are a few keyboard shortcuts you can use to insert the current time and date in a
Microsoft Access table or Excel spreadsheet. 

Current date: Press CTRL+SEMICOLON 
Current time: Press CTRL+SHIFT+ SEMICOLON 
Current date and time: Press CTRL+ SEMICOLON then SPACE then CTRL+SHIFT+ SEMICOLON 

In Access, this keyboard shortcut only works if you are entering data in the Datasheet or Form
view.

Note: When you insert the date and time using this tip, the information remains static. To
update this information automatically, you must use the TODAY and NOW functions. To learn
how to do this, search for Insert the current date and time in a cell in Excel Help and then click
Insert a date or time whose value is updated. 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

George Lucas Educational Foundation (GLEF) publishes five weekly e-newsletters -- the
original Edutopia News and four topic-specific publications: Assessment, Project-Based
Learning, Social & Emotional Learning, and Technology Integration. These newsletters are free,
quick-to-read weekly resources for news, opportunities, and inspiring stories from the frontlines
of K-12 education. You may subscribe to one, two, or more. Each week, these e-newsletters
provide concise editorial highlights from other news sources, information on grants and other
resources, and links to what's new on our Web site
http://www.edutopia.org/products/edutopianews.php 

From GLEF ... Getting Scheduling Under Control by Susan Tidyman. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

EverNote® is a FREE note-taking application - designed for users of all Desktops, Laptops and
Tablets.
http://www.evernote.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.edutopia.org/products/edutopianews.php
http://www.edutopia.org/community/spiralnotebook/?p=24
http://www.evernote.com/en/
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Cl1p.net. It's a Web-based clipboard that allows you to move text between computers. Simply
go to the root web address (http://cl1p.net/), add your folder at the end (e.g.,
http://cl1p.net/rsabella), and then place text and/or files for others to retrieve. For others to
get the info, just send them to your special URL. Pretty cool! Click here for more details.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

AOL@SCHOOL provides educator-reviewed classroom resources for K-12 students and
teachers in math, science, language arts, social studies and more. Here you can quickly find
activities, research materials, educational games, multimedia resources and lesson plans for
primary, elementary, middle and high school classes.

http://www.aolatschool.com/students 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

GoCityKids gives you shortcuts to the city at its best—its parks, stores, professional services,
restaurants, babysitters, places to stay, and entertainment, among other things. It's the answer
to all those times you've wondered how to begin your search for afterschool activities, day
camps, sports equipment, or a good pediatrician. Or what to do on a rainy Sunday, where to
throw a party for an eight-year-old, and how to find camping equipment you can rent. 
http://www.gocitykids.com/choose/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

www.72hours.org
Imagine that you have no electricity, no gas, no water and no telephone service. Imagine that
all the businesses are closed and you are without any kind of emergency services. What will
you do until help arrives? 
http://www.72hours.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Above the Influence
“You may be wondering who's behind this Web site and what our motivation is. Well, this Web
site and the Above the Influence ads you see on TV and in magazines are created for the
National Youth Anti-Drug Media Campaign (a program of the Office of National Drug Control
Policy). This campaign reflects what teens across the country have told us is going on in their
lives. Our goal is to help you stay above the influence. The more aware you are of the
influences around you, the better prepared you will be to stand up to the pressures that keep
you down. We're not telling you how to live your life, but are giving you another perspective
and the latest facts. You need to make your own smart decisions.”

http://cl1p.net/
http://cl1p.net/more.html
http://www.aolatschool.com/students
http://www.gocitykids.com/choose/
http://www.72hours.org/
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http://www.abovetheinfluence.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google U.S. Government Search offers a single location for searching across U.S.
government information, and for keeping up to date on government news. You can choose to
search for content located on either U.S. federal, state and local government websites or the
entire Web -- from the same search box. Below the search box, the homepage includes
government-specific news content from both government agencies and press outlets.  You can
personalize the page by adding content feeds on government or other topics that you're
interested in. 
http://www.google.com/ig/usgov 

____________________________________________

JUST FOR FUN

Quite inspirational! An Interview with God.
http://168.143.173.209/IWG_net.swf 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Museum of Unnatural Mystery
http://www.unmuseum.mus.pa.us/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Shopping Bargains 
Online coupon codes & bargains for 1000+ online stores
http://www.shopping-bargains.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Best Sites for Children: Just for Fun
Lots of fun activities.
http://www.beritsbest.com/categories.php?c=40 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Amazing Video from YouTube
This 3150 m long tunnel in Russia is the longest in-city tunnel of Europe. There is a river
running over it and water leaks at some points. When the temperature reaches -38 degrees like

http://www.abovetheinfluence.com/
http://www.google.com/ig/usgov
http://168.143.173.209/IWG_net.swf
http://www.unmuseum.mus.pa.us/
http://www.shopping-bargains.com/
http://www.beritsbest.com/categories.php?c=40
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it did this winter, the road freezes and the result is the attached video taken during a single day
with the tunnel camera. 
http://www.youtube.com/watch?v=CdBFi5ug7gE 

This one is also a must see: 
http://www.youtube.com/watch?v=PmZyB_ghpa0

~~~~~~~~~~~~~~~~~~~~~~~~~~~

WFTV News of the Strange
View 99 unusual photos capturing a variety of strange news. New photos are added
frequently! 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Theme Park Insider is a consumers' guide to the world's most popular theme and
amusement parks, written by consumers themselves. It has been named the top theme park
site on the Internet by Forbes and Travel + Leisure magazines and has been a finalist for the
Webby Award for best overall Guide/Ratings/Reviews site.
http://www.themeparkinsider.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Breathtaking-Photos.com
This website has no ads, no membership and no hassle.  The site is provided as a free service
to brighten your day.  The brilliant pictures on this site are specifically designed to give you a
little lift in the morning.  You can help this website by telling a friend or linking to this website.
http://www.breathtaking-photos.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Coming Soon
Before spending your heard-earned money on a movie, you might want to do your research.
One of the best ways to do so is with Coming Soon's guide to new releases, courtesy of the
Weekend Warrior.
http://www.comingsoon.net/ 

____________________________________________

http://www.youtube.com/watch?v=CdBFi5ug7gE
http://www.youtube.com/watch?v=PmZyB_ghpa0
http://www.wftv.com/slideshow/news/2691965/detail.html?qs=;s=1;w=480
http://www.themeparkinsider.com/
http://www.breathtaking-photos.com/
http://www.comingsoon.net/
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SchoolCounselor.com eNewsletter #64 - July 7, 2006

It's not a bug - it's an undocumented feature.  ~Author Unknown

I just wish my mouth had a backspace key.  ~Author Unknown

____________________________________________

Technology Training and more for Counselors
Download a booklet with comprehensive descriptions of technology training and resources for
counselors (PDF; 116KB).
http://www.schoolcounselor.com/pdf/booklet.pdf 

Guarding the Innocent: Technology Safety Among Children 
This page is designed to support Dr. Sabella's workshop for parents: Guarding the Innocent:
How Parents and Care Takers Can Help Kids Stay Out of High-Tech Trouble. The goal of the
seminar is to alert parents, educators and other caretakers about the dangers that technology
poses to children and to give them tools they can readily use to keep kids safe and away from
high tech trouble. The workshop covers topics such as social networks (e.g., Myspace.com),
sexual predators, threats to privacy such as online diaries/blogs, cyberbullying and hate,
inappropriate web sites and other materials, inappropriate use of gadgets such as cell phones,
mp3 players, game appliances, and electronic communication such as e-mail, instant
messaging, chatrooms and bulletin boards. Visit http://www.schoolcounselor.com/safety for
more details. 

I collect inspirational stories and thought I’d share one in this newsletter:

Who Are You?

A daughter complained to her father about her life and how things were so hard for her. She
did not know how she was going to make it and wanted to give up. She was tired of fighting
and struggling. It seemed as one problem was solved a new one arose.

Her father, a chef, took her to the kitchen. He filled three pots with water and placed each on a
high fire. Soon the pots came to a boil. In one he placed carrots, in the second he placed eggs,
and the last he placed ground coffee beans. He let them sit and boil, without saying a word.

The daughter sucked her teeth and impatiently waited, wondering what he was doing. In about
twenty minutes he and turned off the burners. He fished the carrots out and placed them in a

http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.schoolcounselor.com/safety
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bowl. He pulled the eggs out and placed them a bowl. Then he ladled the coffee out and placed
it in a bowl.

Turning to her he asked. "Darling, what do you see."

"Carrots, eggs, and coffee," she replied.

He brought her closer and asked her to feel the carrots. 
She did and noted that they were soft.

He then asked her to take an egg and break it. 
After pulling off the shell, she observed the hard-boiled egg.

Finally, he asked her to sip the coffee. 
She smiled as she tasted its rich aroma.

She humbly asked. "What does it mean Father?"

He explained that each of them had faced the same adversity, boiling water, but each reacted
differently.

The carrot went in strong, hard, and unrelenting. 
But after being subjected to the boiling water, it softened and became weak.

The egg had been fragile. Its thin outer shell had protected its liquid interior. 
But after sitting through the boiling water, its inside became hardened.

The ground coffee beans were unique however. 
After they were in the boiling water, they had changed the water.

"Which are you," he asked his daughter.

"When adversity knocks on your door, how do you respond?
Are you a carrot, an egg, or a coffee bean?"

 
____________________________________________

http://www.schoolcounselor.com
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TIPS AND TRICKS

Microsoft Excel™: Navigating to Beginning and End of Spreadsheet
While navigating a Microsoft Excel™ 2003 worksheet, do you ever need to navigate to the first
cell in a given row or the first row in a given column? Instead of using the scroll bars or holding
down the cursor keys, the following shortcuts will work:

HOME or CONTROL+LEFT ARROW - First column in the row
CONTROL+UP ARROW - First row in the column

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Playing Music Continuously in a Web-Based Presentation 
Source: http://www.ellenfinkelstein.com/powerpoint_tip.html#slidelist 

1. You can play music continuously during a presentation that you have posted
to a Web site. The effect is quite striking. Because you usually are not
narrating, the music doesn't interfere, as it would if you were delivering a
presentation live. Here's the technique: 

2. Choose File> Save as Web Page. In the Save as Type drop-down list, make
sure that the type is Web Page (*.htm; *.html), not Single File Web Page. 

3. Click Publish. Click Web Options and choose the settings that you want. 
4. Click Publish again to publish the presentation. 
5. Find the frame.htm file in the folder that contains all the presentation files.

Shift+right-click and choose Open With to open it with Notepad. You'll see
the HTML code for the file.  

6. After the <html> tag but before the <head> tag, add the following. Within
the quotes, put the name of the music file you want to use. I've successfully
tried MID, MP3, and WMA files. 

<bgsound src="harpsichord.mid" loop=infinite>

7. Save the file and close Notepad. 
8. Copy the music file to the same folder as the presentation. The folder is

called [filename]_files.  
9. Open frame.htm in Internet Explorer and the music should play and loop

continuously. 
10. Upload the files to your Web site!  

To see an example in action go to a Quarterly Sales Report sample presentation. The music
takes 36 seconds to complete one run-through and the presentation is only 4 slides long, so
give the music a chance to loop. This presentation is from the tutorial at the beginning of my

http://www.ellenfinkelstein.com/powerpoint_tip.html#slidelist
http://www.ellenfinkelstein.com/quarterlysalesreport_files/frame.htm
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book, How to Do Everything with Microsoft Office PowerPoint 2003. For a complete tutorial that
includes how to make a presentation open full-screen, go to Michael Koerner's tutorial. 

Relatedly, visit Publishing a Presentation to the Web by Ellen Finkelstein author of PowerPoint
2000 Professional Results published by Osborne/McGraw-Hill.
http://www.ellenfinkelstein.com/Publishing_files/frame.htm

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Create a summary slide
PowerPoint has a nice feature that creates a summary, or agenda, slide automatically from all
the slides in the presentation. But did you know that you can choose which slides from the
presentation appear on the summary slide?
http://www.ellenfinkelstein.com/powerpoint_tip_summary_slide.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Quiz Games
Examples of Jeopardy style games you can download and alter.
http://www.echosvoice.com/jeopardy.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Play sound or music by passing mouse over an icon (without
clicking)

Source: http://www.ellenfinkelstein.com/powerpoint_tip_mouseover.html 

You can play a sound or music file on a slide without clicking the mouse. Usually, you insert a
file by choosing Insert > Movies and Sounds > Sound from File. You see a sound icon on the
slide. A dialog box asks you if you want to play the sound automatically or when you click the
icon. If you want control over when the sound plays, you choose to click. 

There's another way to play a sound -- by passing the mouse over the icon. Follow the previous
instructions to insert the sound. Then follow these steps: 

Select the icon. 

Choose Slide Show > Action Settings and click the Mouse Over tab. 

Click the Object Action option and choose Play (the default) from the drop-down list. 

http://www.oldfco.ca/tutorial/pptohtml_files/fullscreen.html
http://www.amazon.com/exec/obidos/ASIN/0072119934/schoolcounselorc
http://www.amazon.com/exec/obidos/ASIN/0072119934/schoolcounselorc
http://www.ellenfinkelstein.com/Publishing_files/frame.htm
http://www.ellenfinkelstein.com/powerpoint_tip_summary_slide.html
http://www.echosvoice.com/jeopardy.htm
http://www.ellenfinkelstein.com/powerpoint_tip_mouseover.html
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Click OK. 

If you hide most of the icon behind another object, it won't be conspicuous. When you pass the
cursor over the icon, a hand or hourglass may appear, but you can move the cursor away from
the icon and the sound or music will play.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Buttonator 
Buttonator is extremely easy to use. Button templates are on the right. Click and drag the one
you want into the "Button Preview" window. Click on the text to change it. Once you're satisfied
with that (the button will automatically resize so it's appropriate for your text) look below the
preview window. There you can change the properties of the button text (font (selection is
somewhat limited), font size, and the width of the button) and the color of the button and
button text. Once you're satisfied with the button you can download it as a .gif file. 
This button maker isn't a substitute for making superfancy buttons, or even a button with
unusual fonts. But when you quickly need to knock up a button for a Web page, this is really
handy!
http://www.buttonator.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Stuck CD in the CD Drive?
Source: http://www.worldstart.com
Have you ever gotten a disk stuck in its drive, whether it's been a floppy disk or a CD? You've
tried to get it out, but nothing seems to work. You've pressed the button a million times, tried
to open it by right clicking the drive and choosing Eject and maybe you even contemplated
using a screw driver to pry the thing open. What a nightmare! Well, before you break out the
screwdriver and try to surgically remove the disk (or worse, buy a new drive), try this simple
little trick to manually open your disk drive tray. 

1. Unwind a paperclip.
2. Stick it in the little hole on the drive tray, usually near the Eject button.

That’s right. There's a little hole you probably never even noticed. It's the manual release for
the drive tray. That should do the trick.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.buttonator.com/
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Microsoft Outlook 2003: Keep track of Birthdays and Anniversaries 
Learn to enter annual events into your Microsoft® Outlook® calendar and to link those events
with people in your Contacts folder. Also, learn to set reminders and to create personalized
calendar views. Check out this free online course. 
____________________________________________

WORTHY WEBSITES AND SOFTWARE

Microsoft USB Flash Drive Manager (Standard)
USB flash drives are compact and easy-to-use devices that are similar in use to your computer
hard drive. USB flash drives slip into your pocket, conveniently around your neck or on a
keychain for ultimate portable storage. USB flash drives in 2005 can hold up to 4 gigs of data,
which is over 1700 three-minute songs (66 hours) recorded as MP3s or about three times the
content of a standard compact disc. If you share a computer, USB flash drives are a great way
to store personal information. USB Flash Drives are also a great option for saving information
and share it with others. When you have many things to save and share but you have a limited
number of USB Flash Drives, you will need to backup the information and restore it when
needed. This is where the Microsoft USB Flash Drive Manager application can help you. The
Microsoft USB Flash Drive Manager will help you backup and restore presentation, pictures,
songs and applications from and to USB Flash Drive devices and take them with you. The
application can also help you to classify and name USB Flash Drives images (for instance "My
network configuration" or "The pictures for my grandma") and lets you see this name whenever
the USB Flash Drive is plugged into the computer. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Oldapps.com
Recently, I discovered that the latest version of Google Desktop, a program I highly rely on,
was crashing Microsoft PowerPoint, a program I rely on even more. What to do. I went back
the Google website to see if I could install an older version which seemed to work fine, no luck.
However, I found a website that archives older versions which did the trick. Sometimes adding
features to an already good program can ruin it so it’s a good thing for this website.
http://www.oldapps.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Nvu (pronounced N-view)
Finally! A complete Web Authoring System for Linux desktop users as well as Microsoft
Windows and Macintosh users to rival programs like FrontPage and Dreamweaver. Nvu (which
stands for "new view") makes managing a web site a snap. Now anyone can create web pages
and manage a website with no technical expertise or knowledge of HTML.
http://www.nvu.com/index.php 

http://office.microsoft.com/training/training.aspx?AssetID=RC060823511033
http://www.microsoft.com/downloads/details.aspx?FamilyID=94991901-bfc4-485e-bcae-c9df0accdaae&DisplayLang=en
http://Www.oldapps.com
http://www.nvu.com/index.php
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Trends
This is neat. Google Trends aims to provide insights into broad search patterns. As a Google
Labs product, it is still in the early stages of development. Check out a special Google Trend
here. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

AndreaMosaic. With this freeware program you can create your own photographic mosaics
made with your own pictures. A photographic mosaic is a mosaic where every tile is a
photograph and not just a simple colored piece. 
http://www.andreaplanet.com/andreamosaic/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Startup Control Panel
Startup Control Panel is a nifty (and free) control panel applet that allows you to easily
configure which programs run when your computer starts. It's simple to use and, like all my
programs, is very small and won't burden your system. Startup Control Panel is compatible with
all modern versions of Windows, including Windows 95, 98, 98SE, ME, NT 4.0, 2000, and XP.
http://www.mlin.net/StartupCPL.shtml 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

eCoordinatorTM Accounts
If your organization is a bona fide 501(c)(3) not-for-profit organization or a K-12 school, we will
set you up with an eCoordinatorTM account that will allow you to keep track of up to 100
volunteers and an unlimited number of organizations and service opportunities, and we will
waive the $20 per month fee for the first user. If you want, you can add additional users for the
normal not-for-profit additional user price of just $20 per month. What does this mean? It
means that if you are a small, non-profit agency, or K-12 school you can have a single user
eCoordinatorTM account for free!
http://www.samaritan.com/free.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

iRiverter
iriverter is a cross-platform frontend to mencoder designed to facilitate the conversion of almost
any video format to one that is playable on various multimedia players.
http://iriverter.sourceforge.net/ 

http://www.google.com/trends?q=school+counselor%2C+guidance+counselor&ctab=0&geo=all&date=all
http://www.andreaplanet.com/andreamosaic/
http://www.mlin.net/StartupCPL.shtml
http://www.samaritan.com/free.php
http://iriverter.sourceforge.net/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

StudyStack.com strives to help people learn what they want to learn.  The StudyStackTM
concept was designed to help people memorize information about various subjects.  Using the
StudyStack web site, you use your computer to display a stack of "virtual cards" which contain
information about a certain subject.  Just like flashcards, you can review the information at
your own pace discarding the cards you've learned and keeping the ones you still need to
review.  However, unlike traditional flash cards, each card can show multiple pieces of
information; and the whole stack can be automatically sorted by any one of the pieces of
information.  Also, when you enter the data for a studystack, the same data can automatically
be displayed as flashcards, a matching game, a word search puzzle, and a hangman game. 
You can also export the data to your cellphone or PDA so you can review it when you are away
from the computer. 
http://www.studystack.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

eCleaner "cleans up" unformatted text from e-mail and the Web by removing HTML tags,
arrow characters, hard returns, and other distracting formatting.
http://ecleaner.tripod.com/clean202.zip 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Volumouse v1.31 - Control the sound volume with a wheel mouse 
Volumouse provides you a quick and easy way to control the sound volume on your system -
simply by rolling the wheel of your wheel mouse. 
It allows you to define a set of rules for determining when the wheel will be used for changing
the sound volume. For example: You can configure Volumouse to use your mouse wheel for
volume control when the Alt key is hold down, when the left mouse button is down, when the
mouse cursor is over the taskbar, and so on... When the conditions that you define are not
satisfied, your mouse wheel will be used for the regular scrolling tasks, exactly as before. 
http://www.nirsoft.net/utils/volumouse.html 

____________________________________________

JUST FOR FUN

Criss Angel Pulls Woman Apart
Magic trick ... this guy is good.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.studystack.com/
http://ecleaner.tripod.com/clean202.zip
http://www.nirsoft.net/utils/volumouse.html
http://smg.photobucket.com/albums/v299/oedipa/?action=view&current=Magic-Pullapartgirlwmv.flv
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Burlingame Museum of Pez Memorabilia 
Opened in 1995, the Burlingame Museum of Pez Memorabilia is the only place in the world to
see every Pez candy dispenser ever made. Over 55 years of dispensers and memorabilia are on
display. The Burlingame Museum of Pez Memorabilia has been featured on Ripleys Believe It or
Not, The London Times, CNN, CBS Morning Show, Good Morning America and The Food
Network. Now you can take a FREE audio tour or podtrip.
http://www.podtrip.com/english.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Sabertooth Paper Airplane
http://www.geocities.com/chouhung/saber.html 

Also see http://bestpaperairplanes.com/ 

____________________________________________

http://www.podtrip.com/english.html
http://www.geocities.com/chouhung/saber.html
http://bestpaperairplanes.com/
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SchoolCounselor.com eNewsletter #65 - July 26, 2006

Computer Professional's Words of Wisdom

The computer gives us true multitasking. I can write my resume and a
report for my boss at the same time! – Anonymous.

Computers have made me much more productive. I mean, look at e-
mail? I no longer have to talk to anyone at work. In fact, I haven’t
spoken a word to anyone in the office in 5 days" – Anonymous.

___________________________________________

Blogs and Real Simple Syndication (RSS)

This article is to let you know about a technology that has been around for a while although
has seemingly not caught on yet with school counselors – Blogging and Real Simple Syndication
or RSS. Blogging technology has the potential to more easily and efficiently help you deliver
important information (e.g., scholarship, parenting, valuable web sites, etc.) to your students
and stake holders. 

You've probably heard the term blog more than once, most likely used on television or print
news media. However, you may still not exactly understand what a blog is. According to the
Webopedia (see http://www.webopedia.com/TERM/b/blog.html), a blog, short for "web log",  is
a web page that serves as a publicly accessible personal journal for an individual. Typically
updated on a daily basis, blogs often reflect the personality of the author.  Google owned
Blogger.com describes a blog as, "A blog is a personal diary. A daily pulpit. A collaborative
space. A political soapbox. A breaking-news outlet. A collection of links. Your own private
thoughts. Memos to the world."  Blogs are also now common staple for any professional that
needs to provide timely and important information to his or her constituents, subscribers, or
interested others. 

Creating a blog is simple and free and it only takes a few minutes. Begin by entering your
name, e-mail address and a few other pieces of (usually personal) information. You select "the
look" (template) for your blog from a set of standard options, click a few buttons, and another
blog has been added to the "blogosphere." Once the blog is set up you can post text, links,
audio and video to your hearts delight. From a computer or cell phone, you can say or show
anything and everything. With a bit of know-how, you can even easily syndicate to other blogs
and web sites. 

http://www.netscrap.com/netscrap_detail.cfm?scrap_id=47
http://www.webopedia.com/TERM/b/blog.html
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According to HowStuffWorks.com (http://computer.howstuffworks.com/blog1.htm), blogs
feature several unique characteristics such as: 

• A typical blog has a main page and nothing else. On the main page, there is a
set of entries. Each entry is a little text blurb that may contain embedded
links out to other sites, news stories, etc. When the author adds a new entry,
it goes at the top, pushing all the older entries down. This blog also has a
right sidebar that contains additional permanent links to other sites and
stories. The author(s) might update the sidebar weekly or monthly. 

• A blog is organized in reverse-chronological order, from most recent entry to
least recent. 

• A blog is normally public -- the whole world can see it (although some
services allow for password protected blogs as well).

• The entries in a blog usually come from a single author (although can easily
be developed by a committee, team, or other group of individuals). 

• The tools that most bloggers use make it incredibly easy to add entries to a
blog any time they feel like it. 

The technology that allows individuals like school counselors (or organizations, especially news
agencies) to write one's own blog is so relatively simple and inexpensive that it is no surprise
they have proliferated the Web as fast as they have. Here are just a few of the services
available.

• Blogger (http://www.blogger.com/): Free, automated weblog publishing
platform in one easy to use website. I highly recommend this one as an easy
and free way to take advantage of blogging services.

• BBlog (http://www.bblog.com/): bBlog is a powerful, elegant personal
publishing system written in PHP and released as free, Open Source software
under the GPL. It is a flexible but simple way to blog that works for blogging
beginners, and can grow into a more advanced user's needs.

• TypePad (http://www.sixapart.com/typepad/): Similar to blogger, another
blogging service although this one has a minimal cost. 

• LiveJournal (http://www.livejournal.com/): Joining this service site is free
although users can choose to upgrade their accounts for extra features.

• Moveable Type (http://www.sixapart.com/movabletype/): “Movable Type is
a blogging and content management platform for professional bloggers and
medium and small businesses. There is a free version although it comes with
no support. 

With a bit of know how, you can even have your blog published on your own counseling
website (you will have to work with your school technology professionals to do this on your
school or district server). For instance, upon setting up a blog at Blogger.com, click on the

http://computer.howstuffworks.com/blog1.htm
http://www.blogger.com/
http://www.bblog.com
http://www.sixapart.com/typepad/
http://www.livejournal.com/
http://www.sixapart.com/movabletype/
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Advanced Options which allows you to direct your blog to a folder on your own website. An
example of this is how the Florida School Counselor Association posts news and legislative
information. What is really neat is that once your blog is established, you can set it up so that
you can post to it directly via e-mail! That’s right. Just send an e-mail to a special address
known only to the blogger and the content of the e-mail immediately gets posted to the online
blog. 

Advantages of Setting up a Blog

From a content provider perspective, it is much easier to post information using a simple form
as compared to using a web authoring program which requires you to open the program, log
into your website, get your file, edit, and save. In the case of Blogger.com, you can quite easily
post information to your blog by e-mail or directly from Microsoft Word™ by using a free plugin
(see http://buzz.blogger.com/bloggerforword.html). Blogs also provide perks from the
consumer perspective. For one, you can more easily have access to current and past
information because all posts are archived and searchable. Depending on the specific blogging
service you use, you can do a variety of things with each post. At blogger.com, each post has a
link next to it that looks like a small envelope. Clicking on this link will allow anyone to easily
forward the information to others via e-mail. Each post also has its own website address so you
can refer others to the post and they won’t have to search for it among other posts. Another
advantage of blogging is that, if you select the option, readers can post comments making the
blog somewhat interactive. 

Real Simple Syndication (RSS)

One of the biggest advantages of using blogs from a consumer perspective is that you can have
these posts automatically delivered to you without having to keep checking the website for
updates! Parents, teachers, kids, and others can automatically receive your posts within
seconds. Your blog can be one of many others of interest and so the consumer can quickly
check several blogs all at once. Two basic steps are involved: First, your blogging service
creates a blog or RSS “feed” which contains some basic information about your posts. The feed
is updated every time you post information. You can indicate the availability of your RSS feed
by promoting your RSS link which, on most sites, is indicated with a small orange icon with the
acronym RSS. 

Second, the blog consumer uses a feed reader also known as aggregator. The reader
subscribes to the blog by pointing the feed reader to the blog’s feed and clicking on
“subscribe.” RSS feeds are even more efficient than listservs because the information is
instantly available to you once your RSS aggregator checks the feed as compared to waiting for
an e-mail to arrive, if it ever does given the new attention on spam blocking. 

http://www.fla-schoolcounselor.org/news/index.htm
http://www.fla-schoolcounselor.org/legislation/
http://buzz.blogger.com/bloggerforword.html
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As the mainstream media attempts to realize the full potential of RSS, the news media in
particular is utilizing RSS by bypassing traditional news sources. Consumers and journalists are
now able to have news constantly fed to them instead of searching for it. School counselors can
also enjoy such power as it pertains to their work. 

How do I get the Feeds? 

Of course, parents, kids, and stake holders can continue to use the traditional method of
periodically checking your website for new information. But with a small investment of time to
set it up once, automatically receiving RSS feeds can open a new world of instant news, not
just in counseling but in a myriad of other areas as well. There are different ways to subscribe
to a feed, you need only do one of the following, whichever is best for you:

• Use the latest web browser such as Internet Explorer 7 which comes with a
RSS aggregator. You can download the latest version by going to
http://www.microsoft.com/windows/ie/. This software is still in “beta”
version which means it’s still somewhat experimental although I’ve been
using it now for several months without any problems. Realize too that this
latest version of Internet Explorer uses other new features such as Tabbed
browsing and advanced security features which is a plus. Also, the Firefox
browser, available as a convenient download from
http://www.schoolcounselor.com/resources/ has the ability to collect news
feeds called Live Bookmarks. Visit
http://johnbokma.com/firefox/rss-and-live-bookmarks.html for a very nice
and short tutorial for using this feature. 

• You can also use free RSS aggregator software which can stay open in the
background and collect your news for you. One such program is Feedreader
(http://www.feedreader.com/). Another is Pluck
(http://www.pluck.com/products/getpluck.html). Also know that if you have
a Google account, you can use the Google Reader at
http://reader.google.com. 

• Even more conveniently, you can use an e-mail program that comes with an
RSS aggregator. This means that you can check e-mail and news feeds at the
same time! For instance, Thunderbird is a free and popular e-mail program
that will do the trick. You might also check to see if your current e-mail
program has available an RSS feed reader add-on. For example, if you use
Microsoft Outlook, check out Newsgator
(http://www.newsgator.com/home.aspx). If you have a Yahoo account,
check out http://my.yahoo.com/s/about/rss/index.html.  Although I don’t

http://www.microsoft.com/windows/ie/
http://www.schoolcounselor.com/resources/index.htm
http://(http://www.mozilla.com/firefox/)
http://johnbokma.com/firefox/rss-and-live-bookmarks.html
http://(http://www.feedreader.com/).
http://www.pluck.com/products/getpluck.html
http://reader.google.com.
http://(http://www.newsgator.com/home.aspx).
http://my.yahoo.com/s/about/rss/index.html.


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 168

have a Gmail account from Google, I’m told that this service also includes a
nice news feed collector or aggregator. 

To subscribe to a specific news feed, just plug in the address of the feed, an address that
typically ends in XML (e.g., www.fla-schoolcounselor.org/news/rss.xml or
http://www.fla-schoolcounselor.org/legislation/rss.xml) to subscribe. That’s it. If you are using
a web browser with RSS capabilities (as mentioned in #1), you can just click on the little
orange icon.  For an online tutorial to help you get the hang of RSS, check out
http://www.askdavetaylor.com/how_do_i_subscribe_to_an_rss_feed.html. 

If I had to make a recommendation to you, I would go with a browser, either the new Microsoft
Internet Explorer version 7 or Firefox, or use the free Thunderbird e-mail program. It seems to
be the easiest and quickest way to subscribe to news feeds. As a side note, I’ve even found
that using the IE7 feed aggregator makes it easy to check on the American School Counselor
Association (ASCA) bulletin boards. Just log in, click on the orange RSS icons next to the topic,
and then click on subscribe. The only catch is that you have to log into the bulletin board
system first with your user id and password for the feeds to be updated. 

Other Examples of School Blogs

Carpinteria Middle School Principal's Blog
http://www.sbceo.org/~cms/boblog/blog.html 

HS Blog - HomeSchool Blog
http://hsblog.org/index.php

The DC Education Blog
http://dcedublog.blogspot.com/

Florida School Counselor Association Blog
http://www.fla-schoolcounselor.org/news/

Weblogs in Higher Education
http://www.mchron.net/site/edublog.php?id=C0_84_13

Education News
http://www.topix.net/education 

Professors Who Blog
http://rhetorica.net/professors_who_blog.htm 

http://www.fla-schoolcounselor.org/news/rss.xml
http://www.fla-schoolcounselor.org/legislation/rss.xml
http://www.askdavetaylor.com/how_do_i_subscribe_to_an_rss_feed.html
http://www.sbceo.org/~cms/boblog/blog.html
http://hsblog.org/index.php
http://dcedublog.blogspot.com/
http://www.fla-schoolcounselor.org/news/
http://www.mchron.net/site/edublog.php?id=C0_84_13
http://www.topix.net/education
http://rhetorica.net/professors_who_blog.htm
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Blogging Help

How to use Google Reader Video Tutorial
http://andywibbels.com/flash/google_reader.htm 

Blogger.com Help
http://help.blogger.com/

Blogging Basics from Technorati
http://www.technorati.com/help/blogging101.html 

Blog Basics
http://www.blogbasics.com/ 

Research Buzz Blogging Help
http://www.semiologic.com/resources/help-with-feeds/ 

Blogging and RSS — The "What's It?" and "How To" of Powerful New Web Tools for Educators 
by Will Richardson, Supervisor of Instructional Technology, Hunterdon Central Regional High
School.
http://www.infotoday.com/MMSchools/jan04/richardson.shtml 

____________________________________________

TIPS AND TRICKS

Virtual Presentation Assistant 
Virtual Presentation Assistant is an online tutorial dedicated to the art and skill of public
speaking, and the site is maintained by the dedicated staff of the communication studies
department at the University of Kansas. Simple in its design, the site covers such topics as
selecting an appropriate theme for a speech, how to research said speech, and supporting your
primary points. If all of this material doesn’t whet one’s appetite, the site also contains a
selection of links to other sites that deal with the subject at hand.
http://www2.ku.edu/~coms/virtual_assistant/vpa/vpa.htm

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Artpad
A free online art program that could work well in counseling.
http://artpad.art.com/artpad/painter/ 

Also check out a free art/drawing program at http://ambientdesign.com/ 

http://andywibbels.com/flash/google_reader.htm
http://help.blogger.com/
http://www.technorati.com/help/blogging101.html
http://www.blogbasics.com/
http://www.semiologic.com/resources/help-with-feeds/
http://www.infotoday.com/MMSchools/jan04/richardson.shtml
http://www2.ku.edu/~coms/virtual_assistant/vpa/vpa.htm
http://artpad.art.com/artpad/painter/
http://ambientdesign.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Basic Tutorial
This is a basic tutorial of Excel.
http://www.usd.edu/trio/tut/excel/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet con artists turn to 'vishing'
A must read story.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

McAfee SiteAdvisor
SiteAdvisor was founded in April 2005 by a group of MIT engineers who wanted to make the
Web safer for their family and friends. Having spent one too many holiday breaks trying to
clean a mess of spam, adware, and spyware from our families' computers, we decided to take
action. 
http://www.siteadvisor.com/ 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Google Government Search with State Filtering
This page allows you to search Google’s government search engine and narrow your results by
a state. Try adding a city or county name to your query as well. For example, if you’re
searching for food stamp information, you might want to search for “food stamps” “example
county” instead of just “food stamps”
http://www.researchbuzz.org/wp/tools/googlestatesearch/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Gliffy: Online Service for Creating and Sharing Flow Charts or Diagrams
Gliffy is an online service that allows you to create flow charts and other diagrams online. At
the moment it’s in beta, and it’s free. To use it you’ll first have to register, which requires just a
user name and a password. Once you’ve registered you’ll be asked to name your first
document. Once that’s done you’re left alone with a piece of virtual grid paper and several sets
of diagram icons on the left, including flow chart, network, user interface and floor layout. 
http://gliffy.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.usd.edu/trio/tut/excel/
http://www.usatoday.com/tech/news/internetprivacy/2006-07-12-vishing-scam_x.htm?csp=34
http://www.siteadvisor.com/
http://www.researchbuzz.org/wp/tools/googlestatesearch/
http://gliffy.com/
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TeensReadToo.com
The ultimate place for all things related to Young Adult & Teen Fiction (and Non-Fiction, too!).
Book reviews, author interviews, spotlight pages, contests, an up-to-date book release
calendar, and the world's largest young adult/teen author directory.
http://www.teensreadtoo.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

KeePass
Passwords are a part of our everyday life. We use them for e-mail, online banking and stock
trading, shopping sites and blogs. For good security, you should have a different password for
each need. But how can anyone remember so many passwords? A password manager is a
great way to consolidate all those passwords without compromising security. Generally, a
password manager is a program that stores all of your passwords for you. All of those
passwords are kept secure with—you guessed it—a password.
http://keepass.sourceforge.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Portable Thunderbird is the full-feature e-mail program that you can take wherever you go.
That means your address book and saved messages travel with you as well. It can be set up for
multiple e-mail accounts and offers the mobile convenience of Webmail. You'll need 8.9 MB of
space to put Portable Thunderbird on your thumb drive.
http://portableapps.com/apps/internet/email/portable_thunderbird

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Blogger for Word
Blogger for Word is a free add-in for Microsoft Word™ that lets you save a Word document as a
post to your Blogger blog with just a few clicks, and without even opening up a browser.
Blogger for Word makes it even easier to express yourself online, save your documents to the
web, and edit your work both online and off. With Blogger for Word, publishing a Word
document to your blog is just as seamless as saving it to your computer, and it's easy to get
started; all you need to do is download and install the Blogger for Word add-in, and three
buttons appear in your Word toolbar: Publish creates and publishes a new post from the text in
your document; Open Post enables you to edit your last 15 Blogger posts in Word; Save as
Draft enables you to keep a post unpublished; it will appear in your Blogger account, but not
publicly on your blog.
http://buzz.blogger.com/bloggerforword.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.teensreadtoo.com/
http://keepass.sourceforge.net/
http://portableapps.com/apps/internet/email/portable_thunderbird
http://buzz.blogger.com/bloggerforword.html
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Rootkit Revealer
Source: http://www.komando.com/downloads/category.aspx?id=1546 
A rootkit is a tool that can distort Windows' most basic operations to hide itself. A rootkit can
make Windows hide the programs it runs. That means anti-virus and other security programs
can be fooled. Even if you know what files to seek out, Windows may not acknowledge that
they're on your hard drive. Rootkits also can be used to hide worms and other malicious
programs. That's why they are normally considered malicious. The worst damage is done when
a rootkit is used to create and hide a hacker's control of your computer. Most antispyware
programs will detect a rootkit. But if the program you are using does not, try this free rootkit
revealer.
http://www.sysinternals.com/Utilities/RootkitRevealer.html 

____________________________________________

JUST FOR FUN

Popcurrent
PopCurrent is a new, democratic way for the people to decide what media becomes popular.
The rank of a particular media link rises and falls on the front page depending on how may
people vote for it -- or against it.
http://www.popcurrent.com 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Musicbox
The best artists. The best videos. And the video codes to put them on your site!
http://www.sonybmg.com/musicbox/ 

____________________________________________

SUBSCRIPTION

Visit http://www.schoolcounselor.com/newsletter to subscribe or unsubscribe from this
newsletter. To change your e-mail address, please subscribe your new address and unsubscribe
your old one.
____________________________________________

http://www.komando.com/downloads/category.aspx?id=1546
http://www.sysinternals.com/Utilities/RootkitRevealer.html
http://www.popcurrent.com
http://www.sonybmg.com/musicbox/
http://www.schoolcounselor.com/newsletter
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SchoolCounselor.com eNewsletter #66 - August 15, 2006

Microsoft Outlook Tips and Tricks Handout
http://www.schoolcounselor.com/pdf/Sabellas%20Outlook%20Tips.pdf 

Updated: Technology Safety Links
http://www.schoolcounselor.com/safetynetlinks.asp 

Technology Training and More for Counselors
Download a booklet with comprehensive descriptions of technology
training and resources for counselors (PDF; 116KB).
http://www.schoolcounselor.com/pdf/booklet.pdf 

Guarding the Innocent: Technology Safety Among Children
http://www.schoolcounselor.com/safety/ 

Posters On Sale!
Some as low as $5.99.
_____________________________________________

Counseling Websites 

Something I’ve noticed recently is the increased attention and interest among school counselors
who want to build a guidance and counseling website. I think this is a good idea. A website can
help provide students and other stake holders with all types of valuable resources, information,
and tools. A question that I get in particular is, “What should I put on my site?” I have a whole
chapter in one of my books, SchoolCounselor.com, that addresses this question, here is an
excerpt:

The first and most important task is to consider your website audience and the purpose
of the site. Who will be accessing it? What will they be looking for? What kind of specific format
might appeal to them? Many different people will access your site for many different reasons.
You might want to create a general introduction, description about you and your program, and
different links for parents, community members, students, faculty and people from other
schools that will lead them to information of special interest to them. For instance, consider the
following lists of web content for each:

General Info

1. Most people know the school as a building and a place they walk into each
day. There are many ways to represent the school building, and especially

http://www.schoolcounselor.com/pdf/Sabellas%20Outlook%20Tips.pdf
http://www.schoolcounselor.com/safetynetlinks.asp
http://www.schoolcounselor.com/pdf/booklet.pdf
http://www.schoolcounselor.com/safety/
http://www.allposters.com/gallery.asp?aid=1418369174&search=on+sale
http://www.educationalmedia.com/Merchant2/merchant.mv?Screen=PROD&Store_Code=EMOC&Product_Code=SCC2
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your office, on your Website: with a photograph; with a diagram or map; with
a drawing by a student or with a written description of the architecture. On
the site, show your office up-close-and-personal by using a photo and include
students (with permission) in the picture so the school appears as a live
space.

2. A profile of you and your background.

3. Link to the Executive summary of the ASCA National Model®.

4. Special features of your counseling program (e.g., photos and descriptions of
closing achievement gap projects). If you have permission, use photos (with
no names) and frequently-updated stories to let people know what students
are accomplishing and performing outside of the academic program.

5. Introduction to the members of your school counseling program guidance
committee. 

6. This year’s guidance and counseling goals and objectives (or action plan)

7. Accountability data that allows others to recognize the kinds of tasks and
activities that you are involved and the relevant results.

8. You might publish a “wish list.” Do you need magazines for an upcoming
small group counseling unit that calls for a collage? Could you use more
computers? Are you in need of new books for your own professional
development? These are just a few of the hundreds of items that might be
posted on your Counselor Wish List. If you ask for a few things of reasonable
value you are likely to be successful in receiving donations. Don’t forget to let
people know how to respond to you, update your list frequently, and include
a list of thank-you’s as well.

9. You might also choose to include a text based, or if you want to get fancy, a
streaming video message from your principal or superintendent that supports
your work and program.

10. One of the things that motivates others to return to your site is new and
updated information, even in the form of a new inspirational quote of the day
(or week).

11. Clear contact information that makes it simple for others, especially parents,
to communicate with you and other counselors.
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12. Any honors or awards that you or your program have received (don’t forget
to include any photos).

13. A list of important dates and events and how to prepare for them.

14. A way to collect data either by creating surveys yourself or using a free or
almost free company (e.g., http://free-online-surveys.co.uk/). 

Parents

1. Tips for parent involvement in your school which might include a list of
projects and “how to help.”

2. Various educational “brochures” about parenting topics.

3. Upcoming parent opportunities for training and development, perhaps
sponsored with the PTA.

4. School and district resources for parents and respective contact numbers.

5. Pertinent aspects of your schedule such as times for parent conferences.

Community Members 

1. Tips for community involvement in your school which might include a list of
projects and “how to help.”

2. Profiles of community members whom have participated in special guidance
and counseling projects (e.g., tutoring, mentoring, or activity sponsorship).

3. How your work serves the interests of the community (e.g., school-to-work
or career development activities).

4. Information about adult education services.

Students

1. Various educational “brochures” about student success topics such as
homework help, time management, conflict resolution, and school
adjustment to name a very few.
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2. Information relevant to school success ranging from studying, making
friends, choosing a college or career, to calculating your GPA.

3. Information for alumni to stay in contact.

4. Online tools (e.g., GPA calculators).

5. Interactive guidance units.

Faculty

1. Curriculum for use within a teacher-as-advisor or career education program.

2. Various educational “brochures” about teaching topics such as classroom
management, discipline options, working effectively with ADHD children, and
team building to name a few.

3. Opportunities for teacher consultation which includes the nature of school
consultation and its effects. For instance, you might describe the opportunity
of having you consult with a teacher for approximately four meetings to
discuss ways to enhance student growth and development known to support
academic achievement.

One of my favorite examples of a guidance and counseling website is maintained by Bob Turba
at http://cyberguidance.net/, check it out. 

Finally, I would highly advise that you delegate web development responsibilities to others,
perhaps a web team. Members of your web development team can write content and assemble
material for the various sections of the site. Luckily, many schools have computer courses and
labs where, as part of their assignment, students can help design various parts of your site. You
might also include talented parents and nearby college students who would like to provide a
community service. In this instance, you might take the role of editor: the person who guides
others into developing appropriate and fitting material, makes any needed changes, and
integrates the material with the total body of information in a way that is logical and easy to
follow.
____________________________________________

http://cyberguidance.net/
http://www.schoolcounselor.com
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2007 Calendars
Beautiful calendars for your home or office.
Click here to start browsing.

Also check out World Culture Calendars.

TIPS AND TRICKS

Dell Battery Recall
Dell has identified a potential issue associated with certain batteries sold with Dell Latitude™,
Inspiron™, XPS™ and Dell Precision Mobile Workstation™ notebook computers. In cooperation
with the U.S. Consumer Product Safety Commission and other regulatory agencies, Dell is
voluntarily recalling certain Dell-branded batteries with cells manufactured by Sony and offering
free replacements for these batteries.  Under rare conditions, it is possible for these batteries to
overheat, which could pose a risk of fire.
https://www.dellbatteryprogram.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

'Bully' video game to be released in October
Game maker Rockstar hasn't yet rated game that features character defending himself against
prep school bullies. Published: August 9, 2006, 4:52 AM PDT 
Rockstar, the maker of best-selling video game series "Grand Theft Auto," said on Wednesday it
would launch in October "Bully," a game with themes of school fighting that has antiviolence
critics up in arms. Read more >>>

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint™: Add Slide Numbers to Your Presentation 
 
When creating a PowerPoint presentation, you may want to add numbers to your slides. This
makes it easier for viewers to reference a slide during or after a presentation if they have
questions about a particular point in the show.

1. Select "Insert" - "Slide Number".
2. The "Header and Footer" dialog box will appear.
3. Check "Slide number".
4. Check or uncheck "Don't show on title slide" depending on whether or not you want the
page number shown on the first slide.

http://affiliates.allposters.com/link/redirect.asp?AID=1418369174&PSTID=1&LTID=5&lang=1&startat=http%3A%2F%2Fwww%2Eallposters%2Ecom%2Fgetthumb%2Easp%3Fc%3Dc%26search%3D83902
http://affiliates.allposters.com/link/redirect.asp?AID=1418369174&PSTID=1&LTID=5&lang=1&startat=http%3A%2F%2Fwww%2Eallposters%2Ecom%2Fgetthumb%2Easp%3Fc%3Dc%26search%3D83852
https://www.dellbatteryprogram.com/
http://news.com.com/Bully+video+game+to+be+released+in+October/2100-1043_3-6103571.html?tag=nefd.top
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5. From here, you can also check or uncheck a box to display the date and time on each slide
as well as a custom footer.
6. When done, click "OK" to close the dialog box.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Frontpage: Website Development
Plan, create, and work with Web sites using Microsoft® Office FrontPage® 2003. Also
understand FrontPage Web sites, Web servers, and publishing. Make sure to have your
speakers on ...

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Copying Text or Graphics in Most Windows Applications
Using Ctrl-Drag to Copy. You can quickly make a copy of any object by holding down the CTRL
key while you drag on the object.  You will then "drag off" a new copy.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Selecting Small Objects
Hit the ESCAPE key to insure that nothing is current selected, then repeatedly hit the TAB key,
which will toggle you through a selection of all of the objects on a slide. This is useful for
selecting very small objects, or objects that are covered up by other larger objects.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Showtime Lookup: What’s Playing at the Local Theater
To look up what movies are playing in your area, simply type in the word movies and your zip
code in the Google Search engine. As a bonus, do the same thing with the word weather and
your zip code. 

WORTHY WEBSITES AND SOFTWARE

Microsoft PowerToys for Windows XP
PowerToys add fun and functionality to the Windows experience. What are they? PowerToys
are additional programs that developers work on after a product has been released.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://office.microsoft.com/training/training.aspx?AssetID=RC061276411033
http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx
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Google Base
If you have information you want to share with others but aren't sure how to reach them,
Google Base is for you. You can easily submit all types of online and offline content to Base,
and if your content isn't online yet, we'll put it there. You can describe any item you post with
attributes, which will help people find it when they do related searches. In fact, based on your
items' relevance, users may find them in their results for searches on Froogle, Google Maps and
even our main Google web search. 
http://base.google.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

EurekAlert!
EurekAlert! features news and resources focused on all areas of science, medicine and
technology. This site also has an RSS feed (see last issue to learn more about RSS feeds) which
makes scanning new research quick and easy and a search engine to find specific entries.
http://www.eurekalert.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

TakingITGlobal.org 
TakingITGlobal.org is an online community that connects youth to find inspiration, access
information, get involved, and take action in their local and global communities. It is now the
world's most popular online community for young people interested in making a difference, with
hundreds of thousands of unique visitors each month.
http://www.takingitglobal.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

ASL University
This site is a "curriculum resource for American Sign Language [ASL] students, instructors,
interpreters, and parents of deaf children." It features a dictionary of words with photos of
proper movements, a "baby's first 100 ASL signs tour," finger spelling lessons, number lessons,
material about ASL grammar and history, and more. From the director, ASL Online and
Immersion Programs, Sacramento State, College of Continuing Education.
http://www.lifeprint.com/asl101/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
Timer (PowerPoint)
There are a few of these on the Web here and there although I like this one because it allows
you to choose various countdown durations. After downloading, view the show, click on your
chosen duration, and you’re good to go ...
http://ttc.coe.uga.edu/middleschool/timer.ppt 

http://base.google.com/
http://www.eurekalert.org/
http://www.takingitglobal.org/
http://www.lifeprint.com/asl101/
http://ttc.coe.uga.edu/middleschool/timer.ppt
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

PC World's Back To School Guide 2006    
Once again, the editors of PC World have carefully selected the best computer products,
electronics, gadgets, and gizmos for the fall term. Whether you are a returning grade school
student or new college coed, our Test Center reports, reviews, and expert advice will equip you
with the best tech gear this season. From powerful gaming PC desktops to "bang for your buck"
audio equipment, we have the products to fit your academic, social, and budget needs. Back to
school shopping has never been this easy! 
http://www.marketing.pcworld.com/backtoschool2006/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Help
As you probably know Google has lots and lots of lots of properties at the moment. It's getting
tough to keep up! For those of you who want to become proficient users of all of them (or at
least as many as possible) check out Google's new Help Pages feature, at
http://www.google.com/support 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint Templates Pack 3
This download is a collection of background and design templates included with PowerPoint 4.0
and later versions.

____________________________________________

JUST FOR FUN

Easy2DIY (“Easy to Do It Yourself): How Much Paint do you Need?
This handy calculator will help you estimate the amount of paint you will need to paint an
interior room -- including all the trim. If you plan on applying a primer coat or multiple finish
coats, multiply the results accordingly.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Addicting Games
http://www.addictinggames.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.marketing.pcworld.com/backtoschool2006/
http://www.google.com/support
http://www.microsoft.com/downloads/details.aspx?familyid=47CEDF97-B910-4A17-96C8-18C155492A9A&displaylang=en
http://www.easy2diy.com/cm/easy/diy_ht_calc_index.asp?page_id=35720769&parent1=Location&child1=Office%2FDen&parent2=Category
http://www.addictinggames.com/


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 181

Remake/Remodel
Sometimes, it is easy to tell when a photo has been manipulated with software. Other times,
editing is well hidden. At this site, you can hold your mouse over one any photo and see what it
looked like before it was "remade." 
http://www.briandilg.com/imaging/index.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Cyborg Name Decoder
R.U.S.S.E.L.L.: Robotic Unit Skilled in Scientific Exploration and Logical Learning. That is my
name if I was a cyborg. At least, according to The Cyborg Name Decoder, which lets you enter
in your first or last name, choose an avatar, and see just what your future robot self is capable
of doing.
http://cyborg.namedecoder.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Gestation Video: 9 Months of Pregnancy in 30 Seconds
A soon-to-be father captures a series of photographs of her pregnant wife's belly every other
day and turns them into a great stop-motion animated video.

____________________________________________

Want to advertise in this newsletter? Visit http://www.schoolcounselor.com/advertising.htm 
____________________________________________

http://www.briandilg.com/imaging/index.htm
http://cyborg.namedecoder.com/
http://labnol.blogspot.com/2006/08/gestation-video-9-months-of-pregnancy.html
http://www.schoolcounselor.com/advertising.htm
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SchoolCounselor.com eNewsletter #67 - August 22, 2006

Microsoft Excel™ Charting Trends 

From “What School Counselors Are Doing with Technology” at
http://www.schoolcounselor.com/counseling-tech-survey.htm 

Erin Mason writes: One thing I do with students is teach them to use
Excel to track their grades. There is a "trend" function that you can type
in after a sequence of grades to predict the next grade. This can be a
very motivating tool because students will say they want to "beat the computer." From the
spreadsheet we can use the Chart Wizard to make a graph for them to take home. I've enjoyed
this tool because it gives the students a visual idea of how their grades add up over time (or
don't.)  Each time they come to see me we can add another column to the spreadsheet and
watch the graph change. This same process can be used for groups as well by calculating mean
averages over time, mean absences, etc. Next year I'll be using this with our "teams" to help
them track progress over the year.

Erin Mason
PhD student, Counselor Education and Practice
Department of Counseling & Psychological Services
College of Education
Georgia State University
ecmm@mindspring.com 

Here’s How the Trend Function Works ... 

1. Highlight the columns that you want to chart (including the top row or label)
2. Press F11 to create a very quick bar chart.
3. Right click on any of the bars and choose “Add Trend Line”
4. Click Linear Trend
5. Select the Options tab
6. Increase the number in the Forecast field (e.g., 4 if you are on the Quarter

system and want to project a year). 
7. Click Okay. 

To view a video demonstration of this, click here.

You must know that I don’t believe that this procedure is statistically sound. That is, a linear
trend model for predicting GPA is not accurate given that it is more difficult to increase grade

http://www.schoolcounselor.com/counseling-tech-survey.htm
mailto:ecmm@mindspring.com
http://www.schoolcounselor.com/training/excel-trendlines/
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point averages with every quarter/semester because the number of credits also increases. Also,
the trend line assumes that all related variables are consistent over the forecasted time which
will probably not be true.  However, students don’t need to know or understand this. By using
the Trend Line function, I believe they will benefit from focusing on a positive direction – doing
the things that they have discovered works for them. Using the Microsoft Excel™ Trend line in
this way, with individuals or groups, can be a viable solution-focused approach to decision
making, motivation, and achievement. 

Click here for the entire document “What are School Counselors Doing with Technology?” (PDF;
216 Kb)

Like this tip? Get hundreds more with the eNewsletter issues 20-45. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~
 

Google Pack is a managed collection of free Google (and some non-Google) software for
your desktop PC. This pack contains a selection of Google software that includes Google
Earth, Picasa, Google Pack Screensaver, Google Desktop, Google Toolbar. Additional software
includes Mozilla Firefox with Google Toolbar, Norton Antivirus 2005 Special Edition, Ad-Aware
SE Personal, and Adobe Reader 7. The optional software list includes Google Talk,
RealPlayer, Google Video Player and GalleryPlayer HD Images.  Google Pack also features an
automatic updater tool that alerts you to software updates for all of the software available in
the collection, with options to automatically download and update any new updates as they
become available.
Get it today by visiting http://www.schoolcounselor.com/resources/ 

____________________________________________

TIPS AND TRICKS

Online Victimization of Youth: Five Years Later (PDF), is a follow-up to a previous survey
conducted in 2000. NCMEC partnered with the University of New Hampshire to interview 1,500
youth, ages 10 to 17. Among the report’s findings, the researchers found that young people
today are exposed to an increasing amount of online porn. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Avoiding Spam
Chances are that you get spam in your e-mail inbox. One of the fundamental tools everyone
should have is a spam filter. Many ISPs (Internet service providers) already filter e-mail for you.
But it's hard to tell how effective they are when you receive dozens or hundreds of junk

http://www.amazon.com/exec/obidos/ASIN/1412904587/schoolcounselorc
http://www.schoolcounselor.com/counseling-tech-survey.htm
http://www.schoolcounselor.com/NEWSLETTER/index.asp
http://www.schoolcounselor.com
http://www.schoolcounselor.com/resources/
http://www.missingkids.com/en_US/publications/NC167.pdf
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messages each day. You can reduce the junk by adding a filter. There are many anti-spam
tools online. I've sorted through dozens to find some that you can use with minimal effort.
They're all free. So you can try each without spending a dime. The following tools work with
e-mail programs like Outlook, Thunderbird and Eudora that use POP3 (post office protocol)
e-mail, the most common standard.
http://www.komando.com/tips/index.aspx?id=1101 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Office 2003 Add-in: Word Redaction v1.2 
Use the Word 2003 Redaction Add-in to hide text within Microsoft Office Word 2003
documents. You can mark text to redact and then create a new, redacted version of the
document in which the marked text is replaced with a black bar that cannot be converted back
to text.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™ Chart Formats
Waterfall, floating, tornado, bubble, clustered ... You didn’t realize that Excel could do all of
these types of charts ...
http://peltiertech.com/Excel/Charts/format.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint to Word Export
Have you ever wanted to easily convert your PowerPoint presentation into a Word document so
that you could pass it on to contacts who don't use PowerPoint? Another reason you might
want to do this is to print handouts with more control or options than offered within
PowerPoint. Here in a 40-second mini video tutorial, you can see exactly how to go about it.

Also see:
http://www.b2blog.com/2006/05/powerpoint-printing-tip.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Wikipedia: The School Counselor
Since its creation in 2001, Wikipedia has rapidly grown into the largest reference website on the
Internet. The content of Wikipedia is free, written collaboratively by people from all around the
world. This website is a wiki, which means that anyone with access to an Internet-connected
computer can edit, correct, or improve information throughout the encyclopedia, simply by
clicking the edit this page link (with a few minor exceptions, such as protected articles and the
main page).

http://www.komando.com/tips/index.aspx?id=1101
http://www.microsoft.com/downloads/details.aspx?familyid=028c0fd7-67c2-4b51-8e87-65cc9f30f2ed&displaylang=en
http://peltiertech.com/Excel/Charts/format.html
http://www.masterviews.com/2006/08/18/powerpoint_to_word_video_tutorial.htm
http://www.b2blog.com/2006/05/powerpoint-printing-tip.htm
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http://en.wikipedia.org/wiki/School_counselor 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows Movie Maker 2.1 makes creating movies amazingly fun. With Movie Maker 2.1,
you can create, edit, and share your home movies right on your computer. Build your movie
with a few simple drag-and-drops. Delete bad shots and include only the best scenes. Then
share your movie via the Web, e-mail, or CD. Using third-party software you can even take
movies you've made and turn them into DVDs. You can also save your movie back to the video
tape in your camera to play back on a TV or on the camera itself.

WORTHY WEBSITES AND SOFTWARE

The SPARC (Support Personnel Accountability Report Card)
The SPARC is a continuous improvement document that gives a school counseling program an
opportunity to demonstrate effective communication and a commitment to getting results.
Modeled after the School Accountability Report Card (SARC), the Support Personnel
Accountability Report Card (SPARC) has been developed by an advisory group of Los Angeles
County counselors and consultants, counselor administrators, counselor educators and
California Department of Education consultants. 
http://www.sparconline.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

SiteAdvisor Spyware Quiz
They say it's hard to judge a book by its cover. We'd argue that it's even harder to judge the
safety of a Web site by its looks.  Think you can sniff out which sites are adware & spyware
free? Take our spyware quiz and see. 
http://www.siteadvisor.com/quizzes/spyware_0306.html 

Also, take the spam quiz here. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

NetPost Mailing Online™ postcards offer an economical and convenient means for keeping
in touch with friends and family. For the low price of a First-Class Mail® stamp, we’ll print and
mail your loved ones a postcard about a family gathering or special occasion. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://en.wikipedia.org/wiki/School_counselor
http://www.microsoft.com/windowsxp/downloads/updates/moviemaker2.mspx
http://www.sparconline.net/
http://www.siteadvisor.com/quizzes/spyware_0306.html
http://www.siteadvisor.com/quizzes/spam_0806/index.html
http://www.usps.com/netpost/sendregularpostcards_consumer.htm?from=netpoststayintouch&page=regularconsumer
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School Counselor Resources
From Jefferson County, Tenn.
http://classroom.jc-schools.net/guidance/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The mission of Let's Say Thanks is to provide a way for individuals across the country to
recognize U.S. troops stationed overseas. By submitting a message through this site you will
send a free personalized postcard greeting to deployed servicemen and women. The postcards,
depicting patriotic scenes and hometown images, were selected from a pool of entries from
children across the country. All you have to do is click on your favorite design and either select
the message that best expresses your sentiment or draft a personal note. The postcards are
then printed on the Xerox iGen3® Digital Production Press and mailed in care packages by
military support organization Give2TheTroops®.
http://www.letssaythanks.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

SharpReader 0.9.7.0 
Source: The Scout Report, Volume 12, Number 33, August 18, 2006
Many savvy computer users use RSS aggregators on a regular basis, and SharpReader may be
yet another such device that is worth examining. Along with performing the normal wrangling
task of keeping various feeds in order, SharpReader also detects and shows connected items
together in a threaded fashion. Finally, the application can also group subscribed feeds into
custom categories. This version is compatible with computers running Windows 98, Me, NT,
2000, and XP.
http://www.sharpreader.net/ 
~~~~~~~~~~~~~~~~~~~~~~~~~~~

The BlogSafety forum is for parents, teens, educators, advocates - everyone engaged in and
interested in the impact of the social Web. The user-driven, all-media, multi-platform phase of
the Web has begun, we all have much to learn about it, and this is the central space – linked to
from social networks across the Web - for learning about the impact of Web 2.0 together. The
forum is also designed to give teens and parents a voice in the public online-safety discussion
begun back in the '90s.  In addition, the site has tips for teens and parents, as well as other
resources for safe blogging and social networking. 
http://www.blogsafety.net/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://classroom.jc-schools.net/guidance/
http://www.letssaythanks.com/
http://www.sharpreader.net/
http://www.blogsafety.net/
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Mpire.com
If you are a shopper, this is a must-see site. From their website .. “Our mission is to empower
the millions of people who buy and sell items from the world's most popular online auction and
classified. Sure it's lofty, but that's what we're doing! We're creating services that save our
buyers and sellers valuable time and provide them with powerful insights, enabling them to
make more informed decisions!”
http://www.mpire.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

It's My Life
It's My Life deals with (you guessed it!) life and the stuff that we deal with every day. Whatever
problem you're dealing with, believe it or not, other kids and teens have gone through the
same thing. Here at It's My Life, you can read informative articles, share your stories, play
games and activities, take quizzes and polls, watch video clips of other kids talking about their
feelings and experiences, get advice from older kids and experts, and contribute your own
comments and questions. It's My Life also features interviews with celebrities about stuff they
had to go through when they were kids. 
http://pbskids.org/itsmylife/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Online Periodicals
In addition to scholarly journals and other professional magazines, I subscribe to many different
educational online periodicals/blogs to keep up with profession. Many of these resources
contain lesson plans that could work for classroom guidance. Here are a few that I think you
would also like:

The SCOUT Report
http://scout.wisc.edu/Reports/ScoutReport/Current/ 

New Horizons for Learning 
http://www.newhorizons.org

MarcoPolo 
http://www.marcopolo-education.org

4teachers 
http://www.4teachers.org

DiscoverySchool.com 
http://school.discovery.com

http://www.mpire.com/
http://pbskids.org/itsmylife/
http://scout.wisc.edu/Reports/ScoutReport/Current/
http://www.newhorizons.org
http://www.marcopolo-education.org
http://www.4teachers.org
http://school.discovery.com


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 188

eSchool News Online 
http://www.eschoolnews.com

Education World 
http://education-world.com

Kathy Schrock's Guide for Educators 
http://school.discovery.com/schrockguide

PBS TeacherLine 
http://teacherline.pbs.org/teacherline

T.H.E. Journal 
http://www.thejournal.com

TechLearning 
http://www.techlearning.com

Scholastic 
http://www.scholastic.com

The PEN Weekly NewsBlast is a free e-mail newsletter featuring school reform and school
fundraising resources.
http://www.publiceducation.org/subscribe.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Linda Thomas at the Movies
Excellent movie reviews and ratings to check out before watching them with the kids.
http://www.lindathomasmovies.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Classroom Clipart
Free and useful clipart 
http://classroomclipart.com/ 
____________________________________________

JUST FOR FUN

Google Maps Flight Simulator
Nothing so advanced as the Microsoft Flight simulator, but this Google computer game lets you
fly a small farmer plane over any landscape created from a compilation of Google Maps images.

http://www.eschoolnews.com
http://education-world.com
http://school.discovery.com/schrockguide
http://teacherline.pbs.org/teacherline
http://www.thejournal.com
http://www.techlearning.com
http://www.scholastic.com
http://www.publiceducation.org/subscribe.asp
http://www.lindathomasmovies.com/
http://classroomclipart.com/
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You can use the keyboard arrow keys to change the flying directions, bank and dive. Space lets
you fire while A/Z are for varying the flying speed.
http://www.isoma.net/games/goggles.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Guess the Place
You are shown a picture and need to find out which country, state or city is being shown by
looking at parts of Google Maps, or Flickr images of the place.
http://www.gamesforthebrain.com/game/guessplace/ 
Other Games for the Brain here. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Office: Focus on fitness: Tools for getting in shape 
 There has never been a better time than right now to get in shape. Lucky for you, Microsoft
Office Online has the tools to empower you on the road to a fit body, including templates that
track your nutrition, weight loss, and fitness routine. Here's how to get started.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Cute Overload
Because sometimes you just need to look at pictures of kittens. Or farm animals. Or
hedgehogs. This popular blog provides a daily dose of cute imagery, found somewhere on the
Internet or emailed in by a fan. Browse categories ("Pocket Pets," "Cats N Racks") or follow the
site's links to more cuteness at sites
http://www.cuteoverload.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Jackson Pollock by Miltos Manetas 
Here's a place where you can indulge your inner abstract expressionist: move your mouse to
splatter virtual paint and click to change the color. To create a hard copy, right-click on the
"canvas" and select Print. 
http://jacksonpollock.org/ 

____________________________________________

http://www.isoma.net/games/goggles.html
http://www.gamesforthebrain.com/game/guessplace/
http://www.gamesforthebrain.com/
http://office.microsoft.com/en-us/assistance/HA011988131033.aspx
http://office.microsoft.com/en-us/assistance/HA011988131033.aspx
http://www.cuteoverload.com/
http://jacksonpollock.org/
http://www.schoolcounselor.com/posters.htm
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SchoolCounselor.com eNewsletter #68 - Sept. 4, 2006

If you trust Google more than your doctor than maybe it's time to
switch doctors.
  - Jadelr and Cristina Cordova

Be who you are and say what you feel, because those who mind don't
matter and those who matter don't mind.
  - Dr. Seuss
____________________________________________

Using Video in Your Guidance & Counseling Work 

From Rusty May, Counselor
Glenn County Office of Education
Teachers in Glenn County's Orlando and Willows school districts have the option of starting
their days with a positive message delivered in a fresh, new format: an Internet-based Web
cast. Known as the Morning Minute, this Web cast is delivered to over 50 participating teachers
via e-mail and can be viewed on their classroom computers. Created daily, show topics are
based on daily themes: Motivation Monday, Teamwork Tuesday, Wellness Wednesday,
Thoughtful Thursday, and Friendship Friday. These Web casts are helping to cultivate a
common language of character and a sense of community across county schools. Shows
emphasize personal responsibility and teach simple ways for students to improve their lives and
relationships. Teachers are free to follow up on the Morning Minute with classroom discussions.
Special Education teachers are using the Web cast as a daily writing prompt. Administrators,
teachers, and students praise the program. "There's no chance I'll ever forget to play the
Morning Minute, since the kids faithfully remind me to check my e-mail daily. Also, there is not
a sound to be heard in the classroom as kids listen attentively," remarked one third-grade
teacher. Additional classes are signing up to participate each week.
http://theminute.glenncoe.org

Thanks to Rusty for sharing this information with me. Following are some resources and other
ideas to help you get started on including video in your work.

Videotape Capture

There are several ways to capture your video and you don’t even have to be the one to do it.
First, you can use what is already available and appropriate. For instance, with permission, you
can use Rusty’s video using the website address above. Or, you can search for video on one or
more of the burgeoning number of public video websites such as:

http://theminute.glenncoe.org
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YouTube. YouTube is a place for people to engage in new ways with video by sharing,
commenting on, and viewing videos. YouTube originally started as a personal video sharing
service, and has grown into an entertainment destination with people watching more than 70
million videos on the site daily.
http://www.youtube.com/ 

GrindTV. “GrindTV.com is a portal, vortal, web2, video, community or something other site.
Point is, no matter how you label it, we have every piece of media we can get our hands on for
all the sports we love.”
http://www.grindtv.com/ 

Google Video. “You've found the world's first open online video marketplace, where you can
search for, watch and even buy an ever-growing collection of TV shows, movies, music videos,
documentaries, personal productions and more. In addition to viewing free content, you can
also purchase or rent premium content at the Google Video store using your Google Account.”
http://video.google.com/ 

Yahoo! Video. 
http://video.search.yahoo.com/ 

MSN Video. 
http://video.msn.com/ 

AOL Video. Use AOL's Video On Demand video search tool to find video clips. Find videos for
what you need, including music videos, news videos and other video downloads for free. AOL's
Video On Demand offers free, comprehensive video content you won't find anywhere else on
the Internet.
http://video.aol.com/ 

You can also search for video clips that might fit and enhance your intervention (e.g., guidance
lesson, parent consult, peer mediation training, etc.) by using search engines that come with
the above mentioned video sites. Or, you can also use specialized video search sites such as
Truveo (http://www.truveo.com/) which attempt to find even the most hidden “gems” on
websites across cyberspace. For example, when I used Truveo with the search terms “guidance
counselor” or “school counselor”, I found a few including the one here which shows a video of a
counselor talking about the SAT exam.

Also check out these popular video search engines:

Blinkx.tv
http://tv.blinkx.com/ 

http://www.youtube.com/
http://www.grindtv.com/
http://video.google.com/
http://video.search.yahoo.com/
http://video.msn.com/
http://video.aol.com/
http://www.truveo.com/
http://video.necn.com/global/video/popup/pop_player.asp?activePane=info&ClipID1=633583
http://tv.blinkx.com/
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iFilm
http://www.ifilm.com/ 

Atom Films
http://www.atomfilms.com/ 

NOTE: Just as a warning, be careful with some online video sites as they may contain adult
material. Look for a “family filter” if available and turn it on which should help. 

Some television programs are now archiving their shows via the web for continued access. For
instance, PBS’s NOVA programs are available to watch online, divided conveniently into
chapters and closed captioned for deaf and hard-of-hearing viewers. I clicked on the Health
Category and immediately found a must-see video about eating disorders called “Dying to be
Thin.” This hour-long program is divided into eight chapters. Choose any chapter below and
select QuickTime or Real Video to begin viewing. (Due to rights restrictions this program is not
available for downloading.) While over at PBS, also check out NerdTV at
http://www.pbs.org/cringely/nerdtv/.

Another way to capture video is to record it yourself. Or, better yet, have the kids do it. Using
video, students can speak volumes about a relevant topic in any domain including career,
personal/social, and academic. Videos can be expressive, tutorial, or simply informational. After
the video is recorded on the video camera, you will need to get it into the computer for
editing/processing. This process typically includes connecting the camera to the computer
(either a firewire or USB connection) using the wires that it came with and then starting a
program to transfer it over – a program that usually comes with the camera or one of the video
editing software programs mentioned below. Some video cameras now accept small memory
cards which you can then insert directly into your computer and the file is ready to go (the
same is true for digital still cameras that have the capability of recording brief video). 

Editing Videos

Video editing does take time and so you may want to find a volunteer parent who can do this
for you (or a technology/media class that can do it as part of their assignment). However,
developing a video can be fun and so if you want to try it yourself, I recommend one of the
following software programs:

Windows Movie Maker 2.1 makes developing/editing movies amazingly fun. With Movie Maker
2.1, you can create, edit, and share your home movies right on your computer. Build your
movie with a few simple drag-and-drops. Delete bad shots and include only the best scenes.
Then share your movie via the Web, e-mail, or CD. Using third-party software you can even
take movies you've made and turn them into DVDs. You can also save your movie back to the
video tape in your camera to play back on a TV or on the camera itself. This software is free.

http://www.ifilm.com/
http://www.atomfilms.com/
http://www.pbs.org/wgbh/nova/thin/
http://www.pbs.org/wgbh/nova/thin/
http://www.pbs.org/cringely/nerdtv/
http://www.microsoft.com/windowsxp/downloads/updates/moviemaker2.mspx
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Photo Story 3 allows you to create a photo story that includes motion, narration, and music.
Photo Story 3 includes dramatic pan and zoom effects, picture rotation, and cropping tools to
customize your photos. You can also compose an original soundtrack from directly within Photo
Story 3, narrate your story and add special effects, transitions, and much more. This program is
free. 

Macintosh or Apple users should know about iMovie.

Personally, I use ArcSoft ShowBiz® DVD 2 which I love. It is a simple yet powerful software
application that has everything you need to edit home video and create professional looking
DVDs. The software features a simple storyboard view for basic video sequencing and a more
advanced timeline view giving you greater control over your movie clips, audio tracks and
transitional effects. What’s more, the program includes a powerful photo slideshow wizard and
a full set of DVD authoring tools for turning your video productions into great-looking DVDs
ready for enjoying on TV. 

Another one that others have recommended is Video Edit Magic v4.21. Rusty’s videos were
developed using the more professional software called Visual Communicator 2 made by Serious
Magic. If you want to get more sophisticated, you can also check out the award winning Adobe
Premiere Pro 2.0. (Adobe Premiere Elements is the home version, which you might want to
start with though). 

You can add various video, photos, and sound effects to your finished product which you can
use from your personal collection or find online such as FindSounds.com, a free site where you
can search the Web for sound effects and musical instrument samples. By the way, I like to add
PowerPoint slides into my videos. To save slides as graphics, click on File, Save As, and then at
the bottom where it says “save as type,” choose JPEG. 

Publishing or Delivering Videos

To deliver your videos to consumers (i.e., students, parents, colleagues, etc.) you can do one
or more of the following:

1. Post it on one of the above mentioned video websites that supports free
video uploading. Then, you can either promote the link or even add it to your
own guidance and counseling website using a snippet of code (HTML). You
can make the video public or private. In the case of the latter, you would
have to provide your audience with the needed information to access it or
sometimes include them in an invitation to view. 

2. Play the video over your school’s closed circuit television system from a
computer, directly from your video camera, or from a computer.  

http://www.microsoft.com/windowsxp/using/digitalphotography/photostory/default.mspx
http://www.apple.com/ilife/imovie/
http://www.arcsoft.com/products/showbiz/
http://www.deskshare.com/vem.aspx
http://www.seriousmagic.com/
http://www.seriousmagic.com/
http://www.adobe.com/products/premiere/
http://www.adobe.com/products/premiere/
http://www.adobe.com/products/premiereel/index.html
http://www.findsounds.com/
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3. Upload it to your school’s server and make it accessible to teachers and
others for viewing in the classroom at their own leisure. This could work
exceptionally well as part of a teacher-as-advisor program or schoolwide
guidance lesson. 

4. Burn your video to DVD or CD and make it available for check-out such as in
the case of providing professional development. 

5. Put your video on a new flash drive and carry it with you to the classroom or
other meeting. 

For more on this topic check out “Producing an Educational Video” by visiting
http://edis.ifas.ufl.edu/WC024. 

Have you used video in your guidance and counseling work? Send me an e-mail and tell me
more about it. I might use it in a future SchoolCounselor.com eNewsletter.

____________________________________________

TIPS AND TRICKS

Quick Rename of your File
Instead of Right clicking and choosing Rename, just highlight a file and press F2.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Volunteer Photo Frames
Celebrate your volunteer efforts with customizable photo frames. Place them behind glass,
promote your next event, or use them as a scrapbook background.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Excel™: Common Excel formulas
Use this handy list of formulas to quickly add to your Excel worksheets.
http://go.microsoft.com/?linkid=5349331 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Outlook: Add me (or anyone else) to your Safe Senders or Safe Recipients
List (Source)
Don’t miss a single issue of SchoolCounselor.com. You can add either the sender's e-mail
address or their domain name to the Safe Senders List.

1. On the Tools menu, click Options. 

http://edis.ifas.ufl.edu/WC024
mailto:newsletter@schoolcounselor.com?subject=Using%20Video%20in%20my%20counseling%20work
http://h10025.www1.hp.com/ewfrf/wc/acProject?lc=en&cc=us&dlc=en&extcat=albumspictureframes&extsubcat=customphoto&project=volunteerphotoframe&jumpid=ex_R602_info/hho-ng-aug-volunteer-photo
http://go.microsoft.com/?linkid=5349331
http://office.microsoft.com/en-us/assistance/HP052433571033.aspx
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2. On the Preferences tab, under E-mail, click Junk E-mail. 
3. Click the Safe Senders or Safe Recipients tab.
4. Click Add.
5. In the Enter an e-mail address or Internet domain name to be added to the

list box, enter the name or address you want added, and then click OK.
6. Repeat steps 4 and 5 for each name or address that you want to add 

Notes: 

1. If you want your Contacts to be considered safe senders, select the Also trust
e-mail from my Contacts check box on the Safe Senders tab. By default, the
check box is selected. All e-mail addresses in your Contacts folder will then
be used by the Junk E-mail Filter to evaluate messages. 

2. If you want people who are not necessarily in your Contacts but are people
you correspond with regularly to be considered safe senders, select the
Automatically add people I e-mail to the Safe Senders List check box on the
Safe Senders tab. This check box is introduced with Microsoft Office 2003
Service Pack 1. To get the latest update to Microsoft Office, go to Downloads
on Office Online. Under Office Update, click Check for Updates.

3. To quickly add a sender, domain name, or mailing list name to the Safe
Senders or Safe Recipients Lists, right-click the message you consider safe,
and then on the shortcut menu, point to Junk E-mail, and then click Add
Sender to Safe Senders List, Add Sender's Domain (@example.com) to Safe
Senders List, or Add Recipient to Safe Recipients List.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Spammers Use Google URLs in Spam to Trick People
This is a trick to watch out for, not to use ... 
There has been a recent increase in the number of spammers who are using Google URLs in
their spam in an effort to trick people. They way they do this is to camoflage their URL so that
it looks like a Google URL. After all, nearly everyone knows, recognizes, and trusts Google. How
sinister could clicking on something which appears to be a Google search result be?
Read more >>>

~~~~~~~~~~~~~~~~~~~~~~~~~~~
Dafont
You can browse by category. You'll see a sample of a specific font. If you like the sample, click
the name to see the full alphabet. Then, click Download to get it. If you've never installed new
fonts, there are instructions. For a Windows machine, typically, all you have to do is extract the
files to a directory at C:\WINNT\Fonts.
http://www.dafont.com/ 

http://www.theinternetpatrol.com/spammers-use-google-urls-in-spam-to
http://www.dafont.com/
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~~~~~~~~~~~~~~~~~~~~~~~~~~~

Display a Photo on your Desktop [Windows XP]
If you would like to display your favorite picture on your desktop, Windows XP makes this a
simple task. Here's how:

1. Using Windows Explorer, navigate to the picture file and right-click it. 
2. In the resulting right-click menu, look for the "Open With" option. Choose to Open it in
Internet Explorer.
3. Once Internet Explorer has opened your picture file, right-click the image and select "Set as
Background". 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The Wonderful World of Google Software and Services by Vangie Beal 
As Google continues to work its way into the world of e-commerce, you should know its product
line — if you don't already. Google has expanded its search technology into blogging, mapping,
shopping, research, and much more. In fact, Google now has so many services it's hard to keep
them straight. Here's a quick rundown to help you boost your Google IQ.
http://www.winplanet.com/article/3349-.htm

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Book Search and download full copies of out-of-copyright books to read at your own
pace. You're free to choose from a diverse collection of public domain titles -- from well-known
classics to obscure gems.
http://books.google.com/

For your convenience, here are some “full view” books for school counselors. You can see
books in the Full View if the book is out of copyright, or if the publisher or author has asked to
make the book fully viewable. The Full View allows you to view any page from the book. 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Back to School Helper Websites
So if you're looking for homework helpers, lesson plans, and other online reference tools for
education, read on...
http://askbobrankin.com/back_to_school.html 

____________________________________________

http://www.winplanet.com/article/3349-.htm
http://books.google.com/
http://books.google.com/books?q=%22guidance+counselor%22+OR+%22school+counselor%22&as_brr=1
http://askbobrankin.com/back_to_school.html
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Google Essentials

Download Picasa now!

Find the pictures you forgot you had.
Picasa organizes your entire collection while you watch, scanning the images on your
computer and automatically sorting them by date.

Move and re-name pictures from inside Picasa.
Want to clean up messy folders and move pictures around on your computer’s hard drive?
Simply drag and drop pictures from one folder in Picasa to another. Picasa will make the
change permanent after double-checking with you. Want to change a picture’s filename from
671056398a.jpg to Lisa.jpg? In Picasa, it only takes seconds to re-name one picture or a
group of pictures.

Make a label.
Use labels to tag your photos into quick groupings inside Picasa. Viewing and sharing the
pictures you grouped under a label is easy – they make great slide shows and movies or you
can email them to friends.

Add a star rating.
Give a gold star to any photo you love: it turns your favorites into visual standouts at a
glance. Picasa even has a star search that reduces your entire photo collection to the best of
the best in less than a second.

Keep one picture in multiple albums.
Picasa creates a new “instance” of each photo you label without taking up more space on
your computer, so you can put the same picture into multiple albums.

Password-protect collections.
Have photos you want to keep to yourself? You can add passwords to any of your Picasa
collections (this does not affect which pictures you and others can see on your 

Download at:
http://www.schoolcounselor.com/resources/ 

http://www.schoolcounselor.com/resources/
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WORTHY WEBSITES AND SOFTWARE

Bibliotherapy Education Project©
This project is an ongoing effort to connect individuals with reading material that can promote
personal and/or professional growth in these areas. 
http://bibliotherapy.library.oregonstate.edu/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Colorful Certificates (PDF)
For elementary school students.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

New Beloit College Mindset® List looks at entering college students, growing up with no
soviet union, one germany and bar codes.
http://www.beloit.edu/~pubaff/mindset/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft PowerPoint: Academic Calendar Year Template
2006-2007 school year calendar (13-pp., July-July)
http://office.microsoft.com/en-us/templates/TC101129051033.aspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Social Impact Games
The goal of this site is to catalog the growing number of video and computer games whose
primary purpose is something other than to entertain. These are also known as "serious
games."
http://www.socialimpactgames.com/ 

Also check out Real Lives 2004 is a truly unique, content rich and empathy-building real
world, real life simulation that challenges your life skills (not your hand-eye coordination) as
you make difficult, high-stakes choices that lead to your success, or failure.
http://www.educationalsimulations.com/products.html 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://bibliotherapy.library.oregonstate.edu/
http://www.riverdeep.net/pls/portal/docs/PAGE/RVDP/ET/LP/CERTIFICATES.PDF
http://www.beloit.edu/~pubaff/mindset/
http://office.microsoft.com/en-us/templates/TC101129051033.aspx
http://www.socialimpactgames.com/
http://www.educationalsimulations.com/products.html
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September 11 & Beyond
On the fifth anniversary of September 11, LII reintroduces its collection, September 11 and
Beyond. LII is also again a participant in The September Project (item below, in newsletter), a
grassroots effort to honor this date with special observations on a wide variety of topics.
http://lii.org/pub/topic/September11 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Internet Crime Complaint Center (IC3)
The "IC3's mission is to serve as a vehicle to receive, develop, and refer criminal complaints
regarding the rapidly expanding arena of cyber crime." You can file a complaint using an online
form on this site. Also includes a FAQ, a description of Internet crime schemes, and prevention
tips in areas such as auction fraud, identity theft, and investment fraud. A partnership of the
Federal Bureau of Investigation and the National White Collar Crime Center.
http://www.ic3.gov 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Free iTunes Downloads (Blog)
We will keep you up to date with the latest free downloads at the US iTunes Music Store.
Subscribe to our feeds to find out when you can download music you're interested in for free!
http://freeitunessongs.blogspot.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Pricelessware
The Pricelessware List reflects the categories and programs favored by alt.comp.freeware
newsgroup participants. It is not a comprehensive list; categories are included if a program is
selected in that category. Some categories list several selections; others have only 1 or 2. Most
programs are well known but there are also some hard-to-find goodies on the list. The
Pricelessware slogan is "the best of the best in Freeware". Freeware is: Legally obtainable
software that you may use at no cost, monetary or otherwise, for as long as you wish. All the
programs listed are free but some are not Freeware. Freeware is noted as such. Other "ware"
types are also noted. See alt.comp.freeware's Ware Glossary for definitions of the "wares"
shown in program descriptions. There are NO Adware/Spyware programs on the Pricelessware
List. 
http://www.pricelesswarehome.org/2006/about2006PL.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Picsearch connects its users to the vast visual resources of the internet. Picsearch uses its
own technology to crawl the web and has created a searchable index of images. When a user

http://lii.org/pub/topic/September11
http://www.ic3.gov
http://freeitunessongs.blogspot.com/
http://www.pricelesswarehome.org/2006/about2006PL.php
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sends a query to Picsearch the result is received as a set of thumbnail images that are sorted to
ensure that they are as highly relevant as possible. When the user clicks on a thumbnail they
are linked to the original web site where that image is located. 
http://www.picsearch.com/ 
____________________________________________

JUST FOR FUN

Youtube: Real Life Simpsons Intro 
http://www.youtube.com/watch?v=49IDp76kjPw 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Add Letters lets you generate images & signs with our own words! See it in action with the
Newspaper Generator, the Highway Sign Generator, or the Graffiti Generator
http://www.addletters.com/ 

In fact, find a bunch of online sign generators here: http://generatorblog.blogspot.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

AntiRebate
Discounts, and deals--that don't require a rebate. 
http://www.antirebate.com 

http://www.picsearch.com/
http://www.youtube.com/watch?v=49IDp76kjPw
http://www.addletters.com/
http://generatorblog.blogspot.com/
http://www.antirebate.com
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SchoolCounselor.com eNewsletter #69 - Sept. 19, 2006

The Internet treats censorship as a malfunction and routes around it. 
John Perry Barlow

They have computers, and they may have other weapons of mass
destruction. 
Janet Reno
____________________________________________

E-mail from Readers

Tri writes, “All of our 2nd grade classrooms have Smart Boards in them this year.  Can you
direct me to any resources or websites where someone has created guidance curriculum
(activities/lessons) using the Smart Board technology?  I don't want to reinvent the wheel.”

If you have any suggestions, please e-mail them to me and I will compile and include in a
future newsletter.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

PhotoStory: E-mail from a School Counselor
I took a class last year on using "photo stories" and think it has a lot of potential for use with
counseling.  I had a group of 5th grade girls "model" different types of bullying (being isolated
in the cafeteria, whispering behind their hands, standing alone in the hall etc.) and we took
photographs of different situations with a digital camera.  We downloaded into photo story -
you then add your own dialogue, music, and many different effects to create a mini
video/movie - everything is right there to help you create it.  The result was very effective
when shown to the rest of the 5th grade girls.  I started working with a fifth grade student
(underachiever) who selected his own pictures then began writing his own narration, music etc. 
Unfortunately it was during the last few weeks of school but I am excited about exploring its
use this year.  It's quite powerful for a students to see themselves and hear themselves - a
great vehicle to begin dialogue or to document change as time goes by.  I think it could also be
used for "social stories" using the individual as the subject.
 
Andrea J. Johns
School Counselor
Roye-Williams Elementary School
Andrea.Johns@hcps.org

 

mailto:newsletter@schoolcounselor.com
mailto:Andrea.Johns@hcps.org
http://www.schoolcounselor.com
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TIPS AND TRICKS

NBC-2 Report on Online Videos (Youtube)
The NBC2 Investigators have discovered a new website that could make your kids a potential
target. On YouTube, kids can put videos of themselves and their friends online. But what those
videos contain can lead a predator right to your front door.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Timesaving tips for working with pictures
Published: April 25, 2006 By Stephanie Krieger, Document Production Expert
http://www.microsoft.com/atwork/getworkdone/images.mspx

~~~~~~~~~~~~~~~~~~~~~~~~~~~

EduProfix is a computer game based on driving cars. You have to drive through the right
answer in addition to get through. Developers meant this game for younger children who aren't
able to learn from lists on paper.
http://www.eduprofix.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Computer and Internet Use by Students in 2003 
This report examines the use of computers and the Internet by American children enrolled in
nursery school and students in kindergarten through grade 12. The report examines the overall
rate of use (that is, the percentage of individuals in the population who are users), the ways in
which students use the technologies, where the use occurs (home, school, and other locations),
and the relationships of these aspects of computer and Internet use to demographic and
socioeconomic characteristics such as students' age and race/ethnicity and their parents'
education and family income. This report confirms that patterns of computer and Internet use
seen in previous research are observed in more recent data. One of the more important
findings presented in the report is that schools appear to help narrow the disparities between
different types of students in terms of computer use. Differences in the rates of computer use
are smaller at school than they are at home when considering such characteristics as
race/ethnicity, family income, and parental education. 
http://nces.ed.gov/pubsearch/pubsinfo.asp?pubid=2006065 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.nbc-2.com/videoplayer.asp?videonum=060918_NBCI_youtube.wmv&dw=http://www.nbc-2.com/news/videolist.shtml
http://www.microsoft.com/atwork/getworkdone/images.mspx
http://www.eduprofix.com/
http://nces.ed.gov/pubsearch/pubsinfo.asp?pubid=2006065


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 203

New Video Educates Students on Illegal File Sharing
The Recording Industry Association of America has developed a short video that can be used to
educate students about the consequences of illegal file sharing.  Preview the video or order a
free DVD at  http://www.campusdownloading.com 

View additional resources on file sharing at  
http://www.educause.edu/Browse/645?PARENT_ID=608 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

NEW KIND OF HIGH SCHOOL OPENS IN PHILADELPHIA
Source: San Jose Mercury News, 7 September 2006
The city of Philadelphia and Microsoft teamed up to create a new kind of high school, one that
its designers hope will usher in different kinds of learning to better suit the needs of today's
companies. About 170 students--mostly black kids from low-income families--make up the first
freshman class of the School of the Future. The school brims with technology--students carry
laptops instead of books, the entire facility has wireless Internet access, teachers use
interactive smart boards--but it also takes a new approach to the structure of a school day.
School runs from 9:15 a.m. to 4:19 p.m., approximating a typical office work day, and students
have appointments with teachers rather than strict class times. As they move through lessons,
students' computers monitor how much they are learning and adjust lessons accordingly. To
graduate from the school, which is expected to have 750 students eventually, students must
apply to college. Doug Lynch, vice dean of the Graduate School of Education at The University
of Pennsylvania, said the project is interesting in that it breaks such new ground but noted that
"we have to be careful because you're messing with kids' lives."
http://www.siliconvalley.com/mld/siliconvalley/15463748.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The New Orleans Kid Camera Project
Source: The Scout Report, Volume 12, Number 36, September 8, 2006
http://scout.wisc.edu/Reports/ScoutReport/2006/scout-060908.php
What happens when a group of energetic young people offer cameras to a group of even
younger people in New Orleans? As it turns out, quite a bit, and the proof is in the photographs
on this site. The New Orleans Kid Camera Project was created in order to allow “children from
flooded neighborhoods to explore their environment and express themselves, their stories and
feelings with their friends.” The goals of the project are quite ambitious, as its leaders are
bringing together an interest in the power of community development and art therapy into the
mix as they offer these young people the opportunity to document their community through a
variety of endeavors. Through weekly meetings, young people and group leaders get the
opportunity to learn a host of skills and also share their photographs. As mentioned previously,
interested parties can take a look at their group blogs to learn more about their progress, and

http://www.campusdownloading.com
http://www.educause.edu/Browse/645?PARENT_ID=608
http://www.siliconvalley.com/mld/siliconvalley/15463748.htm
http://scout.wisc.edu/Reports/ScoutReport/2006/scout-060908.php
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also check out some of their photo galleries, which are organized by ward. The photographs are
quite stark and honest, and include images of a small child looking happily towards the camera,
accompanied by the caption “The girl who loves to pose”. Persons who wish to stay abreast of
future developments on the site can sign up to join their mailing list.
http://www.kidcameraproject.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Windows Tips: The Fast, Simple Way to Defragment Your Disks
Use Windows' own tools to do the job; plus, a free disk-cleaning utility.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

What Time is it in Taipei?
You can look up the current local time in a given location from the Google search box by typing
time $location. So, for instance, for Taipei, you type in “time, taipei” (without the quotes).
http://www.google.com/search?q=time+taipei This works with just about any major city in the
world.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Nortel Learning IT
A comprehensive technology communication skills training portal on the Internet! These free
resources have been developed to help you and your students develop 21st century skills and
practices. Today's students are very comfortable with technology and it is a part of their daily
life. Watch a short video to see how much today's students want to have technology integrated
into their classes!  You also have free access to an exciting new feature within our Learning
Community that enables you to share your work, progress, questions and ideas with others
through high performance sharing and collaboration tools.
http://www.nortellearnit.org/ 

Check out lesson plans at http://www.nortellearnit.org/lessons/ 

____________________________________________

WORTHY WEBSITES AND SOFTWARE

Make the grade with 10 Homework Helpers
Published: September 27, 2005 By Marc Saltzman
Today's students are far more likely to turn to the Internet for research and homework help
than to visit the library. The problem is, there are so many Web sites in cyberspace that it can
be difficult to find what you're looking for—and trust what you're reading. Here are 10 terrific

http://www.kidcameraproject.org/
http://www.pcworld.com/article/id,126243-page,1/article.html?tk=nl_wbxcol
http://www.google.com/search?q=time+taipei
http://www.nortellearnit.org/
http://www.nortellearnit.org/lessons/
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sites that provide homework help, reference guides, and imaginative projects for a range of
grades and subjects.
http://www.microsoft.com/athome/intouch/10homeworkhelpers.mspx 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

The September 11 Digital Archive uses electronic media to collect, preserve, and present
the history of the September 11, 2001 attacks in New York, Virginia, and Pennsylvania and the
public responses to them. 
http://911digitalarchive.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

AOL StudyBuddy
Enter a question in StudyBuddy search and find all the homework answers you need. Choose
your grade level and browse through thousands of articles on hundreds of topics, all designed
to help with your homework. Assignments don't have to be a chore anymore -- use StudyBuddy
to get homework help
http://homework-help.aol.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Digg
Digg is a user driven social content website. Ok, so what the heck does that mean? Well,
everything on digg is submitted by the digg user community (that would be you). After you
submit content, other digg users read your submission and digg what they like best. If your
story rocks and receives enough diggs, it is promoted to the front page for the millions of digg
visitors to see. What can you do as a digg user? Lots. Every digg user can digg (help promote),
bury (help remove spam), and comment on stories... you can even digg and bury comments
you like or dislike. Digg also allows you to track your friends' activity throughout the site —
want to share a video or news story with a friend? Digg it!
http://www.digg.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Children's view of 9/11 from "7 Days in September"
Shane is an eleven-year-old who gives us an emotional and powerful interview about his
thoughts on nuclear war, death, afterlife, and his conflicting feelings on peace and war.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.microsoft.com/athome/intouch/10homeworkhelpers.mspx
http://911digitalarchive.org/
http://homework-help.aol.com/
http://www.digg.com/
http://video.google.com/videoplay?docid=-7997114545098115463
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GigaSize
Files to big to e-mail to someone ... Try GigaSize. You can upload files in a snap. Your file will
be kept for at least 45 days and can be up to one gigabyte in size.
http://www.gigasize.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

BrainPop.com Health
Tons of videos and fun learning animations.
http://www.brainpop.com/health/seeall/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

JUST FOR FUN

Upcoming.org is a social events calendar driven by people just like you! Discover new events,
share them with your friends, and add your own.
http://upcoming.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Google Image Labeler
Help Google and have fun at the same time by playing this image labeler game. You'll be
randomly paired with a partner who's online and using the feature. Over a 90-second period,
you and your partner will be shown the same set of images and asked to provide as many
labels as possible to describe each image you see. When your label matches your partner's
label, you'll earn some points and move on to the next image until time runs out. After time
expires, you can explore the images you've seen and the websites where those images were
found. And we'll show you the points you've earned throughout the session
http://images.google.com/imagelabeler/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Froliconyour.com
“Frolic On Your Com is an entertainment weblog for people who need their daily time wasters
at school, work or home. If you’re feeling a bit bored, come down for a short frolic before
getting on with the day (or night). We got only the best games, videos, and other interesting
finds from the Internet, all carefully selected, crap- filtered and delivered right to your
browser.”
http://froliconyour.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.gigasize.com/
http://www.brainpop.com/health/seeall/
http://www.windowsmarketplace.com/prices.aspx?itemId=1444816
http://upcoming.org/
http://images.google.com/imagelabeler/
http://froliconyour.com/
http://www.uclick.com/client/gfl/sudoc/
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i-SAFE Bumper Sticker Contest for Students
School’s in session! Sharpen a pencil or step up to the computer, and get creative. Enter the
i-SAFE National Bumper Sticker Design Contest, starting Sept. 1, 2006. Design a bumper sticker
with a snappy Internet safety message. Use eye-catching images that help get the word out
about cyber safety. Do your part with art! 
http://xblock.isafe.org/contests.php 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Sudoku

http://www.myspace-games.com/games/sudoku.swf 

http://www.uclick.com/client/gfl/sudoc/ 
____________________________________________

http://xblock.isafe.org/contests.php
http://douweosinga.com/projects/googledate
http://www.myspace-games.com/games/sudoku.swf
http://www.uclick.com/client/gfl/sudoc/
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SchoolCounselor.com eNewsletter #70 - October 4, 2006

World Wide Web BootCamp CD is now available for download!

Sending CD’s through the mail is just so “Old Skool.” Now you can purchase and download
the entire CD online and be up and running within the hour (the file is pretty big, 577 Mb).
Visit http://www.schoolcounselor.com/cd/ for more (see details at the end of this
newsletter). 

Cyberbullying

Russell A. Sabella, Ph.D.
SchoolCounselor.com eNewsletter Issue #70, October 4th, 2006
sabella@schoolcounselor.com

Cyberbullying involves the use of information and communication technologies such as e-mail,
cell phone, text messaging, instant messaging, defamatory personal Web sites, and defamatory
online personal polling Web sites, to support deliberate, repeated, and hostile behavior by an
individual or group, that is intended to harm others.”   It seems to be even worse than live
bullying because the perpetrators are not bound my time or space, and the audience can be
much, much bigger. With the power of technology, the offenses can be much more cruel as
they can incorporate a rich array of media (sounds, altered graphics, text, video, slide shows,
and photos) to deliver the attacks.  Consider the following real situations among cyberbullying
victims as reported in one national newspaper:  

• When Joanne had a row with a longtime friend last year, she had no idea it
would spill into cyberspace. But what started as a spat at a teenage sleep
over swiftly escalated into a three-month harangue of threatening e-mails
and defacement of her weblog. "It was a non-stop nightmare," says Joanne,
14, a freshman at a private high school in Southern California. "I dreaded
going on my computer."

• Ashlee, a former elementary school teacher in Birmingham, Ala., says she
was "sickened" by the manner girls manipulated one another with instant
messages. "I grew to hate that," she said.

• "If I find you, I will beat you up," one message read. Frightened, Michael
blocked their IM addresses but didn't tell his parents for two weeks. "It
scared me," he recalls. "It was the first time I was bullied." 

• At one Elementary School in Fairfax, Va. last year, sixth-grade students
conducted an online poll to determine the ugliest classmate, school officials
say.

http://www.schoolcounselor.com/cd/
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• Cyberbullying is so pervasive in one New York county that officials held a
half-day conference last month for students, parents, teachers and
law-enforcement officials. Six hundred attended. 

• "The person was pretending it was me, and using it to call people names,"
the 14-year-old Seattle student said. "I never found out who it was." 

In a startling case that occurred in June 2003 a twelve-year-old Japanese girl killed her
classmate because she was angry about messages that had been posted about her on the
Internet. In another example, Canadian teenager David Knight’s life became hell when a group
of his school mates established a “Hate David Knight” website and posted denigrating pictures
and abuse and invited the global community to join in the hate campaign. In another case right
her in Florida, a boy named Jeffrey was the target of relentless bullying. The perpetrators used
the computer to launch attacks at Jeff and even destroyed a video game he and his friend
worked on all summer. After two years of this persistent bullying and harassment, Jeff
committed suicide by hanging.    These are only a few examples of this significant and growing
problem among children (Studies about the frequency of cyberbullying suggest that
cyberbullying is affecting a significant minority of school-age children, with nearly 25 to 35
percent of respondents claiming to have been bullied in chat rooms, e-mail, and via text
messages.)

Researchers across various disciplines have collected a rich array of anecdotal examples
for how high-tech bullying takes place which highlights the complexity of the problem. Here is
how kids bully each other in a high-tech world.

• Exclusion: Exclusion is the process of designating who is a member of the
“in-group” and who is an “outcast.” In some cases, this is done by who has a
mobile phone and who has not. Students, particularly girls, will also omit
certain other girls from e-mail lists, chat room conversations and so on. 

• Flaming: Flaming is a heated argument, frequently including offensive or
vulgar language, that occur in public communication environments, such as
discussion boards or groups, chat, or newsgroups. Flamers may use capitol
letters and a range of visual images and symbols to add emotional intensity
and anger to their messages. According to the Wikipedia (see
http://en.wikipedia.org/wiki/Flame_war), a flame may have elements of a
normal message, but is distinguished by its intent. A flame is typically not
intended to be constructive, to further clarify a discussion, or to persuade
other people. The motive for flaming is often not dialectic, but rather social
or psychological. Sometimes, flamers are attempting to assert their
authority, or establish a position of superiority. Occasionally, flamers wish to
upset and offend other members of the forum, in which case they are “trolls.”
Most often however, flames are angry or insulting messages transmitted by
people who have strong feelings about a subject. Occasionally a flame can
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also be used as a zenslap (see http://en.wikipedia.org/wiki/Zenslap).
Finally, some consider flaming to be a great way to let off steam, though the
receiving party may be less than pleased. 

• Outing: this includes the public display, posting, or forwarding of personal
communication or images, especially communication that contains sensitive
personal information or images that are sexual in nature. Increasingly,
images taken using mobile phone cameras and mobile phone text messages
are used as part of outing bullying. Reading the saved text messages on
other’s phones can also be part of the outing process; 

• Cyberstalking: includes threats of harm, intimidation and/or offensive
comments which are sent through personal communication channels.
Frequently with cyberstalking there is a threat, or at least a belief, that the
virtual could become real stalking.

• E-mail: One student sends a threatening e-mail to another, then forwards it
to additional people.

• Harassment: Sending hurtful messages to someone in a severe, persistent, or
pervasive manner. 

• Instant Messaging (IM): several students log on to an IM platform (e.g.,
America Online's Instant Messenger) and simultaneously “slam” another.

• Websites: bullies set up derogatory Web sites dedicated to one or more
victims.

• Impersonation: in other cases, students may impersonate other students and
make unpopular online comments, even set up websites that include hate
leading to the impersonated student being ostracized or further bullied in
more traditional ways. 

• Voting/Polling Booths: Some Web sites offer users the opportunity to create
online polling/voting booths, many at no cost. Cyberbullies can use these
Web sites to create web pages that allow others to vote online for "The
Ugliest , Fattest, Dumbest etc. Boy/Girl at their respective schools. 

Children seem to view the real world and the online or virtual world as part of a seamless
continuum. Conversations with friends may begin at school and pick up again, on a child’s
computer, after dinner, or vice versa. Unfortunately, this is also true of bullying behaviors.
What begins as a flame war in an Instant Messaging conversation can carry over to the lunch
room the next day and include many of the same group members witnessing the electronic
conversation the night before. 

What to do if You Suspect Cyberbullying?

You may notice that your child is acting a bit odd and wonder what is going on with him or her.
Know first of all that pre-adolescence and especially adolescence (the teenager years) can be
weird time for everyone even under “normal” circumstances. Still, you may notice a deviation
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from what you are used to or perhaps extreme changes, especially one or more of the
following: 

• Your child is using their computer late at night more than usual.
• Your child's grades are declining. 
• He or she is misbehaving in school more than usual.
• Changes in ordinary daily activities and conditions such as eating, sleeping,

mood swings, etc. 
• Your child appears upset after Internet use. Or, in general seems more

anxious and fearful, especially as it relates to school attendance. 
• There is some evidence that your child is covering their online tracks. 

If your child is being cyberbullied:

• Don’t freak out. Stay calm and maintain open communication with your child.
Let them know that you trust and support them. Also work with trusted
adults at school such as a principal, teacher, or school counselor. 

• If they are being bullied, explain that taking vengeance is not solving the
problem and that it could make the situation worse. 

• Help your child to keep all records including chat transcripts, photos, website
pages, emails (including full headers) as evidence for future use. 

• Inform the perpetrators Internet Service Provider (ISP) or cell phone service
provider of the abuse. 

• If you can communicate to the perpetrators and their parents, explain to
them that what they are doing is cyberbullying and that you will report to the
authorities if it continues. You see, some kids may not recognize what they
are doing is bullying and may believe that it is innocent play. Using the word
“bullying” serves as a wake up call. 

_____________________

1. Belsey, B. (2004). Always on, always aware. Available online
http://www.cyberbullying.ca/pdf/Cyberbullying_Information.pdf

2. Glenn Stutzky, M.S.W., Clinical Instructor, School of Social Work, Michigan State University.
http://tinyurl.com/khsgu 

3. USA Today, MAR 07, 2005. Schoolyard bullies get nastier online ,  Available online
http://tinyurl.com/ezu2f 

4,6.  Bamford, A. (2004). Cyber-Bullying. Available online
http://www.ahisa.com.au/documents/conferences/PCC2004/bamford.pdf 

http://www.cyberbullying.ca/pdf/Cyberbullying_Information.pdf
http://tinyurl.com/khsgu
http://tinyurl.com/ezu2f
http://www.ahisa.com.au/documents/conferences/PCC2004/bamford.pdf
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5. Source: http://www.jaredstory.com/bully.html. Also see http://www.jeffreyjohnston.org/. 

7. Adapted from Parents Need to be Aware that Bullying Has Gone Hi-Tech
http://www.cbc.ca/pei/features/cyber-bullying/HomeandSchoolPresentation.pdf
 
____________________________________________

TIPS AND TRICKS

Microsoft Word™: Controlling Widows and Orphans
You can format paragraphs so that Word doesn’t leave a single line of the paragraph at either
the top or bottom of a page. This tip explains the controls in the Paragraph dialog box that
allow you to control that level of formatting. (This tip works with Microsoft Word™ 97, Word
2000, Word 2002, and Word 2003.)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Coollist is a web-based system for anyone to easily create FREE mailing lists. Mailing lists will
enhance the power of your e-mail allowing your user group or community to communicate and
share ideas quickly via e-mail. The Coollist system is easy to use and is accessible from
anywhere in the world! Even when you are not on your own PC.
http://www.coollist.com/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Subscriber Emails 
Answers to the question, ““All of our 2nd grade classrooms have Smart Boards in them this
year. Can you direct me to any resources or websites where someone has created guidance
curriculum (activities/lessons) using the Smart Board technology? I don't want to reinvent the
wheel.”

I use http://www.unitedstreaming.com for guidance lessons on video.  They also
offer pdf files of the teacher’s guides that accompany the videos.  Our districts
pays a fee to the service and all staff can use it.  You can also try a free 30 day
trial.  Pat Fuller (pfuller@illinibluffs.com)

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Pretexting: Your Personal Information Revealed Fact sheet for consumers about pretexting,
"the practice of getting your personal information under false pretenses," in which a "pretexter"
might gain information by claiming he is from a survey firm, and then use that information to
call the consumer's financial institution. Under the federal Gramm-Leach-Bliley Act such activity

http://www.jaredstory.com/bully.html.
http://www.jeffreyjohnston.org/.
http://www.cbc.ca/pei/features/cyber-bullying/HomeandSchoolPresentation.pdf
http://wordtips.vitalnews.com/Pages/T0776_Controlling_Widows_and_Orphans.html
http://www.coollist.com/
http://www.unitedstreaming.com
mailto:pfuller@illinibluffs.com
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is illegal. Includes material about protecting yourself and what to do if you think you are a
victim. From the Federal Trade Commission (FTC).
http://www.ftc.gov/bcp/conline/pubs/credit/pretext.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft® Codename Max is your opportunity to try a new, exciting experience from
Microsoft. Today Max lets you make beautiful photo slideshows to share with your family and
friends. You can also use the newsreader to keep up with the latest news updates from around
the world.
http://www.microsoft.com/Max/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Password-protect your Screen Saver
If you're concerned about the privacy of your PC, then it's a good idea to password-protect
your PC when it returns from a screen saver. Here's how:

1. Right-click your desktop and click Properties.
2. Click the Screen Saver tab, then select the On resume, password protect checkbox.
3. Click Apply and then click OK.

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Create a Shortcut to Lock Your Computer
Leaving your computer in a hurry but you don't want to log off? You can double-click a shortcut
on your desktop to quickly lock the keyboard and display without using CTRL+ALT+DEL or a
screensaver. Read more >>>

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mail Merge
Learn how to use mail merge in Microsoft Office Word to produce envelopes and labels for
mass mailings. Then explore how to go beyond the basics to create personalized form letters or
e-mail messages, numbered coupons, and more.

Did you know that you can do an e-mail merge with Microsoft Word™ and Outlook? That’s
right. If you have a list of people and it includes their e-mail addresses, you can send a
personalized e-mail out to each person. Check this site out:
http://support.microsoft.com/kb/294694/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.ftc.gov/bcp/conline/pubs/credit/pretext.htm
http://www.microsoft.com/Max/
http://www.microsoft.com/windowsxp/using/security/learnmore/tips/schnoll1.mspx
http://office.microsoft.com/training/training.aspx?AssetID=RC011205671033
http://support.microsoft.com/kb/294694/
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Getting Solicited on MySpace ...
From Ask Dave Taylor
This is weird: I got a friend request from a scantily clad young woman today but when I look at
her profile, I can't see what we have in common other than that we're both female. She's
talking about being a virgin and yet has plenty of rather revealing photos of herself and links
off to some outside site that I'm afraid to visit. is this common? Read more >>>

For Online Safety links, visit http://www.schoolcounselor.com/safety/ Also, I’m putting together
a new website especially for parents and caring adults, www.GuardingKids.com, look out for
it soon!

~~~~~~~~~~~~~~~~~~~~~~~~~~~

WORTHY WEBSITES AND SOFTWARE

Counselor-O-Matic is an advanced search engine that combines your academic and
extracurricular history (screens 1-3) with your preferences (screens 4-8) to help you find the
right college. Once you've registered, you can come back anytime to tweak your answers. The
more questions you answer, the more precise your results will be. However, you can jump
between pages, or look at your results, by using the buttons on the left-hand side of the
screen.
http://www.princetonreview.com/college/research/advsearch/match.asp 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Elgg.net is the online social network for those interested in education, learning technology and
new approaches to teaching and learning. Passionate about education? Join others who are as
well!
http://elgg.net/

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Microsoft Office 2007 System Beta 2
Evaluate the next release of Microsoft Office products for testing and planning purposes with
2007 Microsoft Office system Beta 2. The beta release contains all the functionality of the
regular release, but is not the final product. 
http://www.microsoft.com/office/preview/beta/getthebeta.mspx  

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.askdavetaylor.com/porn_stars_want_to_be_my_friend_on_myspace.html
http://www.schoolcounselor.com/safety/
http://www.princetonreview.com/college/research/advsearch/match.asp
http://elgg.net/
http://www.microsoft.com/office/preview/beta/getthebeta.mspx
http://www.sense-lang.org/typing/
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Qoolsqool is a free and open educational resource for educators, students, and self-learners
around the world. Qoolsqool's mission is to take advantage of 21st century technologies to
advance knowledge and education around the world and reach to people with a need or a
desire to learn or teach.
http://www.qoolsqool.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Snippy?
How often have you carefully selected some text from a Web page and copied it to an e-mail
message? Snippy makes this a snap! Simply click on the little Snippy icon in the taskbar
notification area, and mark out the region of the screen that you want to copy — that's it,
you're done! The cut-out image will now be in your clipboard, and you can paste it in another
application. If you are cutting out a portion of an Internet Explorer window, the URL will also be
copied to the clipboard; this makes it very convenient to select something interesting on a Web
site and send it out in an e-mail message.
http://www.bhelpuri.net/Snippy/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

OnGuardOnline.gov
OnGuardOnline.gov provides practical tips from the federal government and the technology
industry to help you be on guard against Internet fraud, secure your computer, and protect
your personal information. 
http://onguardonline.gov/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Mirror Image
Mirror Image is a detective-style computer game that teaches teens to be safe in online chat
rooms by challenging players to outsmart a cyber stalker. The game is based on a real-life
criminal case involving cyber stalking. The game has been designed for students to use in a
classroom, guided by a teacher or a police officer and can be completed in one class period. 
http://www.wiredwithwisdom.org/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

A Byte-Size Online Safety Guide
Excellent info in a kid-friendly interface from the folks at Nickelodeon TV.
http://www.nick.com/blab/safety/index.jhtml 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

http://www.qoolsqool.com/
http://www.bhelpuri.net/Snippy/
http://onguardonline.gov/
http://www.wiredwithwisdom.org/
http://www.nick.com/blab/safety/index.jhtml
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AOL@SCHOOL
AOL@SCHOOL provides educator-reviewed classroom resources for K-12 students and teachers
in math, science, language arts, social studies and more. Here you can quickly find activities,
research materials, educational games, multimedia resources and lesson plans for primary,
elementary, middle and high school classes.
http://www.aolatschool.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Cyberbullying Presentation (PDF)
http://www.seattleschools.org/area/source/cyberbullying.pdf 

____________________________________________

JUST FOR FUN

Spreadsheet Software Quizzes
http://www.ecs.psu.edu/training/Quizzes/Excel/Excel_Main.htm 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Find Movies Filmed in your City
http://moviemappr.com/ 

~~~~~~~~~~~~~~~~~~~~~~~~~~~

Matching memory game
They say it keeps you mentally sharp (

http://www.aolatschool.com/
http://www.seattleschools.org/area/source/cyberbullying.pdf
http://www.ecs.psu.edu/training/Quizzes/Excel/Excel_Main.htm
http://moviemappr.com/
http://www.1-language.com/materials/memori/elementary/index.htm


SchoolCounselor.com eNewsletter Issues 46-70
wwwSchoolCounselor.com

Page 217

Websites Included in this Newsletter

The SchoolCounselor.com newsletter may contain links to sites on the Internet owned and
operated by third parties. SchoolCounselor.com is not responsible for the availability of, or the
content located on or through, any such third-party site. Information in this document is
provided "as is," without warranty of any kind, either expressed or implied, including but not
limited to the implied warranties of merchantability, fitness for a particular purpose and
freedom from infringement. The user assumes the entire risk as to the accuracy and the use of
this document. SchoolCounselor.com will not be liable for any damages of any kind arising from
the use of this information, including, but not limited to direct, indirect, incidental, punitive, and
consequential damages.

____________________________________________
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http://douweosinga.com/projects/googlebattle 
http://douweosinga.com/projects/googledate 
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http://froliconyour.com/ 
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http://help.blogger.com/ 
http://homework-help.aol.com/ 
http://hsblog.org/index.php 
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http://internet-filter-review.toptenreviews.com/ 
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